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Chapter 1

Introduction
This manual describes installation and operation of the Teledyne LeCroy Sierra M6‐1™ 
Protocol Analyzer and includes examples of typical applications.

Figure 1.1: Teledyne LeCroy Sierra M6-1 Protocol Analyzer

1.1 Analyzer Overview

The Sierra M6‐1 SAS/SATA Protocol Analyzer is a portable single‐port system that can 
function as a protocol analyzer or as an error injector. The SAS analyzer software performs 
serial bus analysis for Serial Attached SCSI (SAS) data transfers, as well as Serial ATA (SATA) 
data transfers through STP data transfers. The SATA analyzer software performs serial bus 
analysis for Serial ATA (SATA) data transfers.

The Analyzer can operate at 1.5, 3, or 6 Gb/s data rates and has 2 GB or 4 GB of recording 
memory.

The Analyzer supports capture, triggering, and filtering of Serial Attached SCSI packets or 
Serial ATA packets. The Analyzer provides for bi‐directional trigger and capture of 
commands, primitives, patterns and all bus conditions. The analyzer allows you to select 
frames to include and exclude for capture. Capturing can be triggered based on a specific 
event or manually.

The Analyzer has a USB port and a GbE (Gigabit Ethernet) port to connect to a host 
machine, which serves as the host for analysis or error injection software. The versatile 
GbE port can be used for either local or remote network connectivity. 
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Sierra M6‐1 Analyzers can be linked together in cascaded configurations to provide 
additional recording channel capacity, or used in tandem to combine simultaneous error 
injection and trace capture/analysis capabilities (requires two Sierra M6‐1 units, one 
protocol analyzer model and one error injector model). Separate licenses are required for 
the protocol analyzer and the error injector.

The Sierra M6‐1 Analyzer provides a full range of views and statistical reports. Statistical 
reports provide event and error counters, as well as performance metrics, that give users 
a snapshot into capture.

The InFusion™ Error Injector and Traffic Modifier is an error injector and traffic 
modification tool that allows you to verify real‐world fault handling. The Sierra M6‐1 
InFusion models perform as a stand‐alone 1.5, 3 or 6 Gb/s version, allowing engineers to 
verify error recovery characteristics of their designs. An easy pop‐up menu interface 
allows the creation of customized test scenarios in just minutes. You can program on‐the‐
fly modifications to any field within any intercepted and changed to a different user 
frame, as the data moves across the link. Any primitive or data pattern can be intercepted 
and changed to a different user‐specified pattern. Examples include support for changing 
DWORD values, disconnecting links, and forcing various error conditions, such as an 
intermittent CRC error or running disparity errors. This enables unprecedented corner 
case testing for SAS and SATA traffic, which is especially useful during final test and 
integration cycles.

The Sierra M6‐1 Analyzer software has an intuitive GUI, combining easy setup with 
flexible data analysis displays. The application layer view logically assembles frames and 
primitives that are part of a specific SAS or SATA command. You can quickly view the 
completion status of any command, which is especially useful in addressing system‐level 
debug challenges.

1.2 Features
 6 Gb/s SAS/SATA protocol analysis or error injection
 Native PHY for fast lock time
 Easy mode triggering
 Cascade up to 8 ports
 Sync with Teledyne LeCroy Sierra and STX family products
 CrossSync Control Panel
 Hardware filtering
 Automatic error detection
 Comprehensive decoding of SAS and SATA data traffic
 Logical and chronological traffic displays
 Statistical reporting
 Trace memory of 2 GB or 4 GB
 GbE & USB 2.0 host interfaces
 Capture, triggering, and filtering of Serial Attached SCSI packets or Serial ATA 

packets
 TX Vout on transmitters for test and characterization 
 Automation API
 Error Injection Functionality (Jammer)
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1.3 Receiving Your Analyzer

The analyzer package includes the following components:

 1 Sierra M6‐1 Analyzer identified in the packing list
 1 USB A‐B 2.0 cable, 1.8 meter
 1 Ethernet cable, 10 feet
 2 SATA cables, 0.5 meter
 2 SATA cables, 0.15 meter
 1 Sync cable, 10‐pin, 6 inch
 1 DC power pack and cord
 1 Installation DVD‐ROM with software and documentation
 1 Sierra M6‐1 Quick Start manual

1.4 Unpacking the Analyzer

Inspect the shipping container for any damage. Unpack the container and account for 
each of the system components listed on the accompanying packing list. Visually inspect 
each component for any damage. In the event of damage, notify the shipper and 
Teledyne LeCroy Corporation. Retain all shipping materials for shipper’s inspection.

1.5 Analyzer Features

1.5.1 Front Panel

The Analyzer has the following features on the front:

 Power Indicator LED (green)
 Status LED (blue)
 Host SATA Connector
 Device SATA Connector
 LED Indicators for Host and Device

 Trig  trigger (blue)
 Error  error (red)
 Link  link (orange)
 Spd  speed level (yellow)

Speed Host Device

1.5G Off  Off

3.0G On Off

6.0G On On
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 Fr/OOB  OOB (Out of Bound) or Frames (traffic) (green)
Before the link, illuminates during
the OOB sequence. 
After the link, indicates traffic on
the bus.

Figure 1.2: Front Panel

1.5.2 Rear Panel

From left to right, the Analyzer has the following on the back:

 USB Port for host connectivity
 External Trigger IN/OUT and Sync Expansion Port
 Gigabit Ethernet Port for network connectivity
 DC Power
 Power Switch (0/1)

Figure 1.3: Rear Panel

WARNING: Do not open the enclosure. No operator serviceable parts are inside.

1.5.3 Temperature and Humidity

The hardware should operate flawlessly in the following temperature ranges: 

 Operating 0 °C to 50 °C (32 °F to 122 °F)
 Non‐Operating ‐20 °C to 80 °C (‐4 °F to 176 °F)

The hardware should operate in the following humidity range: 

 10% to 90% RH (non‐condensing)
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1.6 Installing Your Analyzer

1.6.1 Software Installation

The SAS and SATA software works on systems using the Windows® XP, Windows 7 (x86, 
x64) Windows 8 (x86, x64), Windows Server 2003, Windows Server 2008 and Windows 
Server 2012 R2 operating systems. 64‐bit Windows OS is recommended because it allows 
using more RAM memory. Other Operating Systems limit the RAM to 3GB.

1. Insert the Installation DVD‐ROM into the DVD drive on the host machine.

2. The installation automatically starts setup, unless Auto Run is off. In that case, select 
the DVD‐ROM from “My Computer” and click Setup.

3. After the warning to close all other programs and before starting the installation, 
the Install component selection opens.

4. Select components for installation.

5. Click Next to complete the installation.

System restart

You must restart your computer before you can use your Analyzer software.

Error Message

If you get an error message during installation of the drivers for Window, consult your 
system administrator. Your system may allow only administrator‐level users to copy such 
driver files.

1.6.2 Hardware Setup

Separate Systems

When using the analyzer, it is recommended to use a system to generate bus traffic and a 
second system to run the software, to avoid characterization of traffic generated by the 
analyzer.

Connecting in General

Note:You must install the software before connecting the analyzer to the host machine for the first 
time.

To set up the analyzer:

1. Plug the power adapter into the unit, and then plug the power adapter into a 100V–
240V, 50Hz–60Hz, power outlet. Turn on the Power switch.

2. Connect the USB cable between the Sierra M6‐1 USB port and a USB port on the 
host machine. The host machine’s operating system detects the analyzer and driver 
files.
(See “Connecting via Ethernet” on page 22 for Ethernet connectivity.)

3. Connect the analyzer to Host and Device as follows.
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Figure 1.4: Hardware Setup.

1.7 Cascading Sierra Analyzers

A Sierra M6‐1 analyzer includes a built‐in Sync port on the back panel (between the USB 
and Ethernet ports). See Figure 1.3. 

To connect two Sierra M6‐1 analyzers, plug the ends of a Micro‐D Sync cable [AC031XXA‐
X] into the Sync ports.

Figure 1.5: Cascading Two M6-1 Analyzers with a Micro-D Sync Cable.

You must connect each of the analyzers to the host machine using the USB port or 
Ethernet port.

Note:Before connecting, stop all recording. However, you do not have to turn power off.

For Sierra M6‐1 analyzers connected by Sync cables, the SAS/SATA Protocol Suite 
application automatically synchronizes their recording timestamps, starts, and stops.

To connect three Sierra M6‐1 analyzers, connect the Micro‐D end of a Micro‐D to 
DB‐9 Sync cable [AC030XXA‐X] to the Sync port of the first analyzer. Connect the male DB‐
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9 end of the Micro‐D to DB‐9 cable to the female DB‐9 end of a second Micro‐D to DB‐9 
cable. Connect the Micro‐D end of the second Micro‐D to DB‐9 Sync cable to the Sync 
port of the second analyzer. Connect the male DB‐9 end of the second Micro‐D to DB‐9 
cable to the female DB‐9 end of a third Micro‐D to DB‐9 Sync cable. Connect the Micro‐D 
end of the third Micro‐D to DB‐9 Sync cable to the Sync port of the third analyzer.

Figure 1.6: Example Cascading Three Analyzers with Micro-D to DB-9 Cables.

To connect a Sierra M6‐1 analyzer to a Sierra M6‐2 or M6‐4 analyzer with a CATC SYNC 
Expansion Card, connect the Micro‐D end of a Micro‐D to DB‐9 Sync cable [AC030XXA‐X] 
to the Sync port of the Sierra M6‐1 analyzer. Connect the female DB‐9 end of the Micro‐D 
to DB‐9 cable to the CATC SYNC OUT port of the Sierra M6‐2 or M6‐4 analyzer.

Figure 1.7: Cascading M6-1 and M6-2 or M6-4 Analyzers with a Micro-D to DB-9 Cable.

Note:You cannot connect a Sierra M6‐1 analyzer to a Sierra M6‐2 or M6‐4 analyzer with a STX SYNC 
Expansion Card.

Note:The Self Test, SAS Verification Test, SATA Compliance Test and Update License functions only 
work on unit 1 when the analyzers are set up in cascading mode.
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For Sierra M6‐1, M6‐2, and M6‐4 analyzers connected by Sync cables, the 
SAS/SATA Protocol Suite application automatically synchronizes their recording 
timestamps, starts, and stops.

For how to daisy‐chain two or more Sierra M6‐2 analyzers, see the Sierra M6‐2 
User Manual. For how to daisy‐chain two or more Sierra M6‐4 analyzers, see the Sierra 
M6‐4 User Manual.

Note:You can use the Sync port to synchronize a Sierra M6‐1 analyzer to analyzers with different 
protocols. You use a Micro‐D Sync cable (AC031XXA‐X) to connect to a Teledyne LeCroy Advisor 
T3 analyzer. You use a Micro‐D to DB‐9 Sync cable (AC030XXA‐X) to connect to other Teledyne 
LeCroy analyzers. For more information, see the CrossSync UserManual and/or see “CrossSync 
Control Panel” on page 45.

1.8 Connecting via Ethernet

The Ethernet connection can have any of these configurations:

1. Analyzer connected to a network using a hub or switch, Gigabit Ethernet interface, 
or similar device.

2. Analyzer connected to the host computer (machine running the application 
software), using a hub or switch, Gigabit Ethernet interface, or similar device.

1.8.1 Connecting to a Network

When connected to a network, the analyzer can communicate with the DHCP server to 
obtain IP address configuration information in order to establish a connection. 

1.8.2 Select Device 

After starting the software, click on Setup and select All Connected Devices (see the 
following screen capture).
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Figure 1.8: Connecting to All SAS/SATA Devices.

The Select Device dialog allows connecting and disconnecting analyzers on the fly, 
without restarting the application. 

The new Device List (introduced in version 4.10) mandates using updated firmware in 
order to detect the analyzer over Ethernet. Thus, the analyzer must be updated over USB 
before it can be used remotely over Ethernet. This is applicable for any update from 
version 4.00 or earlier to any version from 4.10 or later.

The following Select Device dialog displays (see Figure 1.9 on page 24). The colors in the 
‘Location’ column mean the following: 

 Red: Firmware and/or BusEngine components need to be updated to the latest 
version 

 Light Blue: The device is ready to be connected.
 Yellow: The device is locked.
 Green: The software is connected and ready to run.
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Figure 1.9: Select Device Dialog. 

Note:Click Refresh Device List to display all the devices on the network.

The Select Device dialog displays the following buttons:

Set Alias Name 

Click Set Alias Name to display the Set device alias name dialog as shown below.

Figure 1.10: Set Device Alias Name Dialog.

Disconnect 

Click Disconnect to disconnect a device.
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Add Device... 

Click Add Device to add a device with a static IP address.

Figure 1.11: Add Device with Static IP Dialog.

Force Add/Connect Attempt

Use this option if the application's Ping function fails (the button in the upper‐right 
corner), but you're sure the address is correct and you still want to attempt the 
connection. This setting is stored in the device.

Remove Device 

Click Remove Device to remove a previously added device.

IP Settings... 

Click IP Setting to reset IP settings of a device. The following IP Setting dialog displays.

Figure 1.12: IP Setting Dialog.

Networks... 

Click Networks to select a network adapter. The following dialog displays.
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Figure 1.13: Select Adapter Dialog.

Refresh Device List 

Click Refresh Device List to refresh the device list.

To connect to a device, select a device which is Ready to Connect and click the Connect 
button on the right. The Connection Properties dialog is displayed (see Figure 1.14 on 
page 26).

Figure 1.14: Connection Properties Dialog.

Specify one of the actions from the following: 

 Automatically connect to the device 
 Ask if I want to connect to the device 
 Take no action

If ‘Automatically connect to the device’ is selected, the next time the application opens 
the device will be automatically connected. 

In the Select Device dialog chained or cascaded units are displayed in the Device column 

with a [ (square bracket) icon. The sequence of the units is displayed in the Order 
column. See the following figure. 
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Figure 1.15: Select Device Dialog Displaying Unit 1 and Unit 2 Chained.

Note:When using STX Sync cards, you need to manually specify the order of the chained units. To 
match your unit sequence to the address for each unit in the Select Device dialog, click the 
pull down tab under the Order heading (on the right side) and select unit numbers: 1 for 
Unit 1, 2 for Unit 2, and so on. This determines the order in which the cascaded ports appear in 
the trace. When using the CATC Sync cards the order is automatically detected. 

IMPORTANT! Power up all units before starting the software. 

1.8.3 Connecting over Different Subnets

If the host machine (with the software) and Sierra M6‐1 are on the same subnet, they will 
see each other’s broadcasts, and the Sierra M6‐1 application will automatically appear in 
the Select Device dialog, from which you can select a device (as described in the previous 
section).

If the host machine and Sierra M6‐1 do not reside on the same subnet, they will not see 
each other automatically. You must add the Sierra M6‐1 IP address manually. To add the IP 
Address, use the Add Device button (see Figure 1.11 on page 25).

1.8.4 Virtual Private Network (VPN)

 VPN solutions establish special network connections to primary networks and in 
some cases use special virtual network adapters as part of their solution.

 For such VPN solutions sometimes it is necessary to select in the Select Adapter 
dialog a virtual adapter specially created for a VPN connection in order to suc‐
cessfully discover and connect to devices over VPN connection.

 It is quite often that this special virtual adapter might have a special IP address 
different from the primary network address range and have a Point‐to‐Point Pro‐
tocol (PPP) type.

 There are also VPN solutions that may require selecting an Ethernet/Wireless 
adapter that will be used for transferring VPN data.
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 So after a VPN connection to the primary network is established please make 
sure that a correct network adapter suitable for your VPN solution is selected in 
the Select Adapter dialog.

1.8.5 TCP and UDP Ports Must Be Open to Connect over Ethernet

WARNING: Check your firewall settings before making Ethernet connections. Incorrect 
firewall settings can prevent Teledyne LeCroy applications from detecting 
analyzers on the network, though Ping works correctly. Consult your Firewall 
documentation to allow Teledyne LeCroy applications access to the network.

The following TCP and UDP ports must be open to connect over the Ethernet:

TCP Port: 4000 to 4003

UDP Ports: 4015 to 4017

1.9 Launching Your Analyzer

To launch the software, double‐click the SAS or SATA icon.

1.10 Operating in Simulation Mode

The SAS/SATA applications operate in Simulation Mode by default if the software detects 
no hardware.

The Analyzer software launches and displays the appropriate tool bar, but with the 
limitation that the Analyzer operates only on static, previously captured, bus data.

Limitations: Simulation Mode lets you try all of the available functions, but the system 
is not capturing any real data and is displaying only 
pre‐captured results.

1.10.1 Using the Software

Depending on the software license(s) purchased with the unit, the Sierra M6‐1 has 
SAS and SATA protocol capability or has SATA only. Use the SAS/SATA Protocol Suite 
applications, respectively. 

The Teledyne LeCroy SAS/SATA Protocol Suite can be a:

 Protocol Analyzer: Captures data, triggers on events, and saves. Easy Mode 
allows standard Trigger and Data capture. Advanced Mode (requires license) 
allows you to program custom triggering in and out, capturing, state jumps, and 
timers (see “Protocol Analysis” on page 39).

 Jammer: The InFusion™ Error Injector and Traffic Modifier is an error injector 
and traffic modification tool that allows you to verify real‐world fault handling 
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(see “InFusion Overview” on page 283).

Note:The Advanced Mode option has to be purchased separately.

The SAS/SATA application now provides functionality for both protocols. Either protocol  
can now be accessed via the File menu and choosing the protocol to work with. Click File> 
New and select the desired protocol and application.

Figure 1.16: File Menu

To switch between protocols click Window and the select the trace or application to use.

Depending on the protocol in use, the relevant functions and menu options are available 
and the others are greyed out (see Figure 1.17 on page 30).
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Figure 1.17: Window Dialog

1.10.2 Getting Started with the Protocol Analyzer

To use the software for protocol analysis, first select File > New > SAS Protocol Analyzer, 
File > New > SATA Protocol Analyzer for a new SATA project for a new project or File > 
Open an existing protocol analysis file: .sac for a SAS file or .stc for a SATA file (see 
“Protocol Analysis” on page 39). You can also open a .scs SAS Sample file or 
.sts SATA Sample file. Example files are in the Examples folder. 

Note:Project files created on the Sierra M6‐X family of analyzer products are not compatible with the 
Sierra M124A/M124 Analyzer. Open the files and perform a Save As to use them with the Sierra 
M124A/M124 Analyzer.

On the Capture tab, select to capture Everything or Pattern. For Pattern, select a Pattern. 
You can exclude patterns and frames. You can use different patterns for pre‐trigger and 
post‐trigger.

On the Trigger tab, select the trigger type. For Pattern, select the pattern.

On the Settings tab, select trigger position and memory use. 

Change the Analyzer settings if necessary. Change the port Speed if necessary.

Use Advanced Mode only after you become familiar with the hardware and software and 
have special needs.

1.11 Menu Options and Toolbars

This section lists all the SAS/SATA Protocol Suite application menu options and the 
toolbars.
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1.11.1 File

The File menu options allows you to perform common tasks such as open, close, save, 
export, print, send files and exit the application (see Figure 1.18 on page 31).

Figure 1.18: File Menu Option

1.11.2 Setup

For special work, you can use the Setup menu (see Figure 1.19 on page 32) to perform the 
following actions:

 Configure TxRxVout & Pre‐emphasis (see “TxRx Vout & Preemphasis” on 
page 244)

 User Defined Decoding (see “User‐Defined Decoding” on page 259) 
 External Trig Setting (see “External Trig Setting” on page 256)
 Update Device (see “Update Device” on page 256)
 All Connected Devices (see “Select Device” on page 22)
 Find DUT (see “Find DUT” on page 271)
 Manage Setup Licenses (see “Floating License” on page 255)
 Set Preferences (see “Preferences” on page 246)
 Perform a Self Test (see “Self Test” on page 263)
 Create a Data Block (see “Creating a Data Block” on page 112)
 Set Port Alias (see “Set Port Alias” on page 242)
 Set SAS Address Alias (see “SAS Address Alias (SAS only)” on page 243)
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Figure 1.19: Setup Menu Option

1.11.3 Session

The Session menu has the following options:

 Start Capture/Record ‐ Start capture or record a trace
 Pause Capture/Record ‐ Aborts the capture without saving
 Stop Capture/Record ‐ Stops the hardware

1.11.4 Analysis

The Analysis menu allows you to view captured data (see Figure 1.20 on page 33) and 
(see Figure 1.20 on page 33).

Menu items and toolbar options are enabled or disabled and displayed or hidden based 
on the type of window open. The following types of windows can be displayed:

 No active window
 Project file open
 Trace file open
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Figure 1.20: SAS/SATA Analysis Menu

Viewing Captured Data

Captured data can be displayed in several views. Select Analysis from the drop‐down 
menu to access the different views (see “Analysis” on page 122). You can display the same 
data in:

 Packet View: Displays packets
 Spreadsheet View: Displays Packet View fields by time
 Column View: Shows DWORDs in columns by port
 Text View: Shows transaction frames, grouped in columns by port
 Frame Inspector View: Has lots of information that is available in Packet View, 

but not Spreadsheet View, so it is most useful in conjunction with the Spread‐
sheet View.

 Waveform View: Shows waveform display for all active ports, on which you can 
perform timing measurements

 Statistical Report: Generate statistics for all transports, commands, primitives, 
bus conditions, addresses, lanes, and errors 

 Histogram View: Shows frame‐type transfers
 Bus Utilization: Displays the utilization of the bus
 Data Reports: Displays data payloads
 Compare 2 Data Payloads: Compares 2 data payloads
 SAS Verification: Verifies compliance with the SAS specification
 Compliance Test: Verifies compliance with the SATA specification
 VSE: Perform custom post‐process analysis of the open trace by running a verifi‐

cation script over the trace
 Power Tracker View: Displays power statistics
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1.11.5 Navigation

The Navigation menu has the following options to navigate through the application (see 
the following screen capture):

Figure 1.21: Navigation Menu Option

 Goto
 Trigger Position
 X Position
 Y Position
 Packet No
 Time Stamp
 Bookmark
 Begin 
 End 

 Search
 Search Next
 Search Previous

1.11.6 View

The View menu options allows the user to zoom in and out, enable/disable filtering and 
toolbars among other actions. It has the following options (see Figure 1.22 on page 35):
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Figure 1.22: View Menu Option

 Zoom In (refer to “Navigation + View Toolbar” on page 200)
 Zoom Out (refer to “Navigation + View Toolbar” on page 200)
 Actual Size (refer to “Navigation + View Toolbar” on page 200)
 Tile Views (refer to “Navigation + View Toolbar” on page 200)
 Enable Filtering (refer to “Filter Setup” on page 207)
 Filtering (refer to “Filter Setup” on page 207)
 Filter Idles (refer to “Filter Setup” on page 207)
 Link Layer‐SAS only (refer to “Packet View Toolbar” on page 225)
 Transport Layer‐SAS only (refer to “Packet View Toolbar” on page 225)
 Application Layer‐SAS only (refer to “Packet View Toolbar” on page 225)
 Pack/Unpack Repeated Primitives‐SAS only (refer to “Packet View Toolbar” on 

page 225)
 Physical Layer‐SATA only (refer to “Packet View Toolbar” on page 225)
 FIS Layer‐SATA only (refer to “Packet View Toolbar” on page 225)
 Command Layer‐SATA only (refer to “Packet View Toolbar” on page 225)
 Wrap Packets (refer to (refer to “Packet View Toolbar” on page 225)
 Toolbar (allows you to customize the toolbar with the options given below)

 Main
 Record+Capture
 Analysis
 Navigation+View
 Packet View
 Column View
 Cursor position
 Target Emulator

 Status Bar (refer to “Cursor Position Status Bar” on page 236)
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1.11.7 Window

The Window menu has the following options:

 Cascade: Displays all open windows in an overlapping arrangement.
 Tile Horizontal: Displays all open windows in a above‐below arrangement.
 Tile Vertical: Displays all open windows in a side‐by‐side arrangement.
 Arrange Icons: Arranges minimized windows at the bottom of the display.
 Close All: Closes all windows.

1.11.8 Help

For more information see “Help Menu” on page 261.

1.11.9 Toolbars

The toolbars enable you to perform several actions, some of which are listed below. 

 Show or hide fields and ports, change port names, and change data format.
 Show the layers and channels using their toolbars.
 Decode using the Decode toolbar.
 Search and Filter.

There are five sets of toolbars (see Figure 1.23 on page 37):

 Main Toolbar ‐ For details on the Main Toolbar refer to “SAS/SATA Main Toolbar” 
on page 42 and “SATA Main Toolbar” on page 42.

 Record Capture Toolbar ‐ For additional information see “SAS/SATA Main Tool‐
bar” on page 42 and “SATA Main Toolbar” on page 42.

 Navigation + View Toolbar ‐ For additional information see “Navigation + View 
Toolbar” on page 200.

 Show Analysis Toolbar ‐ For additional information see “Analysis Toolbar” on 
page 122.

 Packets View Toolbar ‐ For additional information see “Packet View Toolbar” on 
page 225.
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Figure 1.23: SAS/SATA Protocol Suite Toolbars

1.11.10 Port Status

You can display an overview of the active ports by clicking the buttons at the bottom right 
of the main window (See “Port Status” on page 234).

1.11.11 InFusion

The Teledyne LeCroy InFusion™ Error Injector and Traffic Modifier is an error injector and 
traffic modification tool for traffic passing through the Jammer. It allows you to verify real‐
world fault handling for Serial Attached SCSI (SAS) and Serial ATA (SATA) systems.Click on 

the Jammer icon   to invoke the Teledyne LeCroy SAS or SATA InFusion, (see 
“InFusion Overview” on page 283).

You can toggle between the InFusion and Analyzer panes by using the Alt+Tab keys, the 
Windows Task Bar or by pressing the respective toolbar button in each pane. 

1.11.12 Analyzer and InFusion

Sierra M6‐1 Analyzers can be used in tandem to combine simultaneous error injection 
and trace capture/analysis capabilities (see Figure 1.24 on page 38).
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Figure 1.24: Analyzer and Infusion
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Chapter 2

Protocol Analysis
A default analyzer project is created automatically when the application starts. An 
analyzer project contains all the settings for capturing, triggering and memory usage. A 
project can be saved as a *.sac files for later use.

2.1 Easy Mode (Pre-Defined Setups)

After you install the Analyzer software (see “Software Installation” on page 19) and set up 
the Analyzer (see “Hardware Setup” on page 19), launch the Analyzer software (see 
“Launching Your Analyzer” on page 28) to display the default Protocol Analyzer in Easy 
Mode at the Capture tab.

The default Protocol Analyzer uses the Easy Mode which allows triggering and data 
capture. 

2.2 Main Window

Use Easy Mode to get a comprehensive overview of your analyzer’s capabilities. Use the 
default Analyzer Project or create a new project. 

For SAS: On the Analyzer Menu Bar, click File > New > SAS Protocol Analyzer to open a 
SAS Protocol Analyzer dialog.
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Figure 2.1: SAS: New Analysis Project Dialog

The New Project dialog opens with default settings to capture Everything on the bus and 
to Trigger On on Snapshot. (The analyzer captures everything immediately without 
triggering on anything in particular.)

SATA: On the Analyzer Menu Bar, click File > New > SATA Protocol Analyzer to open a 
SATA Protocol Analyzer dialog.

Figure 2.2: SATA: New Analysis Project Dialog

Project Tree display 

What analyzer triggers on

Capture memory settings

Collapse All button hides details in Project Tree
Expand All button expands collapsed Project Tree

Project Tree display 

What analyzer triggers on

Capture memory settings

Collapse All button hides details in Project Tree
Expand All button expands collapsed Project Tree
40 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual



Project Tree  Teledyne LeCroy
SAS vs. SATA: SATA Dialog does not show “Exclude RRDY” or “Exclude NOTIFY”.
SATA Dialog replaces “Exclude SATA_CONT” with “Exclude CONT” and 
“Exclude SATA_SYNC” with “Exclude SYNC”.

2.3 Project Tree

The Project Tree on the right side of the main window displays a comprehensive tree 
structured overview of the project. The project tree shows the capture configuration, 
trigger setups, and the capture memory settings.

2.4 Capture Tab Fields

The Capture tab has the following fields:

Exclude SATA_CONT (SAS) or Exclude CONT (SATA)

Check this to exclude SATA_CONT primitives from the data capture.

Exclude SATA_SYNC (SAS) or Exclude SYNC (SATA)

Check this to exclude SATA_SYNC primitives from the data capture.

Exclude OOB Signals

Check this to exclude OOB signals from the data capture.

Exclude XXXX

Check this to exclude XXXX patterns from the data capture.

Note:The validity of time stamps during Idles is traded off against good buffer memory utilization 
when using ‘Exclude XXXX’.

Exclude Dev Slp Packets (SATA)

Check this to exclude Dev Slp Packets from the data capture. 

Exclude Payload except

Check this to exclude Payload of Data Frames from the data capture. You can except a 
number of DWORD(s). 

Note:The Data Report (refer to “Data Report” on page 187) does not reflect excluded Payload of Data 
Frames.

Note:When showing truncated data in the Data Payload View, the truncation points are marked with 
a separator placed between payloads. You can get more information about the data exclusion 
using the tooltip over the separator.

Exclude ALIGN

Check this to exclude ALIGN primitives from the data capture.
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Exclude RRDY (SAS only)

Check this to exclude RRDY primitives from the data capture.

Exclude NOTIFY (SAS only)

Check this to exclude NOTIFY primitives from the data capture.

Exclude Idle

Check this to exclude Idles from the data capture.

Define different patterns for pre-trigger and post-trigger data captures

Replaces the Capture tab with a Pre‐Trigger Capture tab and a Post‐Trigger Capture tab.

2.5 SAS/SATA Software Menus and Toolbars

The SAS and SATA software has the following menus and toolbars.

2.5.1 SAS/SATA Main Toolbar

The following figure displays the SAS main toolbar.

Note:The sections “SAS/SATA Main Toolbar” on page 42 and “SATA Main Toolbar” on page 42 are 
shown separately to indicate the different context sensitive toolbar options depending on 
whether SAS or SATA trace or project is open.

Figure 2.3: SAS: Software Menus and Toolbar

2.5.2 SATA Main Toolbar

The following figure displays the SATA main toolbar.

Open Project File

Launch Trainer

Launch Jammer

               Abort Capturing Without Saving Sample File                   

Start Target Emulator 

Find DUT
Stop Recording

Upload Manager

Start Recording

Stop Target Emulator 
Save

Manual Trigger
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Figure 2.4: SATA: Software Menus and Toolbar

2.6 Start Recording

To get an immediate overview of the bus traffic to and from your Analyzer:

1. Click the   Record button.

2. The analyzer begins filling the defined memory buffer with traffic captured from the 
bus. After the traffic fills the memory buffer, the traffic is uploaded to the viewer and 
the Packet View display opens. Packet View is the default display. However, more 
views are available by selecting View on the menu bar and choosing the desired 
View.

Open Project File

Launch Trainer

Launch Jammer

               Abort Capturing Without Saving Sample File                   

Start Target Emulator 

Find DUT
Stop Recording

Upload Manager

Start Recording

Stop Target Emulator 
Save

Manual Trigger
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Figure 2.5: SAS: Typical Packet View

Note:When using the Advanced Mode sequencer, the analyzer logs the state transitions in the trace, 
with the name the user gives to the state.

In the Packet View, right‐click on any packet and select Show‐>State, to display the states 
and their transitions in the trace.

SAS: In case of an STP interface, the expander displays STP addresses provided to the 
SATA drive and the SAS software integrates the STP addresses in the ATA command.

The results display shows each transaction for every layer identified in a different color 
and the data direction identified with data direction arrows. Upstream traffic has an 
arrow from right to left:. Downstream traffic has an arrow left to right: .

Layers can be hidden by clicking the corresponding Show/Hide button on the menu bar. 
The system retains all captured data, but the display has fewer data layers for simpler 
viewing.

You can configure the viewer display for test and viewing preferences (see “Viewer 
Display” on page 119 for details about configuring the viewer display).

Layer ID with different colors

Data direction arrows

X,Y,T
Cursors

Show/Hide Layers buttons

Source and destination addresses in SCSI commands

Transport Layer command interpretation

not shown in this capture

Show/Hide Port Data

Link 
Layer

 
Relative time display
(between two sequential
packets on the same
layer and port)
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The Analysis Project dialog offers you a comprehensive set of choices to create a trigger 
and capture project satisfying some specific need. You can set the Analyzer to:

 Capture specific patterns (see "Patterns and Data Capture Setup" on page 57).
 Capture different patterns pre‐ and post‐trigger.
 Exclude parameters from capture.
 Trigger on a pattern or sequence of patterns (see "Trigger Setup" on page 72).
 Configure trace capture memory (Settings tab).
 Select file to save trace capture in memory (Settings tab).
 Include a project note (Notes tab).

2.6.1 Launch Jammer

The Launch Jammer option invokes InFusion. For more information refer to “InFusion 
Overview” on page 283.

2.7 CrossSync Control Panel

The CrossSync Control Panel allows you to select analyzers for synchronization and 
manage the recording process. It supports a wide combination of Teledyne LeCroy’s 
flagship analyzers including PCI Express, USB, DDR, Serial ATA (SATA), Serial Attached SCSI 
(SAS), Fibre Channel (FC) and Ethernet.

CrossSync is Teledyne LeCroy’s analyzer synchronization solution that enables time‐
aligned display of protocol traffic from multiple daisy‐chained analyzers showing packet 
traffic from multiple high‐speed serial busses. A lightweight software control panel allows 
users to select analyzers for synchronization and manage the recording process. Captured 
traffic is displayed using the latest analyzer software (in separate windows) with all the 
protocol specific search and reporting features.

Captured packets are displayed in separate windows that share a common time scale. 
Navigating the traffic in either direction will scroll to the same timestamp in a 
synchronized window. When using the CrossSync option, users can access the full 
complement of analysis capabilities available within the individual Teledyne LeCroy 
software. Search, reporting, and decoding all operate normally. 

This feature is available with the Teledyne LeCroy SAS/SATA Protocol Suite application.

2.7.1 Launching the CrossSync Control Panel

To launch CrossSync from the SAS/SATA Protocol Suite software application, select the 
‘Launch CrossSync Control Panel‘ entry in the ‘Project Setup’ menu (see Figure 2.6 on 
page 46) and (see Figure  on page 46). Or, you can launch CrossSync from the ‘Start’ 
menu.
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Figure 2.6: Launching CrossSync from the SAS/SATA Protocol Suite Application

Please refer to the CrossSync Control Panel User Manual for more information.

2.8 Save Workspace

Viewing parameters can be saved in a workspace as a .wss file. 

After you open a trace and select views, you can save the viewing parameters in a 
workspace file. Select File > Save Workspace to open a Save As dialog. Save the current 
workspace as a .wss file.

To set a default workspace viewing parameters, select Setup > 
Preferences > Software Settings to open the Trace Viewer dialog. In the Default 
Workspace field, enter the path and name of a saved workspace .wss file.

The workspace can be switched after opening a trace file. Select File > Open to open 
another workspace and select a .wss file.

2.9 Saving a Trace Capture

You can save a Trace Capture for review at a later time using the Save As dialog (see 
Figure 2.7 on page 47).
46 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual



Saving a Trace Capture  Teledyne LeCroy
Figure 2.7: Save As Dialog

You can limit the range of the saved file. You can save:

 All Samples
 a range between selected cursors
 a range between selected Idle, link, commands
 range between bookmarks

The Save Filtered Sample checkbox saves a trace file without filtered data. The Apply 
Show/Hide Link Setting checkbox filters the saved data further by also applying the 
current status of the port buttons of the toolbar.

2.9.1 Exporting

From the File menu, you can Export to Text/Excel, Export to Trainer, Export Read‐Write 
Command Report, or Export Paired SAS Address Report.
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Note:Export to Text/Excel is available from the Spreadsheet View, Packet View or Text View as of S/W 
version 5.60 or later. Export to Text/Excel is not available from Column View as of S/W version 
5.60 or later.

Export to Text/Excel

From the File menu, you can export to Text/Excel, using the Export to Text/Excel. The Save as 
Text dialog displays.

Figure 2.8: Save As Text Dialog.

 From the Save as type: drop‐down select Text Files.txt or Text Files Version 1.0 
.txt for text format or Excel File.csv or Excel Files Version 1.0.csv for Excel format 
(see “Save As Display Formats” on page 49). 

 Check the box Export the whole payload (more than 32KB) to export the whole 
payload (more than 32KB).

 You can limit the range of the saved file. You can save:
 All Packets
 Range between selected cursors

 Range between bookmarks
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Save As Display Formats

The following figure describes the four different Save As type formats:

Export to Trainer

The Export to Trainer dialog, accessible from the File menu, allows exporting data to a file 
in a format supported by the Trainer. See  Figure 2.9 and Figure 2.10 on page 50.

Figure 2.9: Export to Trainer Dialog (SAS)

Excel File.csv format Excel Files Version 1.0.csv format Text Files.txt format Text Files Version 1.0.txt format
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Figure 2.10: Export to Trainer Dialog

In the Export to Trainer dialog you can: 

 Limit the range of the saved file. You can save:
 All Traces
 Range between selected cursors
 Range between SCSI Commands, SMP Commands or Transport

 Import SSP Frames, SMP Frames, or STP Frames (see “Events and Event Proper‐
ties” on page 431).

 Reverse Data Payload: Reverses DWORD's byte order of Data Payload in DATA 
FIS and SSP Data Frame

 Insert Waits inserts the appropriate Wait_for commands in the Trainer script as 
a function of the protocol state machine. An example would be to insert a 
Wait_for open_accept after an open command is exported. This allows the 
script to work, even if the DUT has different timing than the DUT in the original 
trace. See “Wait Commands” on page 404.
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 Insert Delays inserts the exact delays as they appear in the original exported 
trace. This may result in the closest match in terms of timing to the original trace, 
but may not work with other DUTs. See Figure 2.11.

Figure 2.11: SAS Trainer Script with Delays

This option is selected by default but can be unselected by the user and no delays will be 
added to the Exported Trainer script. See Figure 2.12.

Figure 2.12: Trainer Script with No Added Delay

 Use Auto Alignment (see “The Global Setting “AutoAlign”” on page 362).
 Select the Port (see “Setup Menu” on page 351).
 Indicate Trainer Generation File Name and click Export to export the trainer 

No Delay Added
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generation file.

Note:The resulting Trainer Generation file cannot exceed 2MB or 1,000,000 packets.

SATA has different options including Device Sleep.

2.9.2 Export Read/Write Command Report

You can create an Export Read/Write Command Report as an Excel file (*.csv), using the 
Export... dialog from the File menu.

In Setup > Preferences > Trace Viewer, you must first select Create statistical report 
read/write page in order to create this report. 

If this choice was not made when the trace was taken, then use Save As to save the trace 
file with this preference. This will append the Read/Write Command Report to the trace 
file, so this action need only be done once. When you re‐open the trace file, you should 
be able to export the report as described above.

2.9.3 Export Paired SAS Address Report

If Text View is activated, from the File menu you can save a Paired SAS Address Report as 
an Excel file, using the Export Paired SAS Address Report dialog (see following figure). 
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Figure 2.13: Export Paired SAS Address Report Dialog.

 Check the box Export the whole payload (more than 32KB) to export the whole 
payload (more than 32KB).

 You can limit the data range of the saved file. You can save:
 All Packets
 Range between selected cursors

You can view expanded traffic (particularly during discovery) in a spreadsheet format. You 
can use column headers with SAS Address Pairs. For example, instead of I1, T1, I2, T2, and 
so on, the columns are Source/Destination SAS Address pairs, such as S1:SEP or S2:EXP 0. 

2.9.4 Trace Properties

Select File > Trace Properties to see the properties of the trace. For more information refer 
to“Trace Properties” on page 121.

2.9.5 Edit Comment

You can write comments and edit them for a trace for future use. Select File > Edit 
Comment to view the edit window. Key in the comments and close the window.
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2.10 Projects

You can define a new project, starting with the default project definition, or modify the 
settings for the last project run.

New Default Project
To start a New project, select File > New on the main menu bar and choose 
Protocol Analyzer to open a new project with default settings that you can modify (see 
“Main Window” on page 39).

Last Project

Clicking the Green button  opens the last project run, so you can modify it.

2.10.1 Project File Types

Projects have the following file types:

*.asl Decoding script file (in the Examples folder “User Define Decoding Script” 
subfolder)

*.cfg Display Configuration file (in the System folder “Config” subfolder)

*.dat DataBlock file (in the System folder “DataBlock” subfolder)

*.sac SAS Protocol Analyzer/Capture Project/Viewer file (in the Examples folder 
“EasyCaptr”, “AdvanceCaptr”, or “Exerciser” subfolders)

*.saf Device Identifier file

*.scs SAS Sample file (in the SAS Examples folder “Sample” subfolder)

*.sfl Filter configuration file

*.spg Single‐role Pattern Generator file (in the Examples folder 
SAS “PatternGenerator\Single role (spg files)” subfolder and 
SATA“PatternGenerator\Single Role” subfolder). Single role means the file is 
for a Device or Host.

*.ssh SAS Search configuration File

*.stc SATA Protocol Analyzer/Capture Project/Viewer file (in the Examples folder 
“EasyCaptr”, “AdvanceCaptr”, or “Exerciser” subfolders)

*.sts SATA Sample file (in the SATA Examples folder “Sample” subfolder)

*.tsh SATA Search configuration file

*.wss SAS Workspace file (in the SAS System folder “Predefined\Workspace” 
subfolder)

*.wst SATA Workspace file (in the SATA System folder “PreDefined\Workspace” 
subfolder)
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2.10.2 Example Projects

The Analyzer includes example projects that you can use to perform an immediate 
analysis without any setup.

The Analyzer system software has a pre‐defined folder (directory) structure for storing all 
files. All example files are in the Examples folder under the Sierra M6‐1 folder.

It is strongly recommended that you open some example files to see types of projects 
that you can create.

2.10.3 Run an Example Analysis Project

To run an example project:

1. Select File > Open.

2. Locate example analysis projects by looking in the Examples folder. Examples are 
available for AdvanceCaptr, EasyCaptr, Exerciser, PatternGenerator, Samples, and 
User Define Decoding Script.

3. In the EasyCaptr folder, choose an example *.sac file and click Open to display the 
Open dialog.

Figure 2.14: File Open Dialog
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Figure 2.15: SAS: Sample Protocol Analysis Project

SAS vs. SATA: For Pattern Parameters, SATA Dialog adds FIS, FIS Pattern, and ATA 
Command Pattern and does not have STP Frame, SSP Frame, SMP Frame, and Address 
Frame.

4. Click the Record button to execute the pre‐defined example.
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5. After the project runs, you see an analyzer trace capture display similar to the one 
shown in Figure 2.16.

Figure 2.16: SAS: Analyzer Trace Capture Display

For details about the results display, see “Display Manipulation” on page 119 and see 
“Display Configuration” on page 238.

2.11 Patterns and Data Capture Setup

You can refine data capture by choosing Pattern and then selecting specific patterns for 
capture. Additionally, you can define a different set of patterns to capture after trigger.

To define specific patterns for capture, click the Pattern button to display the Capture tab 
for Pattern (see Figure 2.17 on page 58).
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Figure 2.17: SAS: Choosing Capture Patterns

SAS vs. SATA: SATA Dialog replaces “Exclude SATA_CONT” with “Exclude CONT” and 
“Exclude SATA_SYNC” with “Exclude SYNC”. 

SAS: The SAS Parameters window displays the following pattern capture categories:

 STP Frame
 Address Frame
 SMP Frame
 SSP Frame
 Data Pattern
 Protocol Errors

SATA: The SATA Parameters window displays the following pattern capture categories:

 FIS
 FIS Pattern
 Data Pattern
 Protocol Errors

2.11.1 Choose a Parameter

To choose a parameter for capture from any of these categories, highlight the category in 
the parameter window and click the Add>> button. This opens selection dialogs for each 
of the categories displaying all of the parameters for that category. All patterns added 
appear in the Project Tree.

2.11.2 Exclude Patterns

Check this box to allow for the capture of everything except the patterns that have been 
added to the Project Tree. 
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When you check this box, the Primitive category appears in the Parameter window, and 
the window enables the Exclude Idle checkbox.

Figure 2.18: SAS: Exclude Patterns Checked

SAS vs. SATA: SATA Dialog replaces “Exclude SATA_CONT” with “Exclude CONT” and 
“Exclude SATA_SYNC” with “Exclude SYNC”. SATA Dialog has “ Exclude Dev Slp Packets”. 
SATA Dialog has different Pattern Parameters (see “Patterns and Data Capture Setup” on 
page 57).

To remove an item from capture, highlight it in the Project tree and click the <<Remove 
button.

2.11.3 Pre and Post Trigger Data Capture

You can define one set of patterns for capture prior to the occurrence of a trigger and 
another set of patterns for capture after the occurrence of a trigger. The selection and 
setup procedure is the same for both Pre‐Trigger capture and Post‐Trigger capture. 

Check Define different patterns for pre‐trigger and post‐trigger data capture to enable 
the Pre‐Trigger Capture and Post‐Trigger Capture tabs (instead of only the Capture tab) 
(see Figure 2.19 on page 60).
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Figure 2.19: SAS: Post-trigger Capture Dialog Enabled

SAS vs. SATA: SATA Dialog replaces “Exclude SATA_CONT” with “Exclude CONT” and 
“Exclude SATA_SYNC” with “Exclude SYNC”. SATA Dialog has different Pattern Parameters 
(see “Patterns and Data Capture Setup” on page 57).

2.11.4 Defining Patterns

To select an item for capture, either highlight the category and click the Add>> button, or 
double‐click the category, to open a corresponding definition dialog. You can define 
patterns for specific ports by checking or unchecking the Port ID.

Primitive

Double‐click Primitive (available only if you check Exclude Patterns) to open the Primitive 
selection dialog.

Figure 2.20: SAS: Primitive Dialog

Port ID
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SAS vs. SATA: SATA Dialog has no radio buttons and has different drop‐down options.

Choose a Primitive from the drop‐down list box to exclude, and click OK. Repeat for 
additional Primitives.

2.11.5 Data Pattern

Double‐click Data Pattern to open the Data Pattern definition dialog.

Figure 2.21: SAS: Data Pattern Dialog

SAS vs. SATA: SATA Dialog shows Port at the top and does not show SSP or STP.

Define the data pattern for capture or exclusion from capture and click OK.

Note:When entering the data pattern in the “Data” section of this screen, if you are reading the data 
pattern from a recorded trace, you must reverse the order of the bytes listed for each DWORD 
entered. For example, if you want to capture (or exclude) “00 01 02 03” (as displayed in the 
trace), you must enter this pattern as “03 02 01 00”.

2.12 Protocol Errors

Double‐click Protocol Errors to open the Protocol Errors selection dialog (see Figure 2.22 
on page 62). 
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Figure 2.22: SAS: Protocol Errors Dialog

SAS vs. SATA: SATA dialog does not show ACK/NAK Timeout and has FIS signal‐latency and 
state‐transition errors, not STP ones. SATA dialog does not show ALL. SSP and SMP radio 
buttons.

Check protocol error(s) to omit or not capture, then click OK.

Protocol Errors Descriptions

SMP Response Time Limit: is outside the specification requirements.

Code Violation: Wrong 10b symbol detected.

Disparity Error: Wrong disparity detected. 

ALIGN Error: ALIGN primitive frequency is outside the specification requirements.

STP Signaling Latency Error [SAS only] or FIS Signaling Latency Error [SATA only]: 
DWORD difference between HOLD and HOLDA is greater than entered value in the HOLD/
HOLDA Response Timeout field.
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STP Invalid State Transition (Unexpected Primitive) [SAS only] or FIS Invalid State 
Transition (Unexpected Primitive) [SATA only]: Second SATA_SOF is encountered before 
SATA_EOF, and other unexpected primitives.

STP Invalid State Transition (Primitive Timeout) [SAS only] or FIS Invalid State Transition 
(Primitive Timeout) [SATA only]: Timeout between two paired primitives is above entered 
value. 65000 DWORDs is default. For example, it can occur between WTRM and R_OK, or 
X_RDY and R_RDY. It expects device (or host) to send a response, but response is not 
received after 65000 DWORDs. You can configure Primitive Response Timeout and HOLD/
HOLDA Response Timeout in the Settings tab Analyzer Settings section.

Frame Type Error: Wrong frame type.

Frame Length Error: Reported frame length is different than actual frame length.

Frame Direction Error: Wrong frame direction. For example, Register Device to Host 
coming from the Host.

CRC Error: CRC error detected.

ACK/NAK Timeout [SAS only]: ACK or NAK primitive missing or encountered 
unexpectedly.

Delimiter Error: Detects two SOF primitives without an EOF between them. Also detects 
two EOF primitives without an SOF between them. 

Radio Buttons: All, SSP, SMP and STP ‐ By selecting one of these radio boxes you can 
specify that you want to trigger (or filter) on a specific protocol error on a specified frame 
type. If you check CRC error and select the SSP radio button, if a CRC error occurs on a 
SMP frame, the analyzer does not trigger on it. 

Hashed Destination SAS Address (SSP trigger only): Specify the destination address for 
the analyzer to locate specific protocol errors. 

Hashed Source SAS Address (SSP trigger only): Specify the source address for the 
analyzer to locate specific protocol errors.

STP Frame (SATA only)

Double‐click STP Frame to open the FIS Patterns dialog (see Figure 2.23 on page 64).
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Figure 2.23: SATA: FIS Patterns Dialog

SAS vs. SATA: Not available in SATA.

Choose a FIS Type from the drop‐down list and click OK. Repeat for additional types.

Available FIS Types
 Register Host to Device
 Register Device to Host
 Set Device Bits
 DMA Activate
 DMA Setup
 BIST
 PIO Setup
 Data
 Vendor

 Address Frame (SAS only)

Double‐click Address Frame to open the Address Frame Type Pattern dialog (see 
Figure 2.24 on page 65).
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Figure 2.24: SAS: Address Frame Type Pattern Dialog

SAS vs. SATA: Not available in SATA.

Click the down arrow next to the Address Frame Types list box and choose an address 
frame type.

SMP Frame (SAS only)

Double‐click SMP Frame to open the SMP Frame Pattern dialog.

Figure 2.25: SAS: SMP Frame Pattern Dialog

SAS vs. SATA: Not available in SATA.

Choose a SMP Frame Type and Function from the drop‐down list box and choose a frame 
type. Assign a specific function to the frame by clicking the down arrow next to the 
Function list box and choose a function.
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SSP Frame (SAS only)

Double‐click SSP Frame to open the SSP Frame Pattern dialog.

Figure 2.26: SAS: SSP Frame Type Dialog

Choose a SSP Frame Type from the drop‐down list and click OK.

FIS (Frame Information Structure) (SATA only)

Double‐click FIS to open the FIS Type selection dialog.

Figure 2.27: SATA: FIS Types Dialog

SAS vs. SATA: Not available in SAS.

Choose a FIS Type from the drop‐down list box and click OK. Repeat for additional types.

Available FIS Types

 Register Host to Device
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 Register Device to Host
 Set Device Bit
 DMA Activate
 DMA Setup
 BIST
 PIO Setup
 Data
 Any Type

STP Frame Pattern

Double‐click STP Pattern to open the STP Pattern selection dialog.

Figure 2.28: SATA: STP Pattern Dialog

The STP Pattern dialog opens with the default FIS Type as Register Host to device. To 
choose another available FIS Type, click the down arrow next to the FIS Type list box.

Choose FIS Type and complete the corresponding dialog.

FIS Types (SAS and SATA)

If you select STP Frame (SAS) or FIS Pattern (SATA) for the Pattern, the FIS Pattern window 
displays (see Figure 2.29 on page 68). You can select the FIS Type in this window from 
among the following types.

Register Host to Device
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Figure 2.29: Register Host to Device

Register Device to Host

Figure 2.30: Register Device to Host
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Set Device Bits

Figure 2.31: Set Device Bits

DMA Activate

Figure 2.32: DMA Activate
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DMA Setup

Figure 2.33: DMA Setup

BIST

Figure 2.34: BIST
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PIO Setup

Figure 2.35: PIO Setup

Data

Figure 2.36: Data
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Vendor

Vendor is for FIS Pattern.

Figure 2.37: Vendor

2.13 Trigger Setup

 The Trigger tab in the analysis project dialog allows you to specify when the analyzer 
completes a data capture. Three trigger modes are available: 

 Don’t care (Snapshot) is the default
 Manual Trig
 Pattern

When data capture starts with Don’t care (Snapshot) selected, the analyzer triggers on 
the first data pattern on the bus. 

Starting a data capture with Pattern selected triggers when specific pattern(s) are 
detected in the captured data stream. The following three ways can trigger the analyzer 
with Pattern selected.

 Trigger on any pattern (Any Trigger Mode)
 External Trigger
 Trigger on a sequence of patterns (Sequential Trigger Mode)
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2.13.1 Snapshot Mode

To trigger immediately on any pattern, check the Don’t care (Snapshot) button.

Figure 2.38: Default Trigger Selected

2.13.2 Manual Trigger Mode

To perform a manual trigger, check the Manual Trig radio button. In the Manual Trigger 
mode, the analyzer captures bus traffic continually from when you use the Manual Trigger 
until you click the Stop Recording button (on the analyzer toolbar), which triggers the 

analyzer. Clicking the Manual Trigger   button on the application toolbar creates a 
Trigger Event and uploads the trace with the specified trigger position.

2.13.3 Any Trigger in Pattern Mode

In Pattern mode, the Analyzer triggers whenever any of the patterns selected for 
triggering occurs (an OR condition). The procedure for selecting trigger parameters is 
identical to that for selecting capture parameters. All items selected for triggering appear 
in the Project Tree.

To define patterns for triggering, check the Pattern button in the Trigger dialog (see 
Figure 2.39 on page 74).
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Figure 2.39: SAS: Select Patterns for Trigger

The SAS Parameters window displays the following trigger pattern categories:

 Timer
 Timeout
 External/Manual Trigger
 Device Sleep
 Bus Condition
 Symbol
 Primitive
 STP Frame
 ATA Command
 ATAPI
 Address Frame
 SMP Frame
 SSP Frame
 SCSI Command
 Data Pattern
 Training Sequence
 Protocol Errors
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Define Sequential Trigger Mode

This is enabled when more than one pattern is used. It allows for the use of a simple state 
machine of “pattern A then pattern B”. When checked, the Count field in each pattern’s 
dialog is enabled (see figure below).

Figure 2.40: Count Field Dialog

The SATA Parameters window displays the following trigger pattern categories:

 Timer
 Timeout
 External/Manual Trigger
 Device Sleep
 Bus Condition
 Symbol
 Primitive
 FIS
 FIS Pattern
 ATA Command
 ATA Command Pattern
 ATAPI
 Soft Reset
 Data Pattern
 Protocol Errors

Note: In packet view, you can right‐click on any frame, select Add to Trigger, and add the pattern to 
DataPatternCapture to make it a trigger pattern. 

Count field disabled Count field enabled
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2.13.4 Choosing a Parameter

Either highlight the category and click the Add>> button, or double‐click the category, to 
open a corresponding definition dialog.

To remove an item, highlight it in the Project Tree, then click the <<Remove button.

2.13.5 Triggering on a Timer

Triggering based on a timer means that the trigger is activated when the timer expires. 
Other triggers can preempt the timed trigger while it is counting down the time. The 
timer starts when the project s started.

You can set a timer independently of any other trigger selection, to cause an 
unconditional trigger after a set time.

To set the timer value, double‐click Timer in the Pattern window to open the Timer 
dialog.

Figure 2.41: Timer Dialog

Check a Time Unit, enter the Timer Value, and click OK.

2.13.6 Timeout

Selecting Timeout for the pattern displays the Timeout Pattern dialog (see Figure 2.42 on 
page 77).
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Figure 2.42: Timeout Dialog

"Start Events" starts the timer in Timeout Trigger and "End Events" triggers the analyzer (if 
first trigger mode is selected) or resets the trigger (if second trigger mode is selected). 
Repetitions of the Start Events are ignored until the End Event is encountered or the timer 
expires.

Select a pattern for Start Events or End Events, enter a Timeout value, then select Trigger 
Mode: 

 If End Events occur before timer expires
 If timer expires before End Events

Note:Timeouts can only be configured from the Timeout Pattern dialog. The Timeout Pattern dialog 
allows configuring other patterns as triggers in combination with timeouts. Other pattern dialogs 
do not allow configuration of timeouts.
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External/Manual Trigger

To set up an external or manual trigger. To set up the trigger, click the External/
Manual Trigger category.

Figure 2.43: External/Manual Trigger Dialog

Bus Condition

Double‐click Bus Condition in the Pattern window to open the Bus Conditions dialog.

Figure 2.44: SAS: Bus Conditions Dialog

SAS vs. SATA: SATA Dialog separates the COMINIT and COMRESET check boxes and 
replaces COMWAKE with Host COMWAKE and COMSAS with Device COMWAKE. 

Check Conditions on which to trigger, then click OK.

Note:You can define triggering for specific ports by checking or unchecking Port IDs. 
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Symbol

Double‐click Symbol in the Pattern window to open the Symbol dialog.

Figure 2.45: Symbol Dialog

Choose a symbol type by checking either the K Symbol or D Symbol option, then click the 
down arrow in the Symbol dropdown list, choose a symbol to trigger on, and click OK. 
Note that the D Symbol choice does not have a down arrow. 

 To choose a D symbol, click the D symbol option button and enter a Hex value.

Primitive

Double‐click Primitive in the Pattern window to open the Primitive dialog. The radio 
buttons select a different subset of primitives from an approximate total of 88 that are 
available. This makes it easier to find the right primitive. The Count field is enabled when 
the Define Sequential Trigger Mode check‐box is selected (see Figure 2.40 on page 75).

Figure 2.46: SAS: Primitive Dialog

SAS vs. SATA: SATA Dialog has no radio buttons and has different drop‐down options.
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Click the down arrow next to the Primitive dropdown list, scroll the list to choose a 
primitive on which to trigger, and click OK. 

Note:Users need to exclude the ALIGN capture for the SAS SOF / EOF trigger and exclude the XXX 
capture for the SATA SOF / EOF trigger, in order for the trigger to precisely display on those 
primitives in the Link Data frame.

Note:Check the box to the right of the Primitive Type to use the logical NOT.

Figure 2.47: SAS: Primitive Selection Choices

SAS vs. SATA: SATA Dialog has different choices.

Primitive Traffic Speed Option (SATA only)

You can change the speed for triggering as well as search by speed for Primitives.
80 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual



Trigger Setup  Teledyne LeCroy
Figure 2.48: Primitive Dialog

ATA Command

Double‐click ATA Command in the Pattern window to open the ATA Command Pattern 
dialog.

Figure 2.49: SAS: FIS Pattern Dialog

SAS vs. SATA: SATA Dialog has different dropdown options.

Choose a Command from the drop‐down list and click OK.

A powerful triggering choice is Any Command, which causes the analyzer to trigger on 
any ATA command.
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Figure 2.50: SATA: ATA Command Dialog

Choose a Command from the drop‐down list and click OK.

Note:The command code and feature set are not the only parameters that describe an 
ATA command. For parameters such as LBA and sector count, use the ATA Command Pattern 
dialog.

ATAPI

Double‐click ATAPI in the Pattern window to open the ATAPI Pattern dialog.

Figure 2.51: SAS: ATAPI Pattern Dialog

SAS vs. SATA: SATA Dialog has different dropdown options.

Choose a CDB from the drop‐down list and click OK.
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Data Pattern

Double‐click Data Pattern in the Pattern window to open the Data Pattern dialog.

Figure 2.52: SAS: Data Pattern Dialog

SAS vs. SATA: SATA Dialog shows Port at the top and does not show SSP or STP.

Define the data pattern for triggering and click OK.

Note:When entering the data pattern in the “Data” section of this screen, if you are reading the data 
pattern from a recorded trace, you must reverse the order of the bytes listed for each DWORD 
entered. For example, if you want to trigger on “00 01 02 03” (as displayed in the trace), you 
must enter this DWORD pattern as “03 02 01 00”.
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Training Sequence

Double‐click Training Sequence in the Patterns window of the Trigger dialog to open the 
Training Sequence dialog.

Figure 2.53: SAS: Training Sequence Dialog

SAS vs. SATA: Not available in SATA.

Define the training sequence for triggering and click OK.
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Protocol Errors

Double‐click Protocol Errors in the Pattern window to open the Protocol Errors dialog.

SAS: Protocol Errors Dialog

SAS vs. SATA: SATA Dialog shows Port and does not show SSP, SMP, or STP radio buttons.

Check the protocol error(s) to trigger on and click OK.
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STP Frame (SAS only)

Double‐click STP Frame in the Pattern window to open the STP Frame dialog.

Figure 2.54: SAS: FIS Pattern Dialog

SAS vs. SATA: Not available in SATA.

Choose a FIS type from the drop‐down list and click OK.
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Address Frame (SAS only)

Double‐click Address Frame in the Pattern window to open the Address Frame Type 
Pattern dialog.

Figure 2.55: SAS: Address Frame Type Pattern Dialog

SAS vs. SATA: Not available in SATA.

Choose an Address Frame Type from the drop‐down list and click OK.
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SMP Frame (SAS only)

Double‐click SMP Frame in the Pattern window to open the SMP Frame Pattern dialog.

Figure 2.56: SAS: SMP Frame Pattern Dialog

SAS vs. SATA: Not available in SATA.

Choose a SMP Frame Type from the dropdown list on which to trigger.

Then choose a Function from the drop‐down list and click OK.
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SSP Frame (SAS only)

Double‐click SSP Frame in the Pattern window to open the SSP Frame Type dialog.

Figure 2.57: SAS: SMP Frame Type Dialog

SAS vs. SATA: Not available in SATA.

Choose a SSP Frame Type from the drop‐down list and click OK.
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SCSI Command (SAS only)

Double‐click SCSI Command in the Pattern window to open the SCSI Command Pattern 
dialog.

Figure 2.58: SAS: SCSI Command Pattern Dialog

SAS vs. SATA: Not available in SATA.

Choose a CDB from the drop‐down list and click OK.
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FIS (Frame Information Structure) (SATA only)

Double‐click FIS to open the FIS Type selection dialog.

Figure 2.59: SATA: FIS Type Dialog

SAS vs. SATA: Not available in SAS.

Choose a FIS type on which to trigger, and click OK. Repeat for additional types.

Available FIS Types:
 Register Host to Device
 Register Device to Host
 Set Device Bit
 DMA Activate
 Any Type
 DMA Setup
 BIST
 PIO Setup
 Data
 Any Type

Note:You cannot trigger on a Vendor FIS.
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2.13.7 STP Frame Pattern

Double‐click STP Pattern to open the STP Pattern selection dialog.

Figure 2.60: SATA: STP Pattern Dialog

The STP Pattern dialog opens with the default FIS Type as Register Host to device. To 
choose another available FIS Type, click the down arrow next to the FIS Type list box.

Choose FIS Type and complete the corresponding dialog.

ATA Command Pattern (SATA only)

Double‐click ATA Command to open the ATA Command Pattern selection dialog (see 
Figure 2.61 on page 93).
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Figure 2.61: SATA: ATA Command Pattern Dialog

Choose an ATA command, and click OK.

Soft Reset (SATA only)

Double‐click Soft Reset to open the Soft Reset dialog.

Figure 2.62: SATA: Soft Reset Dialog

SAS vs. SATA: Not available in SAS.

2.13.8 Sequential Trigger Mode

In Sequential Trigger mode, triggering occurs whenever the system detects a specific 
sequence of patterns. Defining the triggering patterns sets the sequence order. You must 
define at least two patterns to enable selection of Sequential Trigger mode.

Note:Patterns, such as Primitives and Symbols or Frames, occurring very close together on different 
ports can cause false triggers.
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To define a triggering sequence, select more than one pattern, then check the 
Define Sequential Trigger Mode check box.

Figure 2.63: SAS: Select Sequential Trigger Mode

SAS vs. SATA: SATA Dialog has different patterns.

Timer

The sequential triggering mode offers the option of triggering on a timer or inserting a 
timer in the triggering sequence to delay detection of the next pattern in the sequence. 
To insert a timer in the trigger list, double‐click Timer to open the Timer dialog.

Figure 2.64: Timer Dialog

Enter a Timer Value, choose the Time Unit, and click OK.

Defining Patterns

The definition of patterns for the sequential trigger mode is identical to the Any Trigger 
mode, with the following exception: 

In sequential triggering mode, the definition dialogs for the triggering patterns enable 
the setting to count the number of occurrences (see Figure 2.65 on page 95). This allows 
you to specify the number of times that the pattern must occur before triggering or 
proceeding in the trigger sequence.
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Figure 2.65: Number of Occurrences

Note:The events on each link are counted independently, causing a trigger whenever the number of 
occurrences on any link equals the specified value.

Triggering Order

As you define and add triggering patterns, they display under the Trigger category in the 
Project Tree sequentially, in the order in which you entered them. When the project runs, 
the analyzer detects the occurrence of each pattern in order and triggers on the last one.

You can re‐order the sequence of triggering patterns. To change the sequence order, 
highlight a trigger pattern and use the Up or Down arrow to move it to a new position.

Figure 2.66: Triggering Order
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Pre-Trigger

You can set the amount of data to capture before and after the trigger, as a 
percentage of pre‐trigger, between 1% and 99%. Position the pre‐trigger slider to a 
percentage. This feature allows the evaluation of bus activity leading up to and after the 
triggering event. Figure 2.67 illustrates the operation of pre‐trigger in data memory.

Pre‐trigger data is capture of the specified percentage of data prior to the triggering 
event. It cannot be guaranteed and may be 0. This can occur when the triggering event 
occurs before storing the required amount of pre‐trigger event data. In such a case, the 
data display shows fewer than the specified data points prior to the triggering event.

Figure 2.67: Pre-Trigger Example, 20% Pre-Trigger
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2.14 Project Settings

To set project options, click the Settings tab.

Figure 2.68: SAS: Setting Project Options

SAS vs. SATA: For the ALIGN Transmission Period section, SATA Dialog shows options 256 
and 258, and does not show 2048 or 2049.
For Speed, SATA Dialog shows H1, D1 to H2, D2 and does not show I1, T1 to I2, T2.
SATA Dialog does not show MUX Setting button.

2.14.1 Memory Settings

The Trace Memory Status section has the following fields.

Trigger Position

Pre‐Trigger memory defaults to 50%, which defines the percentage of data to capture 
before and after the triggering event. You can change this percentage by dragging the 
slider.

Capture of the specified percentage of the data prior to the triggering event cannot be 
guaranteed and may be 0. This can occur if the triggering event occurs before storing the 
required amount of pre‐trigger event data. In such a case, the data display shows fewer 
than the specified data points prior to the triggering event. For more detail, See “Pre‐
Trigger” on page 96..
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Note:Trigger Position only works when the triggering option is Pattern.

In certain cases, when one port is recording traffic and filling up the memory much faster 
than another port, you might see traffic appearing only on one port for a while, and the 
other port's traffic will only appear later. This occurs as a function of the trigger position, 
and is normal, expected behavior of the analyzer.

Sample File Name

Click the ellipses next to the Sample File Name text box and choose a file name and 
location for the results of your current project.

Auto Run

To repeat the current capture and trigger setup automatically, check the Auto Run 
checkbox and enter the number of times in the Number of Run text box. The capture and 
trigger repeat automatically for the specified number of times, and the results are saved 
in consecutively numbered Sample.scs files.

Memory Size

In the Protocol Analyzer Settings tab, you can allot memory for the trace recording. Check 
Entire Memory to allow recording to use the whole memory, to capture the maximum 
amount of trace data. (Minimum size of memory is 2 GB. Maximum size of memory is 
16 GB.)

Partial Memory

To reduce the memory size, check Partial Memory and enter a buffer size in kilobytes, up 
to the memory size in megabytes.

Note: If the size of a data packet exceeds the buffer memory allocation, the project runs, but no data 
capture occurs. You must increase buffer memory size to a value greater than the packet size.

Segmented Memory

Alternatively, you can use Segmented Memory. Enter an integer # of Segment, from 1 to 
32, then enter an integer Segment Size in kilobytes, up to the memory size in megabytes 
divided by the number of segments. The default segment size is 10 MB. 

Each time a trigger condition occurs, the system records a new segment. You can use a 
Snapshot or Pattern trigger, but not Manual Trigger. As the same trigger automatically 
repeats, the system makes the number of segments that you entered.

Upload Manager

To upload segments manually in the Upload Manager, select the Don’t upload segments 
and open upload manager automatically checkbox. 
To upload segments automatically for display as the system creates them, do not select 
the checkbox.

To view segmented trace files, click the Upload Manager   button, beside the Record 
button, to display the Upload Manager dialog (see Figure 2.69 on page 99).
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Figure 2.69: Upload Manager Dialog

The dialog displays the segments in the format Segment1, Segment2, and so on.

Select segments by clicking the checkbox. You can also Select All or Deselect All 
segments.

You can Upload segments for display, Save segments as sample files, and Delete 
segments.

The Preview radio button allows a preview of an integer number of megabytes around 
the trigger position. You can set the trigger position as a percentage and select the 
segment number. Click the radio button to Show Traffic Summary with the preview. To 
show the preview, click the Preview button.

2.15 Analyzer Settings

2.15.1 Primitive Response Timeout

The Primitive Response Timeout parameter specifies the number of DWORDs between 
two pair primitives after which the analyzer detects a protocol error. Default value is 
65000. When host or device sends a primitive, such as X_RDY, HOLD, or WTRM, it expects 
device or host to reply with a primitive, such as R_RDY, HOLDA, or R_OK. This parameter 
detects FIS Signaling Latency error, between HOLD and HOLDA, and FIS State Transition 
error, between X_RDY and R_RDY, between SOF and EOF, or between WTRM and R_OK or 
R_ERR.You can set a trigger on these protocol errors.

2.15.2 Disable Descrambling

If checked, causes the Analyzer to assume that no traffic is scrambled. By default, the 
Analyzer assumes the scrambling state of the devices under test has scrambling enabled.
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2.15.3 Show XXXX value

Check this option to display XXXX values.

Pack training sequence

Checking this box allows hiding the details of the Training Sequence, which can take up 
large portions of the trace unless packed.

ALIGN Transmission Period (differs for SAS and SATA)

Choose the ALIGN Transmission Period for SSP and STP by clicking the corresponding 
option button, then open the Protocol Error Mask dialog.

2.15.4 Protocol Error Mask

Click the Protocol Error Mask button to open the Protocol Error Mask dialog.

Figure 2.70: Protocol Errors Dialog

Check the Protocol Errors that you want the Analyzer to ignore.

When “RD Error” and “Code violation Error” are set as trigger events: 
“RD Error” or “Code violation Error” can occur right after the OOB sequence.
“RD Error” or “Code violation Error” can occur right after the recovery from the PM state.

These errors are mainly caused by the long synchronization time of the analyzer. If these 
errors, caused by the Analyzer, become triggers, you cannot detect some other errors 
that you really need to detect. To NOT detect the above two errors, enable the software 
setting Disable ‘Disparity Error’ and ‘Symbol Violation’ during Speed negotiation. After 
this, the code violation is not triggered during the speed negotiation phase, but is 
triggered if the violation happens after the speed negotiation phase. 
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2.15.5 External Trig Out Setting

The Analyzer can send a Low or High external signal when a trigger occurs. Select the 
External Trig Out Setting: High Active, Low Active, or Toggle from High to Low or Low to 
High once (3.3 V output). Enter the External TrigOut pulse width. 

The pulse width is programmable in the software. The Voltage level is 0 to +3.3 Volt. The 
trigger out is derived by NL17SZ126 buffer. The delay for OOB traffic external trigger out is 
330 ns. The delays for non OOB external trigger out are:

 6G ~ 370 ns 
 3G ~ 540 ns 
 1.5G ~ 850 ns 

Note:The External Trigger In and External Trigger Out feature is always available in both Easy and 
Advanced modes and is not dependent on the licensing of both these modes.

2.15.6 External Trig In Setting

An external Low or High input signal can cause triggering. Select the 
External Trig In Setting: High Active, Low Active, or Toggle from High to Low or Low to 
High once (3.3 V output).

2.15.7 Choose Port Speed

The default speed is Autospeed. You can also select the port speed from the 
drop‐down list: 1.5 Gbps, 3.0 Gbps, or 6.0 Gbps.

Note: If a Port ID check box has no check, the analyzer does not capture any patterns for that port. The 
system allocates trace memory for that port to its adjacent port, for example: I1, T1 <‐> I2, T2.

2.15.8 Ports Configuration

Select the Port Configuration button to display the Set Port Configuration dialog.
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Figure 2.71: SAS: Set Port Configuration Dialog

The dialog shows the current port configuration. To select a port configuration, click the 
down arrow to display the Select Port Configuration dialog. 

Figure 2.72: SAS: Select Port Configuration Dialog

Port configuration depends on the application you run. 

 To act as Analyzer, select the   Analyzer port configuration.

 To activate the InFusion on a port, select   Jammer.
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Note:To display the current Port Configuration, click the green button in the lower right corner to 
display the Port Status window (see “Port Status” on page 234).

2.15.9 Port Configuration and Projects

Port Configuration depends on Project selected. 

Performance Analyzer and Performance Analyzer with do not use ports. 

Protocol Analyzer has the following port configuration.

2.15.10 Add a Project Note

To enter and save information about the current project, click the Notes tab and enter the 
data about the project.

 

Figure 2.73: Project Notes Tab

Project Number
Protocol Analyzer Port 1.
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2.16 Advanced Mode (User-Defined)

Advanced Mode expands Analysis capability by allowing you to program complex 
triggering and data capture projects.

Note:The Advanced Mode option has to be purchased separately.

The Advanced Mode is a state machine with up to 23 different states. You can program 
each state individually to:

 Trigger on a different event or trigger unconditionally.
 Capture Everything, Nothing, or a user‐defined pattern.
 Include up to three ELSE IF statements, allowing a jump to any other state based 

on a user definition.
 Use up to three timers, which you can set to a maximum value of 42949 ms. You 

can set a timer in the state or continue the timer set in the previous state.
 Output an external trigger (High or Low).

Note: In Advanced Mode, events on each link are counted independently. A condition is met if the 
number of events on a link equals the defined occurrence.

2.16.1 Working in Advanced Mode

To start working in the Advanced Mode, click the Easy, Switch to Advanced Mode button 
in an open Analyzer window.

You can:

 Display the state definition
 Set Output Trigger level
 Select up to three timers
 Define the If condition and up to three Else If conditions
 Set number of occurrences before trigger
 Set captured data
 Set excluded data
 Go to next state
 Add state
 Choose link for Sequencer setup
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Figure 2.74: SAS: State Programming Dialog

Figure 2.75: SATA: State Programming Dialog

SAS vs. SATA: SATA Dialog removes Exclude ALIGN, Exclude RRDY, and Exclude NOTIFY.
SATA Dialog replaces Exclude SATA_CONT with Exclude CONT and Exclude SATA_SYNC 
with Exclude SYNC.

SATA Dialog has patterns Bus Condition, Primitive, FIS, FIS Pattern, Data Pattern, and 
Protocol Errors and does not have STP Frame, SMP Frame, STP Frame, or Address Frame.
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Figure 2.76: SAS: Advanced Trigger with Multiple Branches

2.16.2 State Number for Complex Trigger Sequences

To follow the path of complex trigger sequences, you can display state numbers in a 
trace. 

To see state number, in Packet View right‐click a link layer packet, show field, and select 
state number.

Setting Trigger Conditions

To set the If and Else If trigger condition:
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1. Click the Add Pattern button  for a Pattern field and choose a trigger condition 
from the drop‐down list.

Figure 2.77: SAS: Choosing a Trigger Condition

2. Define each selected pattern in the same way as in Easy Mode, as described starting 
on page 60. To use a timer, define it first.

Note:You can set a timer for any If or Else If condition.

3. Enter a value for the number of occurrences before trigger in the Cont field, up to a 
maximum of 65535 occurrences.

4. Choose a capture option: Everything, Nothing, or Pattern.
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5. If you choose Pattern, you can select patterns for inclusion or exclusion. Clicking the 
Pattern option enables a pattern definition dialog.

Figure 2.78: SAS: Choosing a Pattern

6. Choose pattern(s) and click the +>> button to add them for capture or exclusion. You 
define each pattern the same way as in Easy mode (see “Defining Patterns” on 
page 60).

7. For an output trigger, click the down arrow in the Ext. Out field and choose an 
output trigger level. Note: Do not use the LOW setting in Advanced Mode.

8. To go to another state, click the down arrow in the Go To field and select a state. If 
no other state has been defined, choose New State to add a state.

Set Timers

You can set and use up to three timers for triggering. You can set each timer for each 
state or continue from a timer set in the previous state. The timer defined for a particular 
state starts when entering that state. To set timers, click the ellipses in the Timer field in 
each state and define each of the timers in the Set Timers dialog.

Figure 2.79: Set Timers Dialog

Note:Three timers are available. You have to set and start each timer in order to continue the next 
timer. For example, you have to start Timer 1, continue it, then set Timer 2 in order to continue 
it. It will not allow you to continue Timer 2 until you first set it.
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Timeout

The timeout trigger allows triggering based on the occurrence or non‐occurrence of two 
events within a pre‐defined period of time. Patterns can be added to the Start Events and 
End Events list. An occurrence of a pattern of the Start Events list starts the timer, or 
resets the timer if the timer is already running. Depending on the configurable Trigger 
mode, the trigger is activated when the End Event(s) occur before the timer expires, or 
the timer expires before the End Event(s) occurs.

 You can set a Timeout. 
 Select a Pattern for the Start Event. (Start Event resets the timer.)
 Select a Pattern for the End Event. 
 Enter the Timeout Value in milliseconds or microseconds.
 Select a Trigger Mode:

 If End Event occurs before timer expires.
 If timer expires before End Event occurs.

Figure 2.80: Timeout Dialog

WARNING: In Advanced Mode, Short State Jump Intervals Can Cause Hardware Queue 
Overflow and Corrupt Frames.

When using Advanced Mode, if too many state jumps occur in a short time, the hardware 
queue can overflow, which may corrupt frames. For example, an infinite loop can cause 
many state jumps in a short time. Hardware overflow can occur if interval between state 
jumps is less than 60 DWORDs.
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In Advanced Mode, infinite loops are usually used to check if an event occurs before a 
timeout. In this case, you can use the Timeout dialog to avoid hardware queue overflow.

 

Figure 2.81: State Machine with Multiple Patterns and Timer Elapse

In Figure 2.81: , the port detects HARD_RESET, which starts the Timer. When the timer 
expires, it jumps to another state. If a trigger occurs between timer start and end, the 
captured trace will have corrupt frames because of hardware queue overflow. 

Figure 2.82: State Machine with Timeout Pattern to replace Timer

To overcome this limitation, use a Timeout Pattern instead of Timer. Figure 2.82 shows 
the state machine using Timeout instead of Timer. Figure 2.83 on page 111 shows the 
Timeout settings.
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Figure 2.83: Timeout Settings

Timeout begins when the port detects the Start Event. Timer begins when the port 
detects the Hard RESET primitive. In the Trigger Mode window, set the Trigger to trigger 
when the port detects the End Event, before the Timeout occurs. In our example, this is 
the Bus Condition. Capture begins when the ports detects the Bus Condition before the 
Timeout occurs. If the port does not detect the Bus Condition until the Timeout occurs, 
the State Machine in Figure 2.82 on page 110 jumps to State 0. 

Useful Key Sequences

The following key sequences are active to assist you in navigating a defined state 
machine:

Ctrl+a Add State

Insert Insert State

Del Delete State

Ctrl+c/Ctrl+Ins Copy

Ctrl+v/Shift+Ins Paste

Up/Down arrow keys Moves selection between states

Page Up/Page Down Page Up and Page Down states

Home Go to first page

End Go to end page
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2.17 Project Settings

Prior to running the Advanced mode project, click the Settings tab. The options in the 
Settings dialog are the same as for the Easy Mode, described starting on page 97.

SAS vs. SATA: For the ALIGN Transmission Period section, SATA Dialog shows options 256 
and 258, and does not show 2048 or 2049.
For Speed, SATA Dialog shows H1, D1 to H2, D2 and does not show I1, T1 to I2, T2.
SATA Dialog does not show MUX Setting button.

2.17.1 Notes

To include some descriptive information about the project, click the Notes tab and enter 
a brief descriptive note (see “Add a Project Note” on page 103).

2.18 Creating a Data Block

You can create the following types of data blocks, for use with data fields:

 Random data pattern
 Custom data pattern specifically for your application
 Counter data pattern
 Walking bit pattern

To create a data block, select Setup > Data Block to open the Data Block dialog box as 
shown in Figure 2.84.

Figure 2.84:  Default Data Block Dialog Box
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To add another data block:

1. Click the New button in the Data Block dialog box.

Figure 2.85:  New Data Block Dialog Box

2. Choose the number of data columns (up to 16 data cells/row) and the cell length (up 
to 16 bytes/cell). This is a display function only.

3. Click either the Bin, Hex, or Ascii option button to choose a number format.

4. Click either the LSB or MSB option button to choose a bit order.

2.18.1 Naming a Data Block

Each new data block automatically receives a sequential data block number. To assign a 
unique descriptive name to a data block, right‐click the data block name to open the Data 
Block Edit menu.

Figure 2.86:  Data Block Edit
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Choose Rename.

Figure 2.87:  Rename Data Block

Enter a descriptive name in the New Name edit box and click OK.

2.18.2 Editing a Data Block

You can enter data in the defined cell structure by these methods:

 Define your own pattern
 Set a counter
 Choose a Random Pattern
 Choose a Walking Bit Pattern

2.18.3 Define Your Own Pattern

To define a pattern:

1. Click Pattern to open the Define Pattern dialog box as shown in Figure 2.88:  

2. Enter a data pattern in the Data Pattern edit box.

3. Choose the number of times to repeat that pattern, and click OK.

Figure 2.88: Define Your Own Data Pattern
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Address

The cell address starts at 0 for the first data entry and automatically increments to the 
next available address. You can set it to a previously defined address to modify its content 
or insert additional data.

Insert/Overwrite Data

To define whether to overwrite data in a previously defined cell or insert new data after 
that cell, toggle the Insert/Overwrite button.

Save

When you have completed a data block definition, click the Save button to save the newly 
created data block. 

2.19 Counter

To use a counter as data, click the Counter button, enter a Starting Number for the 
counter and the data address to count to, and click OK.

Figure 2.89: Set Counter as Data
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2.19.1 Random Data Pattern

To use a random data pattern, click the Random button, enter the number of times to 
repeat the pattern, and click OK.

Figure 2.90: Choose a Random Pattern

2.19.2 Walking Bit Pattern

To use a walking bit pattern, click the Walking Bit button, then choose either a walking bit 
of “0” or “1”, the walk direction, the start position, and the number of times to repeat the 
pattern.

Figure 2.91: Define a Walking Bit Pattern
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2.19.3 Creating and Editing Data Blocks as Text

You can create and edit data blocks using a text editor such as Windows® Notepad. To 
create a data block in Notepad, launch Notepad. Enter a header consisting of [Item1, 
Item2, Item3, Item4, Item5] where:

Item1 is the name of the Data Block.

Item2 is the size of the Data Block or the number of bytes in the format.

Item3 is the format of the data (HEX, BIN, ASCII).

Item4 is the group of bytes defined (1, 2, 4, 8 or 16).

Item5 is the direction (LSB or MSB).

Then enter the data in space delimited Hex format and save as a *.txt text file.

2.19.4 Load Data

To import Text Editor created data, click the Load button in the data block definition 
dialog to open the Load dialog. Choose a file and click Load. Modify existing data.

2.19.5 Save As

To create a new data block from an existing data block using a text editor, select the data 
block to edit from the Data Block Name list, then click Save As to open the Save As dialog.

Assign a name to the new data block text file and click Save.

You can now edit the newly created text file using Notepad or any other text editor, then 
import it into the data block definition, as described above.
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Chapter 3

Display Manipulation
3.1 Viewer Display

After data is captured (Recorded), the Viewer displays a sample file (.scs for SAS and .sts 
for SATA) in Packet View.

Figure 3.1: SAS: Packet View of .scs Sample File.

3.1.1 Scrolling

On Packet View / Spreadsheet View / Column View / Text View, with frame A selected:

 If you scroll with the mouse wheel or go up / down with keyboard arrow button, 
the software will scroll the view but the frame A remains selected.

 If you scroll with mouse wheel or go up / down with keyboard arrow button while 
pressing the Shift button, software will scroll to the next frame like B, C, or D.
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Figure 3.2: SATA: Packet View of .sts Sample File.

3.1.2 Quick View

By default, the Preferences settings enable Quick View. Quick View allows full access to 
the whole trace more quickly, especially when using a Gigabit Ethernet connection. 
However, the trace is NOT written to the host machine’s hard drive. To save the trace, you 
must manually click Save. 

If you uncheck Quick View in the Preferences to disable Quick View, the trace loads more 
slowly, but is automatically saved to the host machine’s hard drive. When Quick View is 
disabled, the Viewer displays successive parts of trace data as they upload. As soon as a 
trace part uploads, it is available in all trace views. 

If you only need quick successive traces, and do not need to save them, keep the default 
setting to enable Quick View.

If you need to save all captured traces, unchecking the Quick View setting loads traces 
faster, especially for larger traces and slower connections than Gigabit Ethernet.

To refresh the viewer display with more uploaded data, scroll to the end of the trace, 
using scroll bars, page down, arrow down, or CTRL‐End. Newly uploaded data then 
appears there.

Note:High‐level decoding and statistics are available only after the whole trace has uploaded.

The software automatically switches to full trace view after trace uploading finishes.

Note:Users must press CTRL Home to go to the beginning of an uploaded trace, and CTRL End to go to 
the end of an uploaded trace.
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3.1.3 Using the Viewer Display

To configure the data viewer display, use the toolbars. You can display the same data in:

 Packet view
 Spreadsheet view
 Column view, with transactions grouped for each active port
 Text view, with transactions grouped for each active port
 Waveform view
 Frame Inspector view
 Histogram view
 Bus Utilization view
 Data Report
 Statistical Report view

To change the view type when opening a sample, change the default workspace or save 
options in the Preferences dialog.

To toggle among open windows, use CTRL ‐ TAB. 
To reverse toggle order, use CTRL ‐ SHIFT ‐ TAB.

To make a frame a trigger pattern, in Packet View, right‐click any frame, select 
Add to Trigger, and add the pattern to DataPatternCapture. 

Viewer Display enables you to also perform the following:

 Decode Assignments (Refer to “Decoding Assignments” on page 123 for more 
details.)

 Compare Two Data Payloads (Refer to “Compare Two Data Payloads” on 
page 189 for more details.)

 Run Verification Scripts (Refer to “Running Verification Script Engine (VSE)” on 
page 197 for more details.)

3.2 Trace Properties

The Trace Properties dialog displays:

 Software version
 Sample file version
 Grouping Type
 Hardware bin file version
 Analyzer armed at
 Analyzer triggered at
 Sample saved at
 Original Capture Project: Open displays the project settings used to capture the 

sample.
 Licensing Information
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Figure 3.3: Trace Properties Dialog.

3.3 Analysis

The Analysis menu options allows you to see the trace in various views and switch views.

3.3.1 Analysis Toolbar

To display the capture in any of the other available views you can make the selection on 
the View Type toolbar as shown below or select the menu option under Analysis as 
shown in Figure 3.5 on page 123.

Figure 3.4: View Type Toolbar.
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Figure 3.5: SAS/SATA Analysis Menu.

3.3.2 Decoding Assignments

The SAS/SATA Protocol Suite is designed to automatically assign SCSI decoding to a trace by using 
SBC3‐SPC4 for SSP based transactions and MMC6‐SPC4 for ATAPI/STP based transactions. To view 
the current decoding assignment for devices in the trace, click on the Decoding Assignments 
icon. See Figure 3.5and Figure 3.6.
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1

Figure 3.6: Decoding Assignments

In the Decoding Assignments window, the hashed address for all SCSI devices detected in 
the trace will appear in the Hash Destination SAS Address list. The supported 
specifications appear in the window on the right labeled SCSI Specs. The Assigned SCSI 
Specs scroll list displays the current assignment for each hashed address detected in the 
trace. This scroll list allows users to manually change the decoding assignment post 
capture. This may be necessary if the trace contains SAS traffic that is not SCSI Block 
Command 3 (SBC3) based, such as SAS tape or multimedia devices (rare). 

If for any reason, the Assigned SCSI Specs list is displaying an incorrect spec for an 
individual device, select the Hash Address within this list and click the Remove button. To 
assign a different specification to the same device, reselect the device hashed address in 
the upper Hash Destination SAS Address window. Then select the correct specification in 
the SCSI Spec(s) window. Click the Add to Assigned List button to assign the individual 
decode. It's only possible to assign one SCSI Spec to a given hash address. Decoding 
changes should appear immediately but It's necessary to save the trace to keep any  
decoding changes. 

In general SATA devices do not require manual decode assignment. Most SATA‐based 
HDD/SSD devices use the ATA/ATAPI command set and are automatically decoded using 
the MMC6‐SPC4 specification. Some removable SATA multimedia devices utilize the 
PACKET feature set (also known as ATAPI devices). These ATAPI based devices use a subset 
of the SCSI command set by default will be decoded using the Multi‐Media Commands ‐ 6  
(MMC6‐SPC4). Some SATA multimedia devices may alternately use the SCSI Streaming 
Command set (SSC2‐SPC4). For these devices it may be necessary to manually assign the 
decoding to the SSC2‐SPC4 spec. See Figure 3.7 on page 125.
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Figure 3.7: Decoding Assignments SATA

To make changes to the default decoding, use the Preferences window to assign the 
specific SCSI specification for all future traces. By changing the default decoding in the 
Preferences window, the Search and Hide options will also reflect the correct decoded 
fields. See Figure 3.8 on page 126.
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Figure 3.8: Preferences Window

If a specific SCSI Spec does not appear in the SCSI Specs window, it may not be supported 
by the current release of the SAS / SATA Protocol Suite. Contact Teledyne LeCroy Technical 
Support to request additional decode development. 

3.3.3 Packet View

After you select a view, it appears in a separate window. To increase the new window 

display size, select View > Packet View or click the   Show/Hide Packet View 
button to hide the Packet View.

When scrolling through a window display using the scroll bar, the displays in the other 
windows also scroll.

To rearrange the tiling, select the Window menu and choose Cascade, Tile Vertical, or 
Tile Horizontal.

You can customize the color of any operation code field using either of the following two 
methods:
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1. Right‐click on any command field in the trace. Select "Color of ..." option to set the 
color for the selected operation code field.

2. In the Preferences window, select the Packet View tab. select the "Based on Specific 
Command Type" option. In the commands list, search for any command that you 
want, and change the background and foreground colors.

Packet View Metrics

The Metrics feature provides quick access to additional information about the packet 
data. Click the Metrics + icon as shown in Figure 3.9 to display the details.
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Figure 3.9: Packet View Metrics.

The following additional information of the packet is displayed when the Metrics field is 
expanded. Refer to Figure 3.10 on page 128.

Performance Reference Definitions
Trp. No. ‐ Number of Transports

The total number of transports that compose this exchange.
Resp. Time ‐ Response Time

The time taken to transmit this command on the link(s) from the beginning of the 
first frame in the command to the end of the last frame in the command.

Pld. Bytes ‐ Payload Bytes
The number of payload bytes this operation transferred.

Latency Time
The time measured from the transmission of the command to the first data 
transmitted for this IO operation.

Data‐Stat. Time ‐ Data to Status Time
The time between the end of data transmission for this command and the Status 
frame.

Thrpt MB/s‐ Data Throughput
The payload divided by response time expressed in MB per second.

Duration
The time taken from the first DWord to the last DWord in a line.

Figure 3.10: Packet View Metrics Expanded.

Copying Packets from a Trace to a Host Emulator Script

This check mark in the illustration below shows packet (s) selected to copy. You can copy 
packet(s) from a trace and paste it into a host emulator script. That is why you can only 
mark packets that we support in emulator and host side packets. You can also mark 
multiple packets by left‐clicking and moving the mouse over multiple packets and then 
right‐click to select them, and paste them in an emulator script.
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Figure 3.11: Packets Selected to Copy.

Note:This is applicable only when using M6‐4 or M6‐2 as only they support emulation.

3.3.4 Viewing Check Condition Sense Data

When a Check Condition error occurs, you can view decode data from it. This information 
is shown in Packet View. Under Transport layer, expand Info Unit, then expand Sense 
Data. In Column View, check the "Show Field View in Column View" check box in SW 
settings, then display Field View while column View is open. 

Figure 3.12: Check Condition Data.
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1. Open Packet View.

Figure 3.13: Packet view. 

2. Show Transport layer.

Figure 3.14: Transport layer. 

3. Expand the Information Unit.

Figure 3.15: Information unit. 
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4. Expand Sense Data. The hidden fields are revealed.

Figure 3.16: Sense data. 

Figure 3.17: Sense data expanded. 

Go to Command / Go to Response

The Go to Command / Go to Response feature can be used to scroll through a large data 
packet to find SCSI commands and responses.

To use the Go to Command / Go to Response feature, open a trace with a data packet and 
“Right Click” on the Data section of the packet. See Figure 3.18 on page 131.

Figure 3.18: Goto Command / Goto Response Menu

Clicking on Goto Command will take you to the Command Packet 1. See Figure 3.19 on 
page 132.
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Figure 3.19: Typical Goto Command Trace

Clicking on Goto Response will take you to the Response Packet 35. See Figure 3.20 on 
page 132.

Figure 3.20: Goto Response Trace

Note:Export to Text/Excel is available from the Spreadsheet View, Packet View or Text View as of S/W 
version 5.60 or later. Export to Text/Excel is not available from Column View as of S/W version 
5.60 or later.

3.3.5 Changing the Default View

Perform the following steps to change the default view of all trace files to Packet View: 

1. Open a trace file.

2. Select the Packet View. Close all other views.

3. Select File > Save Workspace to open a Save As dialog. Save the current workspace 
as a .wss file.

4. Select Setup > Preferences to open the Trace Viewer dialog.

5. In the Default Workspace field, enter the path and name of the workspace .wss file 
that you saved in step 3.
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Because the default workspace contains only Packet View, the software opens trace files 
in Packet View.

3.3.6 Updating the Workspace 

If you’d rather have a set of views open when you open a Trace, you can select a set you 
like and store that particular set of views as a workspace_your_description.wss file. The 
next time you open any Trace it will initially come up showing the Default Workspace (as 
shown in “Changing the Default View” on page 132), but then you can open a Workspace 
you have defined and the Trace will be displayed in your unique Workspace set.

Perform the following steps to define a set of views that you are interested in:

1. Open a trace file. (In this case the 1.5‐3.0‐6.0 Trace has been opened). See 
Figure 3.21 on page 133.

Figure 3.21: Default Workspace (Trace View)

2. Select the other views you’d like to see. (In this case we have chosen Packet, 
Spreadsheet, Column and Bus Utilization. See Figure 3.22).
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Figure 3.22: Workspace with Four Views (Packet, Spreadsheet, Column, Bus Utilization)

3. Now you can save this set of Views to be called up later or as the Default Workspace 
per “Changing the Default View” on page 132.

4. If you Save the Workspace with four views as the Default, the next Trace you open 
will have all the views you want to see. See Figure 3.23.

Packet View Spreadsheet View

Column View Bus Utilization View
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Figure 3.23: Default Workspace Contains Four Views (Trace = NewSample.scs)

5. If you want to know which Views make up the Workspace, select File ‐> Open ‐> 
then select the Workspace file: (workspace_w_4_views_default.wss). See 
Figure 3.24 on page 135.

Figure 3.24: New Default Workspace with Four Views

Packet View Spreadsheet View

Column View Bus Utilization View
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6. To the right side of the window you can see the Packet, Column, Spreadsheet and 
Bus Utilization Views are selected.

3.3.7 Spreadsheet View

Spreadsheet View displays all of the Packet View fields in a time sequential spreadsheet 
format. To display the Spreadsheet View of the current capture, click 

Analysis > Spreadsheet View or click the   button on the View Type toolbar.

Figure 3.25: SAS: Spreadsheet View.

Figure 3.26: SATA: Spreadsheet View.

Right‐click a column heading to go to Preferences, make all columns the same width, 
choose Time Stamp Format, or Goto a position. 

Right‐click a column heading to Hide or Show the column. To show the same columns 
permanently, select Setup> Preferences > Trace Viewer > As Previously Saved. 

Right‐click the column to Add Bookmark or Edit Bookmark, Set Time Stamp Origin, go to 
Preferences, choose Time Stamp Format, Change Background (or Foreground) Color, or 
Goto a position.

Note:You can double‐click a data frame to display the data payload view. 
The Status column can show ABRT and UNC status.
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Spreadsheet View: Column Add/Edit/Delete

Right click on the Column Heading to bring up the Options Dialog, see Figure 3.27.

Figure 3.27: Spreadsheet View: Column Heading Options

You can Add a new column, Edit a new or existing Column or Delete a new or existing 
Column.

If you select Add Column the following dialog will pop up, see Figure 3.28 on page 138.
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Figure 3.28: Column Header Options Dialog

From this dialog you can customize the Spreadsheet View Columns by adding:

 Link Fields
 Transport Fields
 ATA Cmd. Fields
 SCSI Cmd. Fields
 SMP Cmd. Fields
 Additional Fields

Each option will bring up a dialog with characteristics for that field which would become 
a new column. Select an item from the drop down, in this case Link ‐> Frame Information 
Structure (FIS) was chosen. See Figure 3.29 on page 139.
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Figure 3.29: Frame Information Structure (FIS) Selected

The new Spreadsheet View with the new Column is shown in Figure 3.30 on page 140.
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Figure 3.30: Spreadsheet View with New Column Added (FIS)

You can change any of the options shown in the “Add Column to Spreadsheet View” 
dialog (see Figure 3.29 on page 139) – Edit the Column or Delete the Column.

Primitives Displayed in Both Spreadsheet and Packet Views

The following primitives are shown if they are inside a frame:

 RRDY_NORMAL
 ACK
 NAK_CRC_ERROR
 CREDIT_BLOCKED
 BREAK
 DONE_ACK_NAK_TIMEOUT
 DONE_CREDIT_TIMEOUT
 DONE_NORMAL
 AIP_NORMAL
 SAS_ERROR

See Figure 3.31.
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Figure 3.31: Primitives Shown in Spreadsheet and Packet Views

Export As Text/Excel

Select File > Export > Export to Text/Excel to open the Save As Text dialog. 

For Save As Type, select Text Files or Excel Files.

Select options from With comma delimiter, Export Duration and Save in a Single CSV File.

For Save As Range, select All Packets or enter a cursor range.

Enter a File Name and click Save.
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Note:When Spreadsheet View is exported to text, the XFER‐Length field is always in hexadecimal 
format.

Note:Export to Text/Excel is available from the Spreadsheet View, Packet View or Text View as of S/W 
version 5.60 or later. Export to Text/Excel is not available from Column View as of S/W version 
5.60 or later.

Change Format of Logical Block Address (LBA)

You can set different LBA formats in Packet View and Spreadsheet View. To change the 
LBA format, right‐click the LBA column to display the popup menu, select Format, and 
change the format to Decimal, Hexadecimal, or Binary.

In Spreadsheet View, you can also Right‐click on a column heading to go to Preferences, 
click the Trace Viewer and then the Configuration icon to display the 
Trace Viewer Configuration dialog. Expand the Frame List/Spread Sheet View, select 
LBA/Sector#, and change the Format. If you cannot change the format there, select the 
Link Fields, Transport Fields, ATA Cmd. Fields, or SCSI Cmd. Fields node, select the field 
(such as “LBA High”), and then change the Format.

Spreadsheet View Context Menu

In Spreadsheet View a Context Menu is available by performing a right click on an Frame 
packet. See Figure 3.32.

Figure 3.32: Spreadsheet View Context Menu

Spreadsheet View

Spreadsheet 
View Context 
Menu
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From this window you can select the Enable Field List View and the Field List View will 
pop up, see Figure 3.33.

Figure 3.33: Field List View

The Field List View contains information about the selected Packet.

3.3.8 Column View

Column View displays the captured data grouped in columns by port. Each row shows 
captured DWORDs on different ports related to the timestamp. It also shows different 
speed (1.5G, 3G, 6G) DWORDs. Different DWORD cell height shows the duration of the 
DWORD. To display Column View of the current capture (see Figure 3.34 on page 143), 

click Analysis > Column View or click the   button on the View Type toolbar.

You can click the + sign to expand the packet and ‐ sign to collapse the packet. Hovering 
over the signs displays a tooltip showing the contents of the packet (see the arrows in 
Figure 3.34 on page 143). Right‐click a packet to change the background and foreground 
color. 

Figure 3.34: Column View.

Field List View
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Right‐click in the Column View to display commands: 

 Add Bookmark
 Expand All
 Preferences
 Time Stamp Format (LeCroy Format, Milli Second, Micro Second)
 Go to (Trigger Position, X Position, Y Position, Packet Number, Time Stamp, Book‐

mark, Begin, End)
 Goto within Packet (SOF, EOF, Next HOLD, Previous HOLD, Next HOLDA, 

Previous HOLDA, Next Align, Previous Align, Next R_IP, Previous R_IP)
 Set X‐Pointer
 Set Y‐Pointer
 Change Background Color
 Change Foreground Color

Note:The Column View displays the CRC value. To see different formats (10b, 8b, scrambled, and so 
on), select a format by clicking its Tool menu button.

Resize Columns

You can resize the columns in Column View by clicking in the column boundary and 
dragging the boundary to a new position.

Rearrange Columns

You can rearrange columns by left‐clicking in the column title and then dragging the drag‐

and‐drop icon   to a new position.

Note:Export to Text/Excel is available from the Spreadsheet View, Packet View or Text View as of S/W 
version 5.60 or later. Export to Text/Excel is not available from Column View as of S/W version 
5.60 or later.

3.3.9 Text View

Text View displays (see Figure 3.35 on page 145) the captured data interpreted as 
transaction frames, grouped in columns by port.

To display Text View, select Analysis > Text View or click the   button on the 
View Type toolbar.
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Figure 3.35: Text View.

Note:The LBA and Tag Number value are shown in the All Lanes column.

Note:Export to Text/Excel is available from the Spreadsheet View, Packet View or Text View as of S/W 
version 5.60 or later. Export to Text/Excel is not available from Column View as of S/W version 
5.60 or later.

Text View Context Menu

In Text View mode the Context Menu is available by performing a right click on a packet. 
See Figure 3.36.

Figure 3.36: Text View Context Menu

From this window you can select the Enable Field List View and the Field List View will 
popup, see Figure 3.37 on page 146.

Text View
Text 
View 
Context 
Menu
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Figure 3.37: Field List View

The Field List View contains information about the selected Packet.

3.3.10 Frame Inspector View

Frame Inspector View has lots of information that is available in Packet View, but not 
Spreadsheet View, so it is most useful in conjunction with the Spreadsheet View.
This view has the following three tabs:

Spec View: 

This view shows the Frame as it would appear in the spec, with the field names and 
values spelled out clearly. Fields that are too short to clearly contain the description can 
be viewed as tooltips by hovering the mouse over them. Some fields might have a a 
lowercase ‘e’ button at the top right corner. Pressing this button displays an ‘expanded’ 
view of the sub‐fields in this field.

Field View: 

This view shows, when applicable, a hierarchical display of the selected Packet, with the 
relevant fields in each level.

To open a Frame Inspector View of the current capture, select View > Frame Inspector 

View or click the   button on the View Type toolbar (see Figure 3.38 on page 146).

Figure 3.38: Frame Inspector View.

Field List View
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Field View Display Manipulation

If you select Field View, each Field and it’s Value for the selected Packet will be displayed 
(see Figure 3.39).

Figure 3.39: Field Inspector -- Field View Display Selected for a Specific Packet

If you want to manipulate the Field View display, you have the following options:

 Expand All (All fields will be displayed)
 Collapse All (Only the Packet type will be displayed)
 Show Field (Fields which have been hidden will show in the menu)
 Hide Field (You can select Fields to be hidden)

You can select several Fields to Hide. This will remove them from the Field View 
but will also remove them from the Packet View. See Figure 3.40 on page 147.

Figure 3.40: Field Inspector with Fields Hidden

All Fields are Shown

SMP Frame Type, Function, Allocated Response 
Length and Request Length are Hidden
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To display the Hidden Fields simply select them in the Show Field box. They will then be 
displayed in both the Packet View and the Field View.

3.3.11 Waveform Display

You can enable a waveform display for all active ports, and perform timing 
measurements, by positioning timing cursors within the waveform display (see 
Figure 3.41 on page 148).

Select View > Wave Form View or click the Show/Hide Waveform button on the 
View Type toolbar to enable the waveform display.

The Compact View shows the OOB Sequence with speed negotiation.

Figure 3.41: SAS: Waveform View.

Figure 3.42: SATA: Waveform View.

Making a timing Measurement

Timing measurements are made with two timing cursors T1 and T2. Click the left mouse 
button in the gray bar on the top of the waveform display at a point for the T1 cursor, and 
the right mouse button at a point for the T2 cursor. The time difference between the 
cursors is on a line connecting the two cursors.
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Figure 3.43: SATA: Timing Cursors Enabled.

Expanded Waveform View

To see a 10x time scale expansion of the waveform, uncheck the Compact View checkbox 
in the Waveform View window. The OOB Sequence has speed negotiation (Hardware 
version 4 or later).

Figure 3.44: SATA: Expanded Waveform View.

Performance Reference Definitions
Trp. No. ‐ Number of Transports

The total number of transports that compose this exchange.
Resp. Time ‐ Response Time

The time taken to transmit this command on the link(s) from the beginning of the 
first frame in the command to the end of the last frame in the command.

Pld. Bytes ‐ Payload Bytes
The number of payload bytes this operation transferred.

Latency Time
The time measured from the transmission of the command to the first data 
transmitted for this IO operation.

Data‐Stat. Time ‐ Data to Status Time
The time between the end of data transmission for this command and the Status 
frame.

Thrpt MB/s‐ Data Throughput
The payload divided by response time expressed in MB per second.

Duration
The time taken from the first DWord to the last DWord in a line.
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3.3.12 Statistical Report 

Whenever a captured sample is in the Sample Viewer, a Statistical Report selection in the 
Report menu and a Statistical Report Button on the viewer toolbar are enabled. You can 
create a Statistical Report for the entire capture or select a portion of it.

To display a Statistical Report, click the   Statistical Report button on the viewer 
toolbar or select Report > Statistical Report to display the Select Statistical Report Range 
dialog (see Figure 3.45 on page 150).

Figure 3.45: Statistical Report Range Dialog.

The default statistical report has All Samples. You can set a specific Statistical report range 
between defined cursor positions or events.

Generating Statistical Read/Write Report

To create a statistical read/write page perform the following steps:

1. Click on Setup > Preferences.

2. Click on the Trace Viewer tab.

3. Check the box Create statistical report read/write page (see Figure 3.46 on 
page 151.)
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Figure 3.46: Enabling Read/Write Statistical Report.

Note:This setting should be enabled before you capture the trace file. 

If you have already captured a trace file and want to create a read/write statistical report 
for the sample, perform the following steps: 

1. Enable the read/write settings as mentioned above.

2. Open the trace file. 

3. Set the X pointer on the first packet in the viewer. 

4. Set the Y pointer on last packet in the viewer. 

5. Save as the trace file using the X to Y option. 

Now the saved trace file will contain the read/write statistical report. 

Report Between Cursors

Click the option button next to the From cursor selection drop down list. Then click the 
From down arrow and choose the 1st cursor, click the To down arrow to choose the 2nd 
cursor, and click OK. The resulting report has only the capture between the cursors (see 
Figure 3.47 on page 152).
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Figure 3.47: Report between Cursors.

Report Between Events (see Figure 3.48)

1. Click the option button next to the From the event selection dropdown list.

2. Click the From down arrow to choose the first event. Choose from the following 
event types:

 Link
 Transport
 ATA Cmd.
 SCSI Cmd.
 SMP Cmd.
 Task Mng.

3. Enter the number of its occurrence. 

4. Click the To down arrow to choose the second event.

5. Enter the number of its occurrence.

Figure 3.48: Report between Events.

6. Click OK. The resulting reports are limited to the capture between the defined 
events.
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Statistical Report Content

A complete statistical report consists of the following reports, accessed by clicking the 
corresponding tab in the dialog see: Figure 3.49 on page 153.

Figure 3.49: Analysis: Statistical Reports Showing Ports

 General
 Primitive
 SSP Transport
 SMP Transport
 FIS
 ATA Command
 Queue Command
 ATAPI Command
 SCSI Command
 SMP Command
 Task Command
 Read/Write Command
 SAS Address
 Protocol Error
 Performance
 Lanes
 Pending IO
 Others

Performance Reference Definitions

Trp. No. ‐ Number of Transports
The total number of transports that compose this exchange.

Resp. Time ‐ Response Time
The time taken to transmit this command on the link(s) from the beginning of the 
first frame in the command to the end of the last frame in the command.

Pld. Bytes ‐ Payload Bytes
The number of payload bytes this operation transferred.

Latency Time
The time measured from the transmission of the command to the first data 
transmitted for this IO operation.
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Data‐Stat. Time ‐ Data to Status Time
The time between the end of data transmission for this command and the Status 
frame.

Thrpt MB/s‐ Data Throughput
The payload divided by response time expressed in MB per second.

Duration
The time taken from the first DWord to the last DWord in a line.

Note:Results are displayed only for items that have been captured in the sample.

Report Options

Some report categories offer options which display only specific items. The tabs shown in 
the examples below depend on the specific Trace loaded. These report categories 
incorporate drop‐down list boxes offering pre‐defined and custom options. For details 
see “Formatting the Statistical Report View” on page 175.

General Report

To display the General Report, click the General tab. The General Report displays the 
report data in columns with the following information Type of Frame, Port Type, 
Duration, Count and % (see Figure 3.50).

Figure 3.50: General Statistical Report.
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 Type contains: All, Custom, FIS, Open Address Frame, SSP Frame, Identify 
Address Frame, Incomplete Frame and SMP Frame (see Figure 3.51).

Figure 3.51: Statistical Report: General --> Type Descriptions

 Port: All, Custom, I1, T1, I2, T2, I3, T3, I4, T4 (see Figure 3.52).

Figure 3.52: Statistical Report: General --> Port

 Duration: All, Custom, or time unit
 Count: All, Custom, or a number of occurrences
 %: Percentage of total count
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Primitive Report

To display the Primitive Report, click the Primitive tab. The Primitive Report displays 
information in the following columns:

 Primitive: See Figure 3.53 (below)
 Port: See Figure 3.52 on page 155 (All, Custom, I1, T1, I2, T2, I3, T3, I4, T4)
 Count: All, Custom, or a number of occurrences
 %: Percentage of total count

Figure 3.53: Statistical Report: Primitive.
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Bus Condition Report

To display the Bus Condition Report, click the Bus Condition tab. The Bus Condition 
Report displays information in the following columns:

 Bus Condition: See Figure 3.54 (All, Custom, Activity On, COMINIT/COMRESET, 
COMWAKE, COMSAS)

 Port: See Figure 3.52 on page 155 (All, Custom, I1, T1, I2, T2, I3, T3, I4, T4)
 Count: All, Custom, or a number of occurrences
 %: Percentage of total count

Figure 3.54: Statistical Reports: Bus Condition
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SSP Transport Report

To display the SSP Transport Report, click the SSP Transport tab. The SSP Transport 
Report displays information in the following columns.

 Type: See Figure 3.55 on page 158 (All, Custom, Data, XFR_RDY, Command, 
Response and Task)

 Port: See Figure 3.52 on page 155 (All, Custom, I1, T1, I2, T2, I3, T3, I4, T4)
 Duration: All, Custom, or time unit
 Count: All, Custom, or a number of occurrences
 %: Percentage of total count

Figure 3.55: Statistical Reports: SSP Transport.
158 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual



Analysis  Teledyne LeCroy
SMP Transport Report

To display the SMP Transport Report, click the SMP Transport tab. The SMP Transport 
Report displays information in the following columns.

 Types: See Figure 3.56 (All, Custom, Request, Response)
 Port: See Figure 3.52 on page 155 (All, Custom, I1, T1, I2, T2, I3, T3, I4, T4)
 Duration: All, Custom, or time unit
 Count: All, Custom, or a number of occurrences
 %: Percentage of total count

Figure 3.56: SMP Transport Report
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FIS Command Report

To display the FIS Command Report, click the FIS Command tab (see Figure 3.57). The FIS 
Command Report displays information in the following columns:

 FIS Types: All, Custom, Register Host to Device, Register Device to Host, DMA 
Active, PIO Setup and Data

 Port: See Figure 3.52 on page 155 (All, Custom, I1, T1, I2, T2, I3, T3, I4, T4)
 Count: All, Custom, or a number of occurrences
 %: Percentage of total count

Figure 3.57: Statistical Reports: FIS Type

ATA Command Report

To display the ATA Command Report, click the ATA Command tab (see Figure 3.58 on 
page 161). The ATA Command Report displays information in the following columns:

 Command: All, Custom, Check Power Mode, Execute Device Diagnostic, 
Flush Cache, Identify Device, Read DMA Ext, Read FPDMA Queue, Set Feature, 
Write DMA Ext, Write FPDMA Queue

 PM Port
 Port: All, H1, I1, H2, I2, H3, I3, H4, I4, or Custom
 Number of FIS: All, Custom, or a number
 Payload Size: All, Custom, or a number of DWORDs
 Status: All, Custom, Incomplete, Normal Output
 Timeout: All, Custom, N/A, Yes, No (see “Time out of ATA Command Report” on 

page 161)
 Duration: All, Custom, or time unit
 Count: All, Custom, or a number of occurrences
 %: Percentage of total count
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Figure 3.58: Statistical Reports: ATA Command Report from Three Different Traces

Time out of ATA Command Report

The Time out shows the NCQ time out. It is applicable for only NCQ commands. A 
threshold can be set in the "NCQ commands Timeout Threshold", the default value is 
1000 sec (the user can change it to any value). The statistical report provides a "Time 
out" report based on this threshold. Any NCQ command that takes more than the given 
threshold is flagged as "yes", which means that a timeout occurred for that command.
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Queue Command Report

To display the Queue Command Report, click the Queue Command tab (see Figure 3.59 
on page 162). The SMP Transport Report displays information in the following columns.

 Command: Read DMA Queued
 PM Port:
 Status: Normal Output
 Payload Size: Number
 Port: All, H1, I1, H2, I2, H3, I3, H4, I4, or Custom
 Duration: All, Custom, or time unit
 Count: All, Custom, or a number of occurrences
 %: Percentage of total count

Figure 3.59: Statistical Reports: Queue Commands
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ATAPI Command Report

To display the ATAPI Report (see Figure 3.60), click the ATAPI tab. The ATAPI Report 
displays information in the following columns:

 Command: All, Custom, Inquiry, Mode Sense 10, Read10, Request Sense, 
Test Unit Ready, Get Event Status Notification

 Port: All, H1, I1, H2, I2, H3, I3, H4, I4, or Custom
 Number of Transport: All, Custom, or a number
 Payload Size: All, Custom, or a number of DWORDs
 Status: All, Custom, Check Condition, Good
 Duration: All, Custom, or time unit (accumulative)
 Count: All, Custom, or a number of occurrences
 %: Percentage of total count

Figure 3.60: Statistical Reports: ATAPI Report.
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SCSI Command Report

To display the SCSI Command Report (see Figure 3.61 on page 164), click the SCSI 
Command tab. The SCSI Command Report displays information in the following columns:

 Command: All, Custom, Write 10, Inquiry, Read 10, Mode Sense 10, 
Persistent Reserve Out, Report Target Port Groups, Read Capacity, 
Test Unit Ready

 Port: All, H1, I1, H2, I2, H3, I3, H4, I4, or Custom
 Number of Transport: All, Custom, or a number
 Payload Size: All, Custom, or a number of DWORDs
 Status: All, Custom, Check Condition, Good
 Task Attribute: Simple
 Duration: All, Custom, or time unit (accumulative)
 Count: All, Custom, or a number of occurrences
 %: Percentage of total count

Figure 3.61: Statistical Reports: SCSI Command
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SMP Command Report

To display the SMP Command Report (see Figure 3.62 on page 165), click the SMP 
Command tab. The SMP Command Report displays information in the following columns:

 Function: All, Custom, Report General, Report Manufacturer Information, Dis‐
cover List

 Port: All, H1, I1, H2, I2, H3, I3, H4, I4, or Custom
 Number of Transport: All, Custom, or a number
 Payload Size: All, Custom, or a number of DWORDs
 Status: All, Custom, Check Condition, Good
 Task Attribute: Simple
 Duration: All, Custom, or time unit (accumulative)
 Count: All, Custom, or a number of occurrences
 %: Percentage of total count

Figure 3.62: Statistical Reports: SMP Command
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Task Command Report

To display the Task Command Report, click the Task Command tab (see Figure 3.63). 
The Task Command Report displays the report data in columns with the following 
information:

 Function: All, Custom, Abort Task
 Status: Good
 Port: All, H1, I1, H2, I2, H3, I3, H4, I4, or Custom
 Duration: All, Custom, or time unit (accumulative)
 Count: All, Custom, or a number of occurrences
 %: Percentage of total count

Figure 3.63: Statistical Reports: Task Commands
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Read/Write Command Report

Note:To generate this report as well as all the other Statistical Reports, the “Create statistical report 
read/write page” option must be checked in the Preferences ‐> Trace Viewer page. See 
“Statistical Report” on page 150 and Figure 3.46 on page 151.

To display the Read/Write Command Report, click the Read/Write Command tab (see 
Figure 3.64 on page 167).The Read/Write Report displays the report data in columns with 
the following information:

 Time Stamp: All, Custom, Number
 Source SAS Address: All, Custom, Number
 Destination SAS Address: All, Custom, Number
 Protocol Type: All, Custom SSP, STP
 OpCode/Command: All, Custom, Read10, Write10, Write DMA Ext, Read DMA 

Ext, Identify Device
 Tag: All, Custom
 LBA: All, Custom
 Sector Count: All, Custom, Number
 Xfer Length: All, Custom, Number
 Payload Size: All, Custom, Number
 Status: All, Custom, Good, Normal Output, Incomplete
 Completion Time: All, Custom, Number
 Performance: All, Custom, Number
 Standard Deviation: All, Custom, Number
 Count: Number

Figure 3.64: Statistical Reports: Read/Write Command
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SAS Address Command Report

To display the SAS Address Command Report, click the SAS Address tab (see Figure 3.65 
on page 168).The SAS Command Address Report displays the report data in columns with 
the following information:

 Source SAS Address: All, Custom, Number
 Destination SAS Address: All, Custom, Number
 Protocol Type: All, Custom, SSP, STP, SMP
 Frame Type: All, Custom, Data, Response, Command, XFER RDY, Register Device 

to Host, Register Host to Device, DMA Activate, Task, Request, PIO Setup
 Count: All, Custom, Number

Figure 3.65: Statistical Reports: SAS Address Command
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Protocol Error Report

To display the Protocol Error Report, click the Protocol Error tab (see Figure 3.66 on 
page 169). The Protocol Error Report displays the report data in columns with the 
following information:

 Protocol Error: All, Custom, Code Violation, CRC Error, Disparity Error, Align‐
Notify Error

 Port: All, H1, I1, H2, I2, H3, I3, H4, I4, or Custom
 Count: All, Custom, or a number of occurrences
 %: Percentage of total count

Figure 3.66: Statistical Reports: Protocol Error Report.
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Performance Report

To display the Performance Report, click the Performance tab (see Figure 3.67 on 
page 170). The Performance Report displays the report data in columns with the 
following information:

 Performance Items: All, Custom, Total Read Size, Total Read Duration, Total Read 
Commands, Min., Max., Ave. Read Throughput, Min., Max., Ave. Read Latency 
Time, Min., Max., Ave. Read Response Time, Read IO Per Second, Total Write 
Size, Duration, Commands, Min., Max., Ave. Write Throughput, Min., Max., Ave. 
Write Latency Time, Min., Max., Ave. Write Response Time, Write IO Per Second, 
Total IO Per Second, Ave. Byte Per SSP Frame, Ave. Byte Per FISFrame, Init. Bus 
Util, Target Bus Util, Efficiency, Max., Min., Ave., FIS Diff

 Port: All, H1, I1, H2, I2, H3, I3, H4, I4, Custom, or NA
 Value: Number
 Description: Definition of Performance Items

Figure 3.67: Statistical Reports: Performance Items
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Lanes Report

To display the Lanes Report, click the Lanes tab (see Figure 3.68 on page 171). The Lanes 
Report displays the report data in columns with the following information:

 Port: All, H1, I1, H2, I2, H3, I3, H4, I4,or Custom
 Open Accept: All, Custom or Number
 Open Reject: Number
 AIP Waiting on Con.: Number
 Break: Number
 SCSI Command: All, Custom or Number
 ATA Command: Number
 SMP Command: All, Custom or Number
 Outstanding Command: Number
 Transfer Bytes: All, Custom or Number
 Link Utilization: Number
 Link Utilization %: Percentage of total count

Figure 3.68: Statistical Reports: Lanes Report

Pending I/O Report

To display the Pending IO Report, click the Pending IO tab (see Figure 3.69).The Pending 
IO Report displays the report data in columns with the following information:

 Pending IO: All, Custom, SCSI or ATA
 Max. Pending IO: All, Custom, or Number
 Ave. Pending IO: All, Custom, or Number

Figure 3.69: Statistical Reports: Pending IO
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Others Report

To display the Others Report (see Figure 3.70 on page 172), click the Others tab. The 
Others Report displays information in the following columns:

 Items
 Idle No: Number of idle packets
 Payload Size: Total number of payloads in trace files (SCSI + ATA commands)
 Sample Time: Sample time
 Idle (Initiator): Host idle time
 Idle (Target): Device idle time (total)
 SSP Bus Utilization: SSP bus utilization time (SSP frames)
 SMP Bus Utilization: SSP bus utilization time (SMP frames) 
 STP Bus Utilization: SSP bus utilization time (STP frames)

 Report
 Count or Time

Figure 3.70: Statistical Reports: Others Report.

3.3.13 Statistical Report Toolbar

The Statistical Report toolbar provides the following functions accessible by buttons on 
the toolbar:

 Export to Excel
 Save as Text
 Print Report
 Print Preview
 Report Display Settings
 Move to X‐Cursor, Y‐Cursor, or None 



Analysis  Teledyne LeCroy
Export as Microsoft® Excel file

Save as Text file

Print Statistical Report

Print Preview

Figure 3.71: Sample Print Preview of Report

The Export to Excel button opens the Export to Excel dialog. Choose a folder in 
which to save the Excel file, choose an appropriate file name, and click Save.

The Save as Text button opens the Export to Text dialog. Choose a folder in 
which to save the Text file, choose an appropriate file name, and click Save.

The Print button opens the select printer dialog. Choose an available printer 
and click OK.

The Print Preview button displays a preview of the report to print (see 
Figure 3.71 on page 173).
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Report Display Settings

You can set up the report columns for display to suit a particular analysis need, 
eliminating the need to show/hide columns individually. Use the Setting dialog to 
configure the display for each page (see Figure 3.72 on page 174) and (see Figure 3.73 on 
page 174).

Figure 3.72: SAS: Statistical Report Column Setting

Figure 3.73: SATA: Statistical Report Column Setting

The Setting button opens the Setting dialog.
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Link With Sample View

When you select a type on any page of the Statistical Report, a set of navigation buttons 
allows you to examine each instance of that type in the Sample Viewer.

3.3.14 Formatting the Statistical Report View

Initially the Statistical Report View contains all of the information in columns, but you can 
customize the display by:

 Filtering columns by item
 Sorting items by column
 Hiding any column on the display

Filtering Column Content

To filter column content, click the down arrow in the heading for that column and choose 
the items to display. The default is All. By checking a specific item, you exclude everything 
but that item for display.

The Jump to Previous button goes to the previous instance of the selected type in 
the Sample Viewer.

The Jump to Next button goes to the next instance of the selected type in the 
Sample Viewer. 

The Jump to Specific button goes to the instance specified as N of M items on the 
Statistical Report toolbar.

The Move drop-down list moves to the X-Cursor, Y-Cursor, or None.
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.

Figure 3.74: SAS: Type

Choosing Custom allows you to specify more than one item for display.

Figure 3.75: SAS: Custom Filter

Figure 3.76: SATA: FIS Type

Choosing Custom allows you to specify more than one item for display.
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Figure 3.77: SATA: Custom Filter

Check the items to display and click OK.

Sorting Column Content

To sort column content, click the heading for that column. Repeated clicking of the 
column heading sorts the column in ascending or descending order.

Figure 3.78: Toggling Type Sort Order

Hiding Columns

To hide a column, right‐click in the column and choose Hide. To unhide a column, right‐
click any column and choose Unhide.
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3.3.15 Histogram View

The Histogram View displays a histogram of frame‐type transfers.

To display the Histogram View of the current capture, click View > Histogram View or 

click the   button on the View Type toolbar.

Figure 3.79: Histogram View

Hide Frames

You can customize the histogram by including only frame types that you want.

To choose frame types to include in the display, click the down arrow on the Frame 
button on the Histogram toolbar and check frame types:

Figure 3.80: SAS: Histogram Frames

Figure 3.81: SAS: Histogram Frames

Hide Error Frames

Frames with errors are displayed in red. To hide error frames from the histogram, 

click the   button.

Note:To display the error code of a protocol error, click the error icon (with the red 'x').
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Pending IO Graph

The Tool menu has a Pending IO Graph command, with horizontal zoom, vertical zoom, 
click and drag zoom, graph area zoom, synchronize with trace view, fit to graph area and 
graph view. 

User Defined

You can define additional items for inclusion in the Histogram by clicking 

the  button to open the User Defined dialog. See the 
following screen capture:

Figure 3.82: SAS: Histogram User Defined Dialog

You can include Primitive and/or Outside Connections frames.

Primitives

To include Primitives, check the Primitive check box, click the down arrow on the 
Primitive list box, and choose a Primitive.

 

Figure 3.83: SAS: Choosing a Primitive
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Figure 3.84: SATA: Choosing a Primitive

Check a Connection Type option radio button, if available, and click OK.

Zoom

You can Zoom from x1 to x256.

3.3.16 Bus Utilization View

The Bus Utilization View displays information on pending IO, IO Throughput, Latency 
Time and Response Time. To display the Bus Utilization View of the current capture, 
Select Analysis from the Main Toolbar, see Figure 3.85.

Figure 3.85: Analysis: Bus Utilization Dialog

then

select Bus Utilization View or click the   button on the main tool bar.
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This will bring up the Bus Utilization Toolbar (see Figure 3.86), which has the following 
functions:

Figure 3.86: Bus Utilization Toolbar Functions

 Horizontal zoom in
 Horizontal zoom out
 Vertical zoom in
 Vertical zoom out
 Click and drag zoom mode
 Graph areas

Select functions to view from the Available Bus Utilization Views from the Graph areas 
icon:

 Pending SCSI IO (for SAS): Shows number of pending commands
 Pending ATA IO (for SATA): Shows number of pending commands
 SCSI IO Throughput (for SAS): The payload divided by response time expressed in 

MB per second.
 ATA IO Throughput (for SATA): The payload divided by response time expressed in 

MB per second.
 SCSI IO Latency Time (for SAS): The time measured from the transmission of the 

command to the first data transmitted for this IO operation.
 ATA IO Latency Time (for SATA): The time measured from the transmission of the 

command to the first data transmitted for this IO operation.
 SCSI IO Response Time (for SAS): The time taken to transmit this command on 

the link(s) from the beginning of the first frame in the command to the end of 
the last frame in the command.

 ATA IO Response Time (for SATA): The time taken to transmit this command on 
the link(s) from the beginning of the first frame in the command to the end of 
the last frame in the command.

See figure below (Figure 3.87 on page 182).
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Figure 3.87: Graph Selected Functions: SCSI Functions Selected

This will bring up graphs for the Selected functions (see Figure 3.89 on page 184).
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Figure 3.88: Waveform View for Full Trace

Select Packet View to see both the Packet and the Waveforms. See Figure 3.89 on 
page 184.
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Figure 3.89: Packet and Waveform Views

Right clicking the mouse over the graph heading displays the graph legend:

 Go to ATA/SCSI Cmd. #: Jump to command.
 Synchronize with Trace View: Synchronize all open views to that location in the 

trace.
 Fit to Graph Area: Zoom to fit.
 Hide: Do not display the graph.

See Figure 3.90 on page 185.
184 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual



Analysis  Teledyne LeCroy
Figure 3.90: Right Click on Graph Heading Dialog

Selecting Go to SCSI Cmd. 264 and Synchronize with Trace View will bring up both the 
Packet View and the associated Waveforms. See Figure 3.91.

Figure 3.91: Packet View and Waveforms Synchronized

Then you can zoom in to the waveforms associated with the selected packet. See 
Figure 3.92 on page 186.
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Figure 3.92: Zoom In on Waveforms near the Selected Packet

Performance Reference Definitions
Trp. No. ‐ Number of Transports

The total number of transports that compose this exchange.
Resp. Time ‐ Response Time

The time taken to transmit this command on the link(s) from the beginning of the 
first frame in the command to the end of the last frame in the command.

Pld. Bytes ‐ Payload Bytes
The number of payload bytes this operation transferred.

Latency Time
The time measured from the transmission of the command to the first data 
transmitted for this IO operation.
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Data‐Stat. Time ‐ Data to Status Time
The time between the end of data transmission for this command and the Status 
frame.

Thrpt MB/s‐ Data Throughput
The payload divided by response time expressed in MB per second.

Duration
The time taken from the first DWord to the last DWord in a line.

3.3.17 Bus Utilization Buttons

The Bus Utilization window has a row of buttons for changing the format of the displayed 
data. The buttons have the following functions: 

3.3.18 Data Report

When a captured sample is in the Sample Viewer, the Data Report button is on the 
Viewer toolbar, and Data Report is in the Report menu.

The data report displays all the data sent from the host to the device and from the device 
to the host. All PIO In => In commands are grouped as a data packet until the occurrence 
of a PIO Out => Out command, creating a new data packet.

To display a Data Report, click the   Data Report button on the Viewer toolbar or 
select Report > Data Report.

Figure 3.93: SAS: Data Report

Click the Down Arrow in a data field to display Data Report details (see Figure 3.94 on 
page 188).

Horizontal zoom in Vertical zoom in

Horizontal zoom out Vertical zoom out

Graph Areas
Presents options for displaying additional 
graphs.

Click and Drag zoom
Click diagonally to select and 
zoom in on part of the graph.

Hide graph.
Graph legend (see previous 
page)
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Figure 3.94: SAS: Data Report Details

Click the Statistics button  at the end of a row to display data report 
statistics.

Figure 3.95: SAS: Data Report Statistics

Data Payload View

To display the Data Payload View, double‐click a data payload field in a Packet or 
Spreadsheet view, or right‐click a data payload field and select Open as Data View:
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Figure 3.96: Data Payload View

Note:When showing truncated data in the Data Payload View, the truncation points are marked with 
a separator placed between payloads. You can get more information about the data exclusion 
using the tooltip over the separator.

Note:You can control the number of bytes per line.

Find Data Pattern

To quickly locate a data pattern in the current frame, enter the pattern in the Text Box and 
click the Find button.

3.3.19 Compare Two Data Payloads

To compare two data payloads, select two different payload packets, one as reference. 
Right‐click a payload field in Packet View or a related frame in Text View or Spreadsheet 
View to display a menu, then select Set As Reference Data Payload.
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Right‐click a payload field in Packet View or a related frame in Text View or Spreadsheet 
View to display a menu, and choose Set as Second Data Payload.

To compare data payloads, click the
Show/Hide Compare 2 Data Payloads button on the View Type toolbar:

Figure 3.97: Compare Two Data Payloads
190 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual



Trace Expert  Teledyne LeCroy
3.4 Trace Expert

Trace Expert generates the following reports and analysis for the currently loaded trace:

 Performance Analysis
 Error Reports
 Trace Analysis Statistics
 Trace Information

To use Trace Expert, load a saved Trace that you are interested in examining. In this case 
the Trace “SAS 12G.scs” has been loaded. This trace is used as an example and may not be 
suitable for all analyzers, but the basic steps are the same for any analyzer.

Next, find the Trace Expert icon which is available from the Main Toolbar as shown 

in Figure 3.98 or the Analysis Toolbar (shown on Figure 3.5 on page 123).

Figure 3.98: Main Toolbar: Trace Expert Icon

Click on the Trace Expert icon, which generates the following pop‐up dialog (Figure 3.99) 
showing all the Trace HTML files which contain the previously generated reports used by 
Trace Expert:

Figure 3.99: Trace Expert: Pop-Up Dialog

Currently loaded Trace
 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual 191



Teledyne LeCroy Trace Expert
Click on the Save button to add the currently loaded Trace to the list of Saved Trace Expert 
HTML files. These HTML files can then be re‐used. For example, the SAS 12G.html file 
(~150 KB containing all the Trace Expert reports and analysis for that Trace) could be 
emailed to a colleague or to Teledyne Customer Service without sending the whole Trace 
(~39 MB).

The Save process will also generate the SAS 12G Trace Expert HTML file with the following 
topics displayed for the loaded Trace (see Figure 3.100):

Figure 3.100: Trace Expert: Main Report Dialog

The main window has an Expand All button, a Collapse All button. a Print All button and a 
Save All button. The Save All button stores the Trace Expert html file to your Download 
folder.

You can select any of the four topics and information about that topic will be displayed. 

If there is no information on any of the four topics, no report will be generated. For 
instance if no Errors were detected, no report would be generated and the Error Report 
menu option wouldn’t appear.

Expand All

Collapse All
Print All

Save All
192 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual



Trace Expert  Teledyne LeCroy
3.4.1 Performance Analysis

To view Performance Analysis click on that button. See Figure 3.101.

Figure 3.101: Trace Expert: Performance Analysis

You can use the scroll bar to see more data.

Scroll Bar
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3.4.2 Error Reports

To view the Error Report, click on the that button. See Figure 3.102.

Figure 3.102: Trace Expert: Error Reports

You can use the scroll bar to see more data.
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3.4.3 Trace Analysis Statistics

To view the Trace Analysis Statistics, click on the that button. See Figure 3.103.

Figure 3.103: Trace Expert: Trace Analysis Statistics

You can use the scroll bar to see more data.

Scroll Bar
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3.4.4 Trace File Information

To view the Trace File Information, click on that button. See Figure 3.104.

Figure 3.104: Trace Expert: Trace File Information
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3.5 Running Verification Script Engine (VSE)

You can perform custom post‐process analysis of the open trace by running a verification 
script over the trace. A verification script instructs the application to send trace and 
analysis information to the script. A verification script also contains script code, written 
using CATC Script Language (CSL) (see the CSL_RefManual.pdf document in the docs 
directory of the installation), used to process trace data and output that data in different 
formats.

Note:You may write your own verification scripts to perform custom verification and analysis. For 
information on how to write a verification script, see the Verification Script Engine Reference 
Manual.

To run a verification script over a trace:

1. Select the main menu item Analysis > VSE or click the Running verification scripts 

button on the main tool bar. The Run Verification Scripts dialog opens, from 
which you choose and then run one or several verification scripts: 

Figure 3.105: Run Verification Scripts Dialog

To expand the Log window, click the Expand Log button. The Log window fills the whole 
window. To see the Verification Scripts window again, click the Collapse Log button.

To save output, click the Save Output button.
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2. After choosing Settings from the drop‐down list or the button, the Settings dialog 
appears:

Figure 3.106: Run Verification Scripts - Settings Dialog

Choose the editor application: Notepad or other.

Edit all selected scripts in one process: If the editor supports multiple documents, you 
can edit all scripts in the editor.

Open all included files: You can edit included files, as well as the main script.

Launch editor application in full screen: You can use whole screen.

Path to the template file for a new script: You can use a template for the script.

Display Settings can show full trace‐file path, restore dialog at start, load last output from 
save log files, activate dialog after scripts have run, remember dialog layout, and ignore 
errors and warnings.

Saving Settings can save log files to relative file folder, indicate output‐log‐file path, and 
save logs automatically.

3. Click the Run scripts button after you select scripts to run. VSE starts running the 
selected verification scripts, shows script report information in the output windows, 
and presents the results of verifications in the script list:
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Figure 3.107: Run Verification Scripts Dialog

4. Right‐clicking in the script list displays some additional operations over selected 
scripts:

Figure 3.108: Run Verification Scripts - Menu
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Run verification script(s): Start running selected script(s).

Edit script: Edit selected scripts in the editor application specified in Editor settings.

Rename script: Allows you to rename the selected script.

Remove script: Displays prompt for confirming removal of script.

New script: Create a new script file using the template specified in Editor settings.

Show Grid: Show/hide a grid in the verification script list.

Show Description window: Show/hide the script description window (Shortcut key F2).

Show Output: Show/hide the script output windows (Shortcut key F3).

Settings: Open a special Setting dialog to specify different settings for VSE.

3.6 Navigation + View Toolbar

The Navigation + View toolbar allows you to navigate, search filter, hide RRDY/all 
primitives and unassociated traffic, zoom, tile views and select ports.

The down arrow on the Go To button allows location of cursors or specific 
packets: Trigger Position, X Position, Y Position, Packet Number, Timestamp, 
Bookmark, Begin, and End.

The Search button opens the search dialog (see “Search” on page 218).

The Filtering Setup button opens the Filter dialog (see “Filtering” on 
page 206) and allows you to specify the criteria for filtering the result.

The Enable Disable Filtering button toggles the result between a filtered and 
unfiltered view (see “Filtering” on page 206).

The Filter Idle button toggles the display to show/hide idle packets (see 
“Filtering” on page 206).

The Hide RRDY Primitives button toggles the display to show/hide RRDY 
primitives (see “Filtering” on page 206).
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3.6.1 Go To Menu

Locate Cursors

To quickly locate any cursor within the data viewer display, click the Go To button and 
choose the cursor to locate. You can also locate a cursor by selecting Go To from the Edit 
menu and choosing the cursor to locate (see Figure 3.109 on page 202).

The Hide Unassociated Traffic button toggles the display to show/hide 
unassociated traffic (see “Filtering” on page 206).

The Hide All Primitives button toggles the display to show/hide all primitives 
(see “Filtering” on page 206. Note: When capturing PM traces, you need the 
ability to filter the PM primitives so you can find commands quicker. 

The Zoom In button on the Viewer Setting Toolbar magnifies the data display 
area on the screen. Clicking this button in Column or Text View increases 
column width only.

The Zoom Out button on the Viewer Setting Toolbar scales the data display 
area to display more data lines on the screen. Clicking this button in Column 
or Text View decreases column width only.

The Normal Zoom button on the Viewer Setting Toolbar resets the zoom to 
default normal on the screen. Clicking this button in Column or Text View 
resets column width only.

You can use Tile Horizontally All Views icon or select View > Tile Views to 
revert any unintended window docking or sizing, or maximize screen 
utilization. This function only tiles views inside a trace window.

Note that there is no command to tile views vertically.

The Data Report button displays the data report.

You can use this tool to incrementally Show or Hide 
Ports, either one at a time, or multiple ports at the 
same time. For multiple ports, select the desired ports 
to Show or Hide, and click Apply (see “Show/Hide 
Ports” on page 225).
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Figure 3.109: Locate Cursor

Go to Time Stamp

To locate a timestamp, click the Go To button and choose Timestamp.

Figure 3.110: Time Stamp

Enter a time stamp value in the Go To Timestamp dialog and click OK. 

Figure 3.111: Go to Time Stamp

Bookmarks

Bookmarks are a convenient way to mark a point in the data viewer display by name, so 
that you can rapidly return to that point. To create a bookmark, right‐click the mouse in 
the data viewer area on a packet in which to place the bookmark (see Figure 3.113 on 
page 203).
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Figure 3.112: Bookmark

Click Bookmark from the fly out menu to open the Bookmark Comment Dialog (see 
Figure 3.113 on page 203).

Figure 3.113: Bookmark Dialog

Enter a description for the bookmark and click the Add button. Repeat for additional 
bookmarks.

You can save the bookmark as a text file or Excel CSV file.

Note:Column View has a different bookmark mechanism than other views, and you can set a 
bookmark on each DWORD in the view. This makes Column View bookmarks unavailable in 
other views and vice versa.

Editing a Bookmark

If a packet has a bookmark, you can edit the bookmark by right‐clicking the data viewer 
area of the packet, selecting the Edit Bookmark command from the 
pop‐up menu, and changing the information in the Bookmark dialog (see above). 
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Finding a Bookmark

To find a bookmark in the data viewer display, right‐click the mouse in the sample viewer 
and select Bookmark (see Figure 3.114 on page 204).

Figure 3.114: Go To Bookmark Dialog Box

Highlight the bookmark to which to go, then click the Go To button, or 
double‐click the selection.

Figure 3.115: Bookmark Found Example in Data Viewer Display

Bookmark Description

To get a quick description of a displayed bookmark, position the tool tip over a bookmark. 
The name and description of the bookmark display.

Set Time Stamp Origin

Right‐click in the sample viewer to open the fly out menu (see Figure 3.116 on page 205):
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Figure 3.116: Set Time Stamp Origin: Trigger.

Highlight Set Time Stamp Origin and choose either Absolute, Trigger, Current Position, or 
Based on system time.

Example: Trigger Mode

An example Trace showing the Time Stamp set to Trigger Mode in both the Packet View 
and the Column View is shown below in Figure 3.117.

Figure 3.117: Time Stamp Set to Trigger

In the Packet View (upper pane) the Red T for Trigger shows that the trigger occurs within 
Packet 79 and setting the Time Stamp to Trigger shows 0 ns.
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In the Column View (lower pane) the Red T for Trigger shows that the trigger occurs 
566ns within Packet 79. The reason the two trigger times are different is because the 
Column View is more accurate. The Packet View tells you that the trigger occurs within 
Packet 79, but the Column View tells you that the trigger occurs 566ns after the start of 
the packet.

3.6.2 Filtering

The Filtering menu and options allow you to modify data in the sample viewer display to 
exclude packets with a set of user‐defined patterns and show the results in all views.

To set up filtering, you must have a viewer display open.

The Filtering menu has the options:

 Enable Filtering (see “Enable Filter” on page 217)
 Filtering (see “Filter Setup” on page 207)
 Link Layer (SAS)
 Transport Layer (SAS)
 Application Layer (SAS)
 Physical Layer (SATA)
 FIS Layer (SATA)
 Command Layer (SATA)
 Filter Idles (see “Filter Idle” on page 217)
206 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual



Navigation + View Toolbar  Teledyne LeCroy
3.6.3 Filter Setup

To display the Filter setup dialog, click the   Filter button on the Viewer toolbar or 
select View > Filtering (see Figure 3.118 on page 207).

Figure 3.118: SAS/SATA: Filter Setup Dialog

You can select or deselect each of the items shown in the Filter Options window for 
filtering, by checking or unchecking a corresponding check box. Items not in the current 
sample are in shade. See “Selectable Filter Options for SAS” on page 211 and “Selectable 
Filter Options for SATA” on page 216.

Note: If you select a group, that also selects all child items. 

Note:Only packets captured at run time are available for selection for filtering.
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Filter Type

You can choose to show or hide the Filter Type items by checking the Show or Hide 
option button.

Note:When capturing PM traces, you need the ability to filter the PM primitives so you can find 
commands quicker. 

Filtering Direction

You can select items for filtering in a single direction or both directions by checking the 
corresponding Port. By default, all ports are enabled. Uncheck the port check boxes for 
ports not to include in the filter.

Filter Idle

Depending on the Filter Type (Hide/Show), Idle packets in the Sample Viewer are shown 
or hidden.

Save Filter Setup

After you have set up a Filter configuration, you can save it as an SAS Filter file (*sfl) or 
SATA Filter file (*.tfl) by clicking Save. You can then use it on a different capture by 
clicking Load in the Filter dialog.

Filter Logic

After you have set up Filter options, you can set filter logic to And Related Items to apply 
"AND" logic on related selected options (for example, SCSI commands and SAS 
Addresses) or OR to apply "OR" logic on all selected options.

Filter only applies to entities in a trace. When you choose SCSI command AND SSP frame, 
for instance, Filter affects all entities in the trace that are SCSI commands, AND are SSP 
frames. Any SCSI commands that are NOT SSP frames, will not, in this case, be filtered. 

If you choose OR, Filter affects all entities that are SCSI commands, as well as all SSP 
frames.

The AND operator is only applicable for some cases, such as:

 A SCSI command AND a Tag.
 A SCSI command AND a source/destination address.

For example, when you choose a SCSI command AND a tag = 0x1, you will filter all entities 
on a trace that are SCSI commands that have tags equal to "0x1" in that SCSI command.

As a general rule, it is not possible to apply AND to two packet types (frames, commands, 
primitives, training sequences or bus conditions). It only works when you apply AND to 
one packet type with other items such as source/Destination Addresses, TAG, Task 
attribute.

Multilevel Filtering in SAS

You can set up a filter in a sequential steps by Multi level filtering. In each level, you can 
select specific items to “AND” to the previous level. The results of all levels show in views 
(see the following three figures). 
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Figure 3.119: First Level of Multilevel Filtering
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Figure 3.120: Second Level of Multilevel Filtering
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Figure 3.121: Third Level of Multilevel Filtering

Filter descending packets from trace highlight bar

If you check the Filter descend packets if ascend packet is filtered checkbox, the 
application will only filter onward from the highlighted trace selection bar.

If you uncheck this option, the software only filters the filtered packet. For example, if this 
option is checked and any SCSI command is selected, all transport and link packets of this 
command are filtered. If you unchecked this option, only selected SCSI commands are 
filtered.

3.6.4 Selectable Filter Options for SAS

The SAS Filter Options are:

 Command Data Pattern
 Bus Condition
 Primitive
 Incomplete Frames
 Address Frames
 SSP Frames
 SMP Frames
 STP Frames
 SCSI Commands
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 Task Management Functions
 ATA Commands
 SCSI Command Status (see “Filter Check Condition” on page 213)
 Source SAS Address
 Destination SAS Address
 Pair SAS Address
 Protocol Error
 STP Port
 Tag (see “Filter by Tag Number” on page 214)
 ATAPI SCSI Command
 Miscellaneous (see “Filter Miscellaneous” on page 215)
 Training Sequence

Command Data Pattern

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured Command Data Patterns in the Sample Viewer.

Bus Condition

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured Bus Conditions in the Sample Viewer.

Incomplete Frames

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
Incomplete Frames in the Sample Viewer. 

ATA Command

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured ATA commands in the Sample Viewer.

Protocol Error

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured packets with the specified Protocol Errors in the Sample Viewer.

ATAPI SCSI Command

When selected, depending on the Filter Type, the Show/Hide selection shows or hides 
ATAPI SCSI commands.
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Filter Check Condition

Checking the SCSI Command Status check box enables Check Condition for filtering.

Figure 3.122: Filter Check Condition
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Filter by Tag Number

Checking the Tag check box displays tags available for filtering. Check the corresponding 
check boxes for tags to filter.

Figure 3.123: Filter by Tag Number
214 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual



Navigation + View Toolbar  Teledyne LeCroy
Filter Miscellaneous

When you choose Miscellaneous, an additional dialog displays, allowing you to specify 
the filtering of State Range and/or External Signal In.

Figure 3.124: Filter State and/or Device Sleep
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Use Pair SAS Addresses

You can use all available pair SAS addresses (Source ‐> Destination) instead of using SAS 
source and destination addresses. To enable the pair SAS address filter option, check Use 
Pair SAS Addresses check box in the Filter dialog.

Figure 3.125: SAS: SAS Address Filtering before and after Using Pair SAS Addresses

Note: If you enable pair SAS addresses, the source/destination SAS addresses options are disabled and 
filtering on them is ignored at filtering time. If you disable pair SAS addresses, the pair SAS 
address option is disabled and filtering on it is ignored at filtering time.

Training Sequence

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured Training Sequences in the Trace Viewer.

3.6.5 Selectable Filter Options for SATA

The SATA filter options are:

 Bus Condition
 Incomplete Frames
 FIS
 ATA Command
 Protocol Error
 Port
 ATAPI SCSI Command
 Miscellaneous
 Filter Idle (see Figure 3.124 on page 215)
216 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual



Navigation + View Toolbar  Teledyne LeCroy
Bus Condition

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured Bus Conditions in the Trace Viewer.

Incomplete Frames

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
Incomplete Frames in the Trace Viewer. 

FIS

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured FIS items in the Trace Viewer. 

ATA Command

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured ATA commands in the Trace Viewer.

Protocol Error

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured packets with the specified Protocol Errors in the Trace Viewer.

Port

When selected, depending on the Filter Type, the Show/Hide selection shows or hides 
packet traffic for the selected port.

ATAPI SCSI Command

When selected, depending on the Filter Type, the Show/Hide selection shows or hides 
ATAPI SCSI commands.

Miscellaneous

When you choose Miscellaneous, an additional dialog displays, allowing you to specify 
the filtering of State Range and/or External Signal In (see “Filter Miscellaneous” on 
page 215).

3.6.6 Enable Filter

Select Filtering > Enable Filtering or click the   Filter Enable button on the display 
menu bar to toggle between Filtered and Unfiltered display.

3.6.7 Filter Idle

Depending on the Filter Type (Hide/Show), Idle packets in the Sample Viewer are shown 
or hidden.
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You can quickly filter idles by clicking the   Filter Idle button. This button toggles 
between Show and Hide items.

3.6.8 Search

The Search menu and toolbar options permit you to examine any data capture file to 
quickly locate the packet or data pattern. 

To perform an initial search, select Edit > Search or click the   Search button to 
open the Search setup dialog (see Figure 3.126)

Note:Only items captured in the sample file are enabled for search.

Figure 3.126: SAS: Search Data Pattern
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Figure 3.127: Search Parameter Definition Dialog

You can continue to search the output file using Next Search (F3) or Previous Search (F4) 
for the same pattern, until you redefine the data capture search parameters.

Save Search Setup

After you have set up a Search configuration, you can save it as a SAS Search configuration 
file (*.ssh) or a SATA Search configuration file (*.tsh) by clicking Save. You can then use it 
on a different capture by clicking Load in the Search dialog.

Search By

Choose Hashed SAS Address to search on hash address, or choose SAS Address to search 
for address. 

Search Direction

Choose either Forward or Backward direction in which to perform the search.

Search From

Choose a starting point to begin or continue a search: Start of the sample file, 
Trigger Pointer, X Pointer, Y Pointer, or Last Found.
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Search Logic

The default setting is Or Selected Items. With this setting, clicking Find Next locates all 
selected items in turn. If you choose And Selected Items, you can set a logical AND 
combination of items to find. Both options allow setting Advanced search features.

Search looks for entities in a trace. When you choose SCSI command AND SSP frame, for 
instance, search will return all entities in the trace that are SCSI commands, AND are SSP 
frames. Any SCSI commands that are NOT SSP frames, will not, in this case, be returned.

If you choose OR, search will return all entities that are SCSI commands as well as all SSP 
frames.

The AND operator is only applicable for some cases, such as:

 A SCSI command AND a Tag
 A SCSI command AND a source/destination address.

For example, when you choose a SCSI command AND a tag = 0x1, you will get all entities 
on a trace that are SCSI commands that have tags equal to "0x1" in that SCSI command.

As a general rule, it is not possible to apply AND on two packet types (frames, commands, 
primitives, training sequences or bus conditions). It only works when you apply AND on 
one packet type with other items such as source/Destination Addresses, TAG, Task 
attribute.

Search For

Choose a category to search in the Search For window. Each of the search categories 
offers additional choices in the Search Items window to refine the search. Check items 
for the selected category.

Data Pattern

Search for Data Pattern allows you to search for a specific Data Type, Pattern, and Length 
(see Figure 3.126 on page 218).

 Data Pattern Only
 Data Payload Length Only
 Data Pattern and Data Payload Length

Advanced options

Some of the Search For categories offer advanced options for search. To set these 
options, highlight the search item in a category and click the Advanced button to open 
the Advanced options dialog.
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Figure 3.128: Advanced Options Dialog Example: Set Device Bits

Set the options and click OK.

Search Domain

Click the Domain button and choose a search domain from all ports or a specific port.

Protocol Error

You can refine the search to locate packets with an error or without an error.

Note:When searching for Protocol Errors in Column View, you cannot search for a specific Protocol 
Error type. Search returns any protocol error.

Search Sub Items

When searching SCSI Command Status, you can refine the search by selecting from a list 
of Sub Items.

Note:Some of the search categories allow you to refine the search by specifying specific SAS addresses 
and STP ports to search.
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Figure 3.129: Search Sub Items

When you check the SCSI Command Status, the Check Condition item appears in the 
Search Items Window, if a check condition has occurred. Clicking this enables Search Sub 
Items, allowing you to refine the search by specifying Sense Key, ASC, and ASCQ.
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Search by Tag Number

To search by Tag Number, check the Tags box in the Search For window and then check 
the Tag(s) for which to search in the Search Items window.

Figure 3.130: Search by Tag Number
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Search by Speed

To search by Speed, check the Speed box in the Search For window to look for points 
where speed changes occurred in the trace.

Figure 3.131: Search by Speed Changes
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3.6.9 Show/Hide Ports

You can Show/Hide a Single Port or you can Show/Hide Multiple Ports. To do so click on 
the Ch Down Arrow.

Single Port

If Single Port is selected, you can click on one port button at a time to show/hide the 
capture for that port. Show/Hide Single Port is time consuming as it shows or hides one 
port at a time.

Multiple Ports

If Multiple Ports is selected, you can click on multiple ports to show or hide them. This 
mode is much faster. Click on multiple ports to show or hide them.

Figure 3.132: SAS: Show/Hide Ports Toolbar

.

Figure 3.133: SATA: Show/Hide Ports Toolbar

You can also show or hide a port by right‐clicking a Port ID in Text View or Column View 
and choosing Show or Hide (see Figure 3.137 on page 229).

3.7 Packet View Toolbar

The Packet View toolbar allows wrapping, zooming, and configuration.

The Wrap Packets button on the Viewer Toolbar wraps the packet data in the 
display to eliminate the need for horizontal scrolling.

Go to CATC Navigation View. Click this button to change the trace display to a 
CATC Trace™. 
You can change the colors, fonts, and so on, in the Trace Viewer Configuration 
(see “Set Port Alias” on page 242).
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The Show/Hide Link Packet button displays/hides the Link layer. SAS only. 

The Show/Hide Transport Packet button on the Layers Toolbar displays/hides 
the Transport layer and below. SAS only.

The Show/Hide All Commands Packet button shows/hides the 
Command layer and all layers below: SCSI Cmd and Task Mng, SMP 
Cmd, and ATA Cmd. SAS only.

Click the down arrow on the Show/Hide All Commands Packet 
button to choose command types to show/hide.

The Show/Hide Physical Packet button toggles the display of physical layer 
packets. SATA only. 

The Show/Hide FIS packet button toggles the display of FIS layer packets. 
When “OFF”, the FIS layer and its links are hidden. SATA only. 

The Show/Hide CMD packet button toggles the display of the CMD packets. 
When “ON”, only the command layer displays. SATA only. 

The Show/Hide Command Queue (CQ) button displays queued commands. 
SATA only. 

The CQ button’s hierarchy only applies to ReadDMAQueued and 
WriteDMAQueued. The hierarchy for other queued commands is displayed 
as part of the regular application layer decoding.

The Order/Reorder toggles the time order of packets. SATA only. 

The Pack/Unpack Repeated Primitives toggles packing repeated primitives in 
one port. SAS only. 

The 10B button displays the payload data as 10‐bit encoded data.

The 8B button displays the payload as 8‐bit scrambled or unscrambled data, 
depending on the Scrambled setting.
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3.7.1 CATC Navigation View

To change the trace display to a CATC Trace™, click the CATC Navigation   button (see 
Figure 3.134 on page 227). You can change the colors, fonts, and so on, in the Trace 
Viewer Configuration (see “Trace Viewer Configuration” on page 238).

Figure 3.134: CATC Navigation View

The SC button selects scramble/unscramble for the 8‐bit payload data.

The PV button shows/hides the primitive value.
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3.7.2 Spec View

Spec View shows packet header information. 

To obtain the Spec View from the CATC View, left‐click to display a popup menu, then 
select the View Fields option.

To obtain the Spec View from the Catalyst View, right‐click to display a popup menu, then 
select the View Fields option.

Figure 3.135: Spec View

The tabs allows you to display Hexadecimal or Binary. 

The buttons allow you to go to Previous or Next.

You can Save As a text file.

3.7.3 Decode Icons

The Decode Toolbar controls encoding and scrambling features.

To view corresponding Unscrambled and Scrambled payload data values instantaneously, 
position the mouse pointer over a data field (see Figure 3.136 on page 229).
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Figure 3.136: Payload Data Display

3.7.4 Customize Display

Rename Port

You can rename each port for easy identification. To rename a port, right‐click the port ID 
in Text View or Column View.

Figure 3.137: Rename Port

Choose Rename title of port to open the Rename Title of Port dialog.

Figure 3.138: Rename Title of Port

Select and Apply Show/Hide Port Mode

You can simplify the viewer display by hiding the captures of ports. All active ports are 
highlighted on the Show/Hide Ports toolbar. 

You can Show/Hide a Single Port or you can Show/Hide Multiple Ports. Click on the 
drop‐down arrow and select from the two options as shown in the following figure:

Running Disparity indication
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 Show/Hide Single Port
 Show/Hide Multiple Ports

Click on the Apply show/hide port button to apply the specific mode.

.

Figure 3.139: Show/Hide Single or Multiple Ports

Show/Hide Field

You can simplify the Viewer display by hiding some fields. You can hide the Duration, 
Relative Time, External Signals, and Packet number fields by right‐clicking the 
corresponding field title and choosing Hide Field.

Figure 3.140: Hide Field

To restore a field to the display, right‐click a Port ID field and choose the hidden field to 
restore.

Figure 3.141: Show Field

Note:Only the fields previously hidden appear in the restore list.

Apply show/hide port button
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Related Frames

Right‐click a Command frame for an SSP frame, or Register Device to Host for an STP 
frame, to open a short‐cut menu, then choose Goto Response to jump to the 
corresponding Response frame in the viewer.

Figure 3.142: Goto Response

Similarly, right‐click a Response frame for an SSP Frame, or Register Device to Host for an 
STP frame, to open a short‐cut menu, then choose Goto Command to jump to the 
corresponding Command frame in the viewer.

Figure 3.143: Goto Command

In Column View, you can right‐click a DWORD inside a frame to display the 
Goto Within Packet command. You can jump to an SOF, EOF, HOLD, or R_IP.

Figure 3.144: Goto Within Packet Command
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Byte Order

You can change the byte order in fields marked by an arrow and other fields. 

Right‐click in the field, select Byte Order, and choose the ordering.

Figure 3.145: Byte Order

Note:A blue arrow in the byte order field indicates that it has been changed.

Choose Data Format

You can display data values either in hexadecimal (default) or binary. To choose data 
format, right‐click the mouse over a data field, and choose Format and the format.

Figure 3.146: Format
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Show All Data

To display all captured data, click the data expand toggle arrow in a data field, to examine 
the data in detail.

Figure 3.147: Show All Data

You can expand or collapse all data fields globally. To expand all data fields, 
right‐click the mouse in a data field and choose Expand All (see Figure 3.148).

Figure 3.148: Expand All

To collapse all fields, right‐click the mouse in a data field and choose Collapse All.

You can expand or collapse all FIS’s and commands. To expand, right‐click the mouse in a 
data field and choose Expand All FIS’s or Expand All ATA Cmd.s. See Figure 3.149 on 
page 234.

Data expand toggle
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Figure 3.149: Expand All FIS’s

To collapse, right‐click the mouse in a data field and choose Collapse All FIS’s or Collapse 
All ATA Cmd.s.

You can expand or collapse specific packets and commands by clicking on the   or   
buttons. 

Figure 3.150: Expand/Collapse Specific Layers.

3.8 Port Status

You can get an overview of the active ports by clicking the Port Status button at the 
bottom right of the application window.

The Port Status displays the Port, Speed, and Analyzer (see Figure 3.151 on page 235).
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In addition to displaying OOB, Link, Frame, and Error, a display showing the % buffer full 
opens when a trigger occurs.

Figure 3.151: Port Status Window and Capturing Time

1. Pre‐trig capturing (trig is 50%)

2. Trig point (shown by red bar; 36% pre trig was captured)

3. Post‐trig capturing (50% post‐trig was captured and capturing has stopped)

Note: If sample capture occurs with more than one unit active, additional Port Status windows display.

The OOB, Link, Frame and Error LEDs in the Port Status dialog mimic/follow the LEDs on 
the Front panel of the unit. 

When the LEDs are dim, it indicates they were lit in the past. Pressing the Reset button 
erases this history and the illuminated LEDs are removed from the dialog.

LEDs illuminated
Reset button
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3.9 Toolbars

3.9.1 Enabling Tool Bars

To customize the Viewer Display workspace, you can enable and reposition the available 
toolbars. To display or hide toolbars, select View > Toolbar, then check or uncheck 
toolbars (see following screen capture).

Toolbars are:

 Main
 Record + Capture
 Analysis
 Navigation + View
 Packet View
 Column View
 Cursor Position
 Device/Target Emulator

Once enabled, the toolbars can dock at the Viewer Display window or float on the 
windows desktop.

3.9.2 Cursor Position Status Bar

To display the cursor position status bar, select Toolbar > Cursor Position.

Figure 3.152: Cursor Position Toolbar
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See “Using the Cursors and Bookmarks” on page 237.

3.10 Status Bar

The Status bar is located at the bottom of the main display window.

3.10.1 Search Status

The right most segment displays the current search direction: Fwd (forward) or 
Bwd (backward). Change the search direction from the Search Menu or double‐click the 
Search Status segment. 

3.11 Using the Cursors and Bookmarks

3.11.1 Cursors

The data viewer display incorporates three cursors labeled X, Y, and T. All cursors are 
initially overlaid and positioned at location 0, which is the trigger position of the display. 
The Trigger, or T, cursor is the measurement reference and is always at location 0 in the 
display.

Positioning the X Cursor
To position the X‐Cursor within the viewer data display, click the left mouse button in the 
gray bar on the left side of the sample viewer next to the line in which to place the cursor. 

Positioning the Y Cursor

To position the Y‐cursor within the viewer data display, click the right mouse button in the 
gray bar on the left side of the sample viewer next to the line in which to place the cursor. 

Note:You can also left‐click to set the X‐cursor and right‐click to set the Y cursor in the Frame and 
Column View by clicking in the narrow strip on the very left side of a cell. Similarly, you can set 
the cursors in the Waveform View by left and right clicking at the beginning of a waveform.

Time

Time differences between the cursors are displayed in the Cursor Position toolbar. To 
display the cursor position toolbar, select Toolbar from the view menu and choose Cursor 
Position.

Figure 3.153: Cursor Position Toolbar
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3.12 Display Configuration

The Analyzer ships with a default display configuration of field and viewer settings. You 
can define your own field and viewer settings for a particular testing scenario. Right‐click 
in the Packet View and select Preferences or select Setup>Preferences>Trace 
Viewer>Configuration. Select the Trace Viewer tab and click Configuration to display the 
Trace Viewer Configuration dialog (see Figure 3.154 on page 239)

3.12.1 Trace Viewer Configuration

The Trace Viewer Configuration dialog allows you to change the following display settings 
(see Figure 3.154 on page 239):

 Field Setting
 Format (Decimal, Hexadecimal, Binary)
 Visible
 Byte Order (Right Align, Left Align)

 Field Header Setting
 Text (color)
 Name
 Abbreviation
 Foreground (color)

 Viewer Setting
 Wrap Packet
 Enable Tooltips

 Data Payload
 Columns in Row (1, 2, 4, 8, 16)
 Bytes in Column (1, 2, 4, 8, 16)

 Time Stamp Origin: Absolute, Trigger, User Defined, Based on System Time
 Same color for start time and port
 Enable Packet View Condense Mode
 Time Stamp Format (LeCroy, Milli, Micro)
 Save Trace Viewer Configuration in a file
 Load Trace Viewer Configuration from a file
 Factory Setting (restores default settings)
 Font (opens Font dialog)
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Figure 3.154: Trace Viewer Configuration
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Field Setting

To view a packet field, select a field from the packet field tree and check the Visible box. 
Uncheck it to hide the field. To change the data format of a packet field, select the field 
and choose a data format from the Format drop‐down list.

Figure 3.155: ATA Command Fields
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Field Header Setting

You can use the Name or Abbreviation.

To change the color of the text in a packet field header, select a field from the packet field 
tree and click the Foreground button.

Figure 3.156: Color

Choose an appropriate color and click OK.

Viewer Setting

Check the Wrap Packet box to enable the wrapping of packets in the display.

Check the Enable Tooltip box to enable tool tips for packet fields.

Data Payload

You can format the Data Payload display.

For Columns in Row, select 1, 2, 4, 8, or 16.

For Bytes in Column, select 1, 2, 4, 8, or 16.

Time Stamp Origin

Select Absolute, User Defined, Trigger, or Based on System Time.

Start Time and Port

You can use the same color for the start time and port.

Packet View Condense Mode

You can enable Packet View Condense Mode to minimize Packet View rows.
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Time Stamp Format

Select Teledyne LeCroy, Milliseconds, or Microseconds.

Font

To change display fonts, click the Font button to open the Font dialog box.

Figure 3.157: Font

Choose the font, font style, and size, and click OK.

Save/Load Settings

You can save the customized configuration settings in a *.cfg file by clicking the Save 
button and completing the Save As procedure. To load a previously saved configuration 
file, click Load and choose an appropriate file.

3.13 Set Port Alias

Port Alias allows you to assign a meaningful name to each port to assist in interpreting 
the results displayed in the sample view (see Figure 3.158 on page 243).

To assign port names in an open sample view, select Setup  > Set Port Alias.
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Figure 3.158: SAS: Assign Port Alias

Assign a meaningful name to each port in use and click OK. The assigned names replace 
the port numbers in the sample view.

If you elect to save the capture sample file, the assigned port names are saved together 
with the result, so that when you open the sample file later, the assigned names are 
retained.

Restore Factory Presets

Click the Restore Factory Presets button to restore the settings to the factory settings.

Set As Default

If you want to set these port aliases for sample files that will be captured later, you can set 
them as default, and new samples will be opened by these default port aliases.

3.14 SAS Address Alias (SAS only)

SAS Address Alias allows you to assign a meaningful name to each SAS address to assist in 
interpreting the results displayed in the sample view (see Figure 3.159 on page 244). To 
assign SAS address names in an open sample view, select Setup > Set SAS Address Alias.
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Figure 3.159: SAS: Assign SAS Address Alias

Assign a meaningful name to each SAS address in use and click OK. The assigned names 
replace the SAS address in the sample view, Search, filter,. and Statistical report.

Figure 3.160: SAS: SAS Address Alias

If you elect to save the captured sample file, the assigned SAS address names are saved 
together with the result, so that when you open the sample file later, the assigned names 
are retained.

Set As Default

If you want to set these SAS address aliases for sample files that will be captured later, 
you can set them as default, and new samples will be opened by these default SAS 
address aliases. 

3.15 TxRx Vout & Preemphasis

The analyzer incorporates the ability to select TX Vout for the transmitter on each port. 
Selecting TX Vout increases the output voltage swing above the nominal value, for test 
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and characterization purposes. This feature is also useful to compensate for line loss 
when driving long cables. 

To select TX Vout, select Setup > Tx Vout & Preemphasis to display the 
Rx/Tx Settings dialog.

Figure 3.161: Choose Port for TX Vout

Port displays ports to select from. 

Copy Selected Port Settings to All Ports implements one port's setting into all other port 
settings.

Input signal equalization allows you to select values for Short time constant, Medium 
time constant, Long time constant, Output power level and Loss of signal from the drop‐
down menu.

Output pre‐emphasis: 

Output Pre Long allows you to select values for Pre‐emphasis level, Pre‐emphasis decay, 
from the drop‐down menu.

Output Pre Short allows you to select values for Pre‐emphasis level, Pre‐emphasis decay, 
from the drop‐down menu.

Port Status displays number of errors per second.

Apply applies the selected settings.

Start Reading Port Status implements reading of number of errors displayed in Port 
Status. 

Restore Factory Settings restores default values.

Save saves the new values as a *.sng file.

Load loads back the saved *.sng file.
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3.16 Preferences

Preferences allow you to define template files for new Analyzer projects, to specify how 
sample files appear when opened, and to set ATAPI and SCSI Spec Assignments.

To perform settings in an open sample view, select Setup > Preferences

3.16.1 General Tab

Figure 3.162: Preferences Dialog General Tab

The SATA Preferences dialog has the same options, except that it does not have 
“SCSI spec assignment”.

Paths
User Path specifies the “User” folder path, used by the software after launching the Open dialog. 

Template Files

Protocol Analyzer: You can use a pre‐saved analyzer project file as a template. Whenever 
you make a new project file, the software uses the template to initialize the project file. 

New Protocol Analyzer Project in Advanced Mode: When you use the New menu item to 
create a new project file, the software switches to Advanced mode automatically.
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Other

Default Workspace specifies the default workspace file for opening a sample file. You can 
save any viewer configuration as a workspace and then specify it as the default 
workspace. The software always open a trace file based on the default workspace file.

NCQ Commands Time out Threshold: The software uses this setting in the statistical ATA 
command page for NCQ commands. If the time out exceeds this setting, the software 
reports an error.

Maximum Number of Uploader Threads: If Quick View is not enabled, during cascading, 
specifies the number of concurrent processes for uploading a sample file.

ATAPI spec assignment: Specifies the ATAPI default spec.

SCSI spec assignment (SAS only): Specifies the SCSI default spec.

Convert port configuration without prompt for confirm: If the current attached board 
does not support the project file port configuration, the software converts it to a 
supported port configuration without asking for confirmation. If this setting is unchecked, 
the software asks for confirmation 

Ask user to close the previous captured sample before running the new project: When 
you start to run a new project, the software prompts you to close the current sample.

Found Device List Mode

Reset (clear) the list of found devices: Lists only the currently found devices.

Refresh (append to) the list of found devices: Adds new devices to the list of devices 
found previously.

Browse Default Path

Software default: After you select File > Open, the Open dialog shows the default user 
folder.

Windows default: After you select File > Open, the Open dialog shows the path selected 
when the Open dialog was last used.

Port Configuration Setting

These options pertain to Port Configurations that have unused ports (as marked by a dash 
in the Port Configuration table, e.g. AA‐‐). This allows the user to control these ports, if 
unused by the analyzer platform, are to be disconnected or are to be used as pass 
through, meaning the traffic will simply pass through them (default setting). It is 
sometimes useful to force disconnect on unused ports, to cause all traffic to pass through 
the used ports. Select the desired option:

Disconnect don’t care ports

Pass through don’t care ports
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3.16.2 Trace Viewer Tab

Figure 3.163: Preferences Dialog Trace Viewer Tab

The SATA Preferences dialog has the same options.

Open Trace file In

Default Workspace: The software opens a sample file in view(s) based on the specified 
default workspace.

As previously saved: The software opens a sample file in view (views) based on the last 
saved configuration for the sample file. 

Optimization

Sampling memory usage optimization: Enables memory cascading for two ports. The 
analyzer will use memory of another port if there is not data on another port. See 
“Sampling Memory Usage Optimization” on page 253.

Quick View: Quick View allows full access to the whole trace more quickly, especially 
when using a Gigabit Ethernet connection. However, the trace is NOT written to the host 
machine’s hard drive. To save the trace, you must manually click Save.
If you do not check Quick View, the trace loads more slowly but is automatically saved to 
the host machine’s hard drive.
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3.16.3 Other

Switch to CATC Navigation: Packet view will open in CATC mode. 

Reverse Link Data: The software shows DWORDs of link data as reversed.

Pack Repeated Primitives: The software packs repeated primitives just after opening a 
sample file. 

Scroll Horizontally to Show matched Column in Search: When unchecked makes columns 
stationary even during search

Use new PHY capabilities decoding: Checking this box sends the first bit as bit # 7. 
Leaving the box unchecked sends the first bit as bit # 0.

Cancel button kills upload immediately: The software kills the uploading process if you 
press Cancel. 

Close previous sample file when new sample file opens: When you want to open a new 
sample file, the software closes any open sample files.

Create statistical report read/write page: The software creates a Read/Write page in the 
statistical report. Enabling this setting displays the Read/Write Stream DMA command in 
the Read/Write page.

Show Quick View Warning: The Quick View Warning pops up when attempting to close a 
trace that has not yet been saved, and is only shown in Quick View "mode". This checkbox 
allows to turn off this popup.

LBA mode: Checking this box enables LBA mode for ATA decoding.

CHS mode: Checking this box enables CHS mode for ATA decoding.

According to LBA mode in ATA command: Checking this box enables decoding according 
to LBA mode in ATA command for ATA decoding.

Configuration: Clicking Configuration displays the Trace Viewer Configuration dialog (see 
Figure 3.164 on page 250).
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Figure 3.164: Preferences trace Viewer Configuration Dialog 

Select a view in the left pane and set the trace viewer display options in the right pane.
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3.16.4 Spread Sheet View Tab

Figure 3.165: Preferences Dialog Spread Sheet View Tab

The SAS Preferences dialog has the same options, except that it does not have 
“Show ‘Sector Count’ instead of ‘Xfer Length”.

Color Setting

Based on Cell Type: Each column has its own color. 

Based on Port No.: Data of each row are shown based on the specified color for its port. 
You can set the color of ports in the Viewer settings. 

Based on Read/Write Command Type: You can specify a color for Read commands, 
another color for Write commands, and other color for other commands. The software 
shows each row based on the command type: Read, Write, or others.

Based on Specific Command Type: You can specify a color for each command. The 
software applies the setting on the Command column.

Anchor the Selection bar

You can anchor the selection bar of the Spreadsheet View.

Set the Anchor row as sync. point: Other views synchronize based on the contents of the 
anchor row.
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Other

Repeat decoded command in frame column: The spreadsheet shows the name of the 
command in front of all frames in the Command column. Otherwise, it will show the 
name of the command only in front of the SSP command frame.

Decode CDB of Commands: The spreadsheet shows name of command in command 
column, otherwise shows CDB of command in command column.

Show ‘Sector Count’ instead of ‘Xfer Length’ (SATA only): Display sector count.

3.16.5 Column View Tab

Figure 3.166: SAS: Preferences Dialog Column View Tab

Other

Show Warning in Search Primitive In Column View: If searching in Column View takes a 
long time, the software asks if you want to continue search. Otherwise, the software 
continues searching with no pause.
252 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual



Preferences  Teledyne LeCroy
3.16.6Packet View Tab

Figure 3.167: Preferences Dialog Packet View Tab

Based on Command Layer: You can specify a color for the Command Layer. The software 
shows each row based on the command layer.

Based on Specific Command Type: You can specify a color for each command. The 
software applies the setting on the Command column.

3.16.7 Sampling Memory Usage Optimization

The Preferences dialog has a Sampling Memory Usage Optimization option. This Memory 
Assignment (MA) feature optimizes sampling memory utilization.

If the Sampling Memory Usage Optimization Option is Checked

The system tries to use empty space in all memory banks to prevent any memory bank 
from filling completely. Each physical link is not necessarily assigned to a specific memory 
bank. The system can capture more sample data than if the MA option is unchecked, and 
sample file size is closer to the user‐defined Sampling Memory Size.

Memory Assignment efficiency varies with Port Configuration and Trigger Position:

 FPGA: The Memory Assignment feature works for a pair of ports connected to 
one FPGA, for example ports 1 and 2 (or ports 3 and 4). Memory Assignment 
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does not work for two ports connected to different FPGAs, for example ports 1 
and 3.

 Triggering: Memory Assignment only starts after the trigger point. During 
pre‐trigger, each physical link is always assigned to a specific memory bank.
Post‐trigger, the system can try to use empty space in all memory banks, if you 
check the MA option. Therefore, Memory Assignment efficiency is maximum 
when Trigger Position is set to 0% (snap‐shot trigger) and is minimum when Trig‐
ger Position is set to 99% or when there is no triggering (you stop recording 
manually).

 MUX: When MUX is enabled, each segment has four memory banks, limiting 
Memory Assignment somewhat.

Here are examples of different Port Configurations and Trigger Positions:

 One port configuration (A ‐ ‐ ‐): Sample size is user‐specified sample size.
 Two port configuration (AA ‐ ‐): Ports 1 and 2 are on the same FPGA, so 

Memory Assignment has an effect. If you use snapshot triggering, the sample 
size is near specified size.

 Two port configuration (AA ‐ ‐): If you use manual stop, Memory Assignment 
has no effect. Sample size depends on port traffic loads.

 Two port configuration (AA ‐ ‐): If trigger is set at 50%, and there is enough data 
to fill pre‐trigger, Memory Assignment has an effect. Sample size is typically near 
specified size.

 Two port configuration (AA ‐ ‐): If trigger is set at 50%, but there is not enough 
data to fill pre‐trigger, Memory Assignment has an effect. Sample size is typically 
more than half specified size, with size determined by the amount of data cap‐
tured before trigger.

 Two port configuration (A ‐ A ‐): Ports 1 and 3 are not on the same FPGA, so 
Memory Assignment has no effect. If one port has heavy traffic, it may fill its 
memory bank and stop recording, resulting in smaller sample size than speci‐
fied.

Note:Checking this option does not affect the sample. It only allows larger sample sizes.

Note: If traffic is balanced on ports, sample size is the same whether you check or uncheck the 
Sampling Memory Usage Optimization option.

Note:Memory Assignment depends on traffic load distribution at the time when the system tries to 
re‐assign physical links to memory banks. Therefore, if you repeat a capture with the same 
Sampling Memory Size and Segment Number parameters, the resulting sample size may not be 
the same. However, if traffic load distribution is similar, sample size will be similar. 

Note:The buffer status indicator shows buffer by FPGA, not by port.
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If the Sampling Memory Usage Optimization Option is Not Checked

Each physical link (or logical link if MUX is enabled) is assigned to a specific memory space 
(memory bank), depending on the Sampling Memory Size and Segment Number 
parameters.

Important: If any physical link fills its memory bank, the recording process stops. Other 
memory banks will typically be less than full (and can be empty). The sample file might be 
smaller than the user‐defined Sampling Memory Size. You might even think that the 
Analyzer malfunctioned. 

3.17 Floating License

Note: License Manager is only available when in Cascading mode.

To manage the license, select Setup > License Manager.

The Floating License dialog displays the available functionality by Function, Total Ports, 
Assigned To ports, and Not Used. It also displays the Current License Configuration by 
License Type, Serial Number, Analyzer, and InFusion.

Figure 3.168: Floating License Dialog
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3.18 External Trig Setting

The External Trig Setting dialog displays the External Trig Out Setting and External Trig In 
Setting as High Active, Low Active, or Toggle.

Figure 3.169: External Trigger Setting Dialog

To display the External Trig Setting dialog, select Setup > External Trig Setting.

External Trig Out Setting

The Analyzer can send a Low or High external signal anytime a trigger occurs. Select the 
External Trig Out Setting: High Active, Low Active, or Toggle from High to Low or Low to 
High once (3.3 V output).

Enter the External TrigOut pulse width.

Note:The External TrigOut pulse width field supports increments of 16 ns, starting from 64 ns and up 
to 1024 ns.

External Trig In Setting

An external Low or High input signal can cause triggering. Select the 
External Trig In Setting: High Active, Low Active, or Toggle from High to Low or Low to 
High once (3.3 V output).

3.19 Update Device

The Update Sierra Device command allows you to update a Sierra M6‐1 Analyzer or CATC‐
Sync expansion card whose current version is incorrect.

1. Click Setup > Update Sierra Device to display the Device Setup dialog (see 
Figure 3.170 on page 257).
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Figure 3.170: Device Setup Dialog with BAD Device Status

Devices whose version is correct have an OK status. 
A device whose version is incorrect has a BAD status.

Note:You can click the ellipses (...) at the end of a file path and name to display an Open dialog, in 
which you can browse for files.

2. Click the checkbox to the left of a device with BAD status, then click Update Selected to 
begin the process that will make the Analyzer version correct.

Figure 3.171: Device Setup Dialog Beginning to Update Status of a Device

After the update, the device must restart.
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Figure 3.172: Info Dialog

Then the update is complete.

Figure 3.173: Device Setup Dialog with DONE Device Status
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3.20 User-Defined Decoding

User‐defined decoding allows you to create a definition file to interpret commands and 
frames that are not in the standard set recognized by the software.

Select Setup > User Defined Decoding to open the User Defined Decoding dialog. See 
Figure 3.174.

Figure 3.174: SAS/SATA: User Defined Decoding.

SAS adds SCSI Commands, SSP Frames, and SMP Frames.

Select one of the script types and click on the “...” tab. See Figure 3.175 on page 260.
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Figure 3.175: Select a Script Type

This will take you to the location of the stored script type. See Figure 3.176.

Figure 3.176: Path to Stored User Defined Scripts

Choose an appropriate script file and click Open.
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3.21 Help Menu

3.21.1 Tell Teledyne LeCroy

Report a problem to Teledyne LeCroy Support via e‐mail. This requires that an e‐mail 
client be installed and configured on the host machine.

3.21.2 Help Topics

Displays online help. You can also select F1.

3.21.3 VSE Help Topics

Displays VSE online help. You can also select F1. 

3.21.4 Update License

A current license agreement with Teledyne LeCroy entitles the Analyzer owner to 
continued technical support and access to software updates as they are published on the 
Teledyne LeCroy website. When you obtain a license key, from the Help menu select 
Update License to display the Select License Key File dialog box. Enter the path and 
filename for the license key, or browse to the directory that contains the license key and 
select the *.lic file. Click Open.

3.21.5 Display License Information

Open a license information dialog to display a list of named features supported by the 
current software version (see Figure 3.177 on page 262).Named features that are not 
enabled on your system are indicated by No in the Purchased column. Whether or not 
named features are enabled depends on the license key stored in your analyzer. If you try 
to use a feature for which you do not yet have a license, the program displays the License 
Protection Message. To use the feature, you must purchase a license.
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Figure 3.177: Licensing Dialog

3.21.6 Check for Updates

Check whether a new software version is available. If so, you can download from the 
Teledyne LeCroy web site. 
You can select to Check for updates at application startup (see Figure 3.178 on page 263).
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Figure 3.178: Check for Updates

3.21.7 About

Displays version information.

3.22 Setup Menu

3.22.1 Self Test

You can use the built‐in RAM self‐test utility. Select Setup on the main menu bar and 
choose Self Test to open the Self Test dialog.

Figure 3.179: SAS: Self Test Command on Tools Menu
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3.22.2 Clock Check

To perform a Clock check, choose the clock to test and click the Start Clock Check button. 
After a short time, the Test Result appears to the right of the selected line.

Figure 3.180: SATA: Self Test Dialog Clock Tab

Test Result: OK or Error

If a test is OK and you specified one run, the Test Result is OK: 1 times.

If a test has an error and you specified one run, the Test Result is Error: 1 times.

Saving

You can save any check result by checking the Save error details check box and specifying 
a destination file name.
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Number of Runs Each Test

You can specify to run a test more than once.

Run All Tests Sequentially

This option runs all items in the Clock, Memory, Serdes, Crosspoint, Main FPGA, 
Expansion, and LED/Buzzer tests in order. After you check this check box, the command 
button becomes Start All Tests. You must click the Stop Test button on the LED/Buzzer tab 
to stop the check.

3.22.3 Memory Check

To perform a SDRAM or Exerciser RAM memory check, select the Memory tab.

Figure 3.181: SAS: Self Test Dialog Memory Tab

Choose the SDRAM, Exerciser Data, or Exerciser Instruction to test and click the Start 
Memory Check button. After a short time, the Test Result appears to the right of the 
selected line.
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3.22.4 Serdes Check

To perform an FPGA 1 or 2 Serdes Chip check, select the Serdes tab.

Figure 3.182: SATA: Self Test Dialog Serdes Tab

Choose the n FPGA 1 or 2 Serdes Chip to test and click the Start Serdes Check button. 
After a short time, the Test Result and Marvel Failure Type appear to the right of the 
selected line. Marvel Failure Type indicates the error type.
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3.22.5 Crosspoint Check

To perform a Crosspoint‐Crosspoint bus test or Crosspoint external loop back, select the 
Crosspoint tab.

Figure 3.183: SATA: Self Test Dialog Crosspoint Tab

Choose the Crosspoint Interconnection Pair or External loop back to test and click the 
Start Crosspoint Check button. After a short time, the Test Result appears to the right of 
the selected line.
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3.22.6 Main FPGA Check (SATA only)

To perform an Inter‐FPGA Connection check, select the Main FPGA tab.

Figure 3.184: Self Test Dialog Main FPGA Tab

Choose the Inter‐FPGA Connection test and click the Start Main FPGA Check button. 
After a short time, the Test Result appears to the right of the selected line.
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3.22.7 Expansion Check

To perform a Expansion Card Data Status or Clock Status check, select the Expansion tab.

Figure 3.185: Self Test Dialog Expansion Tab

Choose the Expansion Card Data Status or Clock Status to test and click the 
Start Expansion Check button. After a short time, the Test Result appears to the right of 
the selected line.
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3.22.8 LED/Buzzer Check

To perform a LED or Buzzer check, select the LED/Buzzer tab.

Figure 3.186: Self Test Dialog LED/Buzzer Tab

Check LED Test or Buzzer Test and click the Start LED/Buzzer Check button. For the LED, 
you should see the LED pattern. For the buzzer, you should hear it sound. You must click 
the Stop Test button to stop the check.
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3.23 Find DUT

The Find DUT utility obtains all vendor‐specific information and detailed device 
parameters.

Find device finds any devices that are attached to any port.

Select Setup on the main menu bar and choose Find DUT.

Figure 3.187: SATA: Find Device Command on Tools Menu

The Find DUT dialog displays (see Figure 3.188 on page 272).
 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual 271



Teledyne LeCroy Find DUT
Figure 3.188: SATA: Find DUT Dialog

Click the Find Device button to search for connected devices. After a brief period, the 
dialog displays all device information.

Figure 3.189: SAS: Identified Devices

Click a device in the Device List to display information about that device.
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Aliasing

You can enter a 16‐character alias name for a device. In the Device List, right‐click the 
device name and enter an alias after the colon.

The alias name appears in the Device List. 

Exporting

You can export a device specification to a text file. Click the Export button to open the 
Export dialog. 

3.24 Discover List Descriptor Lists Decode

In a Trace that has Discover List Descriptor Lists, Click on the Discover List descriptor list.

Figure 3.190: Discover List Descriptor Lists

This will bring up the Discover List descriptor list. See Figure 3.191 on page 274.
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Figure 3.191: Descriptor Lists

Click on the “+” sign in the first field to bring up a menu with more information abut the 
Discover list descriptor. See Figure 3.192 on page 275.
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Figure 3.192: Details of a Single Discover List Descriptor

If you right click in the Value Field you can Copy text, Show First Field or Change the data 
format to binary, decimal or leave it in hexadecimal format. See Figure 3.193:  on page 
275.

Figure 3.193: Discover List Descriptor List Showing Different Options and Formats

If you de‐select Show First Field the Data will be shown as Function, Data Size and value 
of the data with an explanation. See Figure 3.194 on page 276.
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Figure 3.194: Data Shown as Function, Data Size and Value

3.25 Trusted Command Group Decodes in Spreadsheet View

Trusted Command Group (TCG) decodes are now available in the Spreadsheet View. See 
Figure 3.195 on page 277.
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Figure 3.195: Trace Showing Trusted Command Group data in Spreadsheet View

If you click on the TCG icon in the trace a window with detailed data about the TCG packet 
will pop up. The different Fields shown include: Com Packet, Packet, Data Sub Packet, 
Data Payload and Data. See Figure 3.196 on page 277.

Figure 3.196: TCG Parameter Data Field Name, Size and Values
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Clicking on the “+” symbol in any of the Field Name boxes will pop up a window with 
more detailed information about the particular Field. See Figure 3.197 on page 278.

Figure 3.197: Detailed Look at Data for Each Packet, Payload or Data

With the cursor inn each field, if you perform a right click a menu pops up showing that 
you can Copy Text, Show First Field (if selected) and change the format of the data shown 
(Hex, Binary or ASCII). See Figure 3.198 on page 279. 
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Figure 3.198: TCG showing Copy Text, Show First Field and Changing Format of Data

If you de‐select Show First Field the Data will be shown as Function, Data Size and value 
of the data with an explanation. See Figure 3.199 on page 279.

Figure 3.199: TCG showing Copy Text, No Show First Field and Changing Format of Data

3.26 Exporting LBA, XFER Length and Tag from Spreadsheet View

From an open Trace in Spreadsheet display mode, you can now Export and SaveAs LBA, 
Transfer Length and Tag data in different formats: Text 1.0/2.0 and Excel 1.0/2.0 as well as 
hexadecimal, decimal or binary. See Figure 3.200 on page 280.
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Figure 3.200: Export --> Export Text/Excel

This will bring up a SaveAs menu. See Figure 3.201 on page 281.
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Figure 3.201: Select Text Files Version 1.0/2.0 or Excel File Version 1.0/2.0

LBA/Sector#, XFER Length‐Sector Count and Tag will bring up a option to save the data in 
hexadecimal, decimal or binary format. See Figure 3.202 on page 282.
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Figure 3.202: Save Data as Hex, Decimal or Binary
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Chapter 4

InFusion Overview
The Teledyne LeCroy InFusion™ Error Injector and Traffic Modifier is an error injector and 
traffic modification tool that allows you to verify real‐world fault handling for 
Serial Attached SCSI (SAS) and Serial ATA (SATA) systems. InFusion can sit unobtrusively in 
the data path on a live system to programmatically alter or corrupt traffic. InFusion is the 
ideal tool for stress‐testing systems using actual workloads.

Figure 4.1: InFusion Windows.

InFusion supports SAS SSP, SMP, STP, and SATA‐based protocols operating across a single 
SAS or SATA link up to 6 G. InFusion monitors traffic from both directions in real‐time and 
relies on predefined rules to replace any bit, primitive, or parameter with one you specify. 
InFusion can change traffic when it detects a specific sequence or reaches a designated 
time interval, yet it requires no complicated scripts, programming, or simulation tools.
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InFusion can monitor traffic in both directions and act on events occurring in either 
direction of the communications link. InFusion can modify traffic in only one direction 
within a given test scenario, but that direction can be either from the Initiator or from the 
Target.

InFusion is specifically designed to verify recovery characteristics within a subsystem. An 
easy pop‐up menu interface allows you to create specific test scenarios in just minutes. 

Once a InFusion session starts, the system automatically handles protocol handshaking 
between devices. InFusion transmits a faithful copy of the original data stream down to 
the CRC value which, if needed, it recalculates. InFusion allows test engineers to 
systematically verify error recovery in ways not possible with other test platforms.

An Infusion event can trigger an analyzer.

Infusion supports all commands in the SATA 3.0 specification.

4.1 Key Features

The key features of InFusion are:

 Error Injection: Injects CRC, disparity, 8b/10b encoding, framing, and coding 
errors.

 Break Link Recovery: Programmatically breaks the connection to test link recov‐
ery.

 Value Replacement: Monitors the link for specific values, patterns, or primitives 
(as low as bit level) and replace with user‐defined values. You can replace values 
on every occurrence, after a specified number of occurrences, or after a speci‐
fied time interval.

 Packet Drop: Removes individual primitives, address frames, or data frames 
from the stream to verify retry behavior.

 Primitive Manipulation: Replaces handshaking and flow control primitives to 
help validate robustness of a design. 

 Traffic Monitoring: Operates as a traffic monitor, collecting statistical data on 
user‐specified parameters. In this mode, data passes unchanged in both direc‐
tions. 

 Menu‐Driven Interface: Allows easy set‐up of test scenarios.
 API based on C++: Allows development of custom test applications.
 Scenario Batch Files: Allows scenario scripts.

With respect to traffic modification, in the Link Layer you can modify primitives, CRC, 
scrambled traffic, and SSP, SMP, and STP connection events. You cannot modify clock 
skew management, OOB and power management, and signal integrity.

InFusion consists of a hardware device that connects to the line under test and a 
Windows‐based software application used to create and download test scripts to the 
device. You also can use the software application to configure and control the device 
across an Ethernet link.
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InFusion test scripts are called scenarios. Scenarios determine how the hardware device 
monitors and modifies line traffic. You must use the application to create and download 
scenarios.

For the InFusion connections, the device is connected between the SAS/SATA host and 
the PHY of the test target (DUT). While jamming, the signals between ports I1 and T1 (for 
example) are routed through the FPGA, as opposed to being routed through the front end 
in the case of Analyzer mode. Both Out of Band (OOB) and data signals propagate through 
the FPGA. 

4.2 Interface

4.2.1 Buttons

The InFusion interface has the following command buttons:

New Scenario: Begins the scenario creation process by listing Scenario Name, Direction 
for traffic changes, and Global Rules in the scenario window.

New Batch Script: Starts a scenario batch file in Batch Script window.

Open Library: Lists the InFusion Library Files (.infdb), which contain the available 
scenarios, in an Open dialog.

Save: Saves the current scenario in the UserData folder.

Print: Prints the current scenario.

Show Library: Displays/hides the Main Library window (on the right), which displays the 
available scenarios. You can create a new scenario, save a selected scenario, save the 
library, save a copy of the library, display the selected scenario, insert a copy of the 
selected item, or delete the selected scenario.

Show Output: Displays/hides the Output window (at the bottom), which displays 
InFusion output. Use the buttons to save output, print output, display options 
(automatically save the log file, with a path and size), start logging, stop logging, and clear 
the Output window.

Show Device Library: Displays/hides the scenarios of the current device library.

Port Configuration: Displays the port configuration dialog. See “Port Configuration for 
InFusion” on page 289.

Show Analyzer: Returns to the Protocol Analyzer. 

Show Trainer: Goes to the Trainer window.

Run Batch Script: Runs a scenario batch file.

Stop Batch Script: Stops a running scenario batch file.

Rec Analyzer: Starts recording on the current analyzer, using the current project.

Stop: Stops recording on the current analyzer.
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Abort: Aborts recording.

4.2.2 Menus

The InFusion interface has the following menus:

File (see command descriptions in the “Buttons” section above)

 New Scenario, Open Scenario (File Library or Main Library)
 Open an InFusion database (.infdb file)
 Launch Analyzer
 Launch Trainer
 New Batch Script, Save Batch Script As
 New Library, Close Library (File Library or Main Library), Save Library, Save Copy 

of Library As
 Open Log File
 Print Setup
 Recent Trace Files
 Recent Project Files
 Close

Setup
 External Trig Setting (see “External Trig Setting” on page 256)
 Update Sierra Device (see “Update Device” on page 256)
 All Connected Devices
 Status Bar

View
 Views (Library, Output, Customize; see window descriptions in “Buttons” section 

above)
 Smart Docking
 Toolbar
 Status Bar

Configuration

Port Configuration (see “Port Configuration for InFusion” on page 289)

Batch Script Setting (see “Scenario Batch Files” on page 348)

Tools 

Browse UserData, System, or InFusion folder.

Help

Help Topics and About InFusion.

4.2.3 Main Library

You can Show Main Library.
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Figure 4.2: Main Library.

The Main Library has Scenarios.

Using the buttons from left to right, you can:

 Create a new scenario and save a scenario.
 Save a library and save a copy of a library.
 View/edit a scenario, insert copy of a scenario and delete scenario.
 device ports.
 Copy and paste.

4.2.4 File Library

You can display the File Library.

Figure 4.3: File Library.

A File Library has Scenarios currently available in the device. Using the buttons from left to right, you 
can:

 New scenario.
 Save selected scenario.
 Save library.
 Save a copy of the library as.
 View/edit a selected item.
 Insert a copy.
 Delete a selected scenario.
 Copy
 Paste
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4.2.5 Device Ports

If a device is connected, the software displays the Device Ports.

Figure 4.4: Device Ports.

Using the first row of icons, you can Run/Stop All Ports or Run/Stop individual ports.
The columns display the Port, Function/Configuration, Library, and Scenario.
You can Float, Dock, Auto‐Hide, or Hide the window.

Note:A port row is grayed‐out when that port has not been configured to be a Jammer in the 
Port Configuration dialog (see “Port Configuration for InFusion” on page 289).

4.2.6 Using the Device Ports Dialog

After you have finished Port Configuration (see “Port Configuration for InFusion” on 
page 289), you use the Device Ports dialog to assign specific scenarios to ports, so that 
different scenarios can run on different ports. 

To assign a scenario to a port, drag and drop the scenario from any library window to the 
port. The Device Ports dialog then displays the Library and Scenario on the row for that 
Port/Configuration.
88 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual



Port Configuration for InFusion  Teledyne LeCroy
Alternatively, assign the scenario using the Library and Scenario drop‐down lists.

After you have assigned scenarios to ports, in the first row of icons, use the first green 
arrow icon to Run/Stop All Ports, or use the numbered green arrows to Run/Stop an 
individual port.

Note:A port row is grayed‐out when that port is running a scenario.

4.3 Port Configuration for InFusion

The InFusion (Jammer) port configurations must match the Analyzer port configurations 
for the infusion‐analyzer to work. 

Select Configuration > Port Configuration to display the Set Port Configuration dialog. 

To record traffic, select Jammer on the port that you want to jam. In the following figure, 
there is a match on Port 1. 

Figure 4.5: Ports Configuration Dialog with InFusion/Analyzer Port Match.

Note:To display the current Port Configuration, click Show Analyzer to go to the analyzer application, 
then click the green button in the lower right corner to display the Port Status window (see 
“Port Status” on page 234).
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4.4 InFusion Scenarios

You can create and execute InFusion scenarios. A scenario is a test script that defines how 
InFusion monitors and modifies line traffic.

4.4.1 Scenarios Overview

The InFusion application provides a menu‐driven interface for building scenarios. The 
interface prompts you for simple decisions and choices from drop‐down menus. As you 
make your selections, the script takes shape automatically in the scenario window. The 
script is in the form of simple English sentences. You need not understand any formal 
scripting language (see Figure 4.6 and Figure 4.7 on page 291).

To start, Select File ‐> New Scenario as shown below:

Figure 4.6: Generate a New Scenario
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Figure 4.7: Structure of New Scenario 0
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InFusion Scenario Parameters

Timers

Timers allowed per state/sequence/scenario: 

2 timers per state and 6 timers per scenario are allowed.

Events

Events allowed to be used per state/sequence/scenario: 

For combined events, there is virtually no limit per state/sequence/scenario. 

Actions

Actions allowed per state/sequence/scenario: 

A maximum of 8 actions per state, 2048 actions per sequence (8*256 state), 4104 actions 
per scenario (2*2048 + 8 more in the Global Rules "state"). 

Monitors

Monitors allowed to be used per state/sequence/scenario: 

InFusion can keep an account of 8/12 Monitor/Count events per scenario. 

Random change of use of count and count randomly:

In Global Rules, if a Counter is used for Event counting, 2 extra actions are consumed. 2 
more actions are required for "Every Nth occurrence" option. 

In Sequences, If a Counter is used for Event counting, 3 extra actions are consumed. 3 
more actions are required for "Every Nth occurrence" option. 

Regarding limits on any of the above mentioned connections, i.e., x timers + y monitors 
are allowed per state where x+y=n: 

There are a lot of big/small rules checked by the scenario compiler, but as a rule of 
thumb: 

8 actions per state are available

12 counters globally are available, each assigned permanently to a certain job 

6 available timers per scenario 

12 programmable multi‐purpose resources for DWORD comparison/substitution/capture 
are available. If a pattern detector uses 3 of these resources to trigger on a specific frame 
on the bus, only 9 more resources are available for other tasks. Frame/FIS type detectors 
are excluded from this rule, because they use their own dedicated resources. 

8 primitive detectors are available

If you want to trigger on a pattern (Frame/FIS) and change/capture a dword(s) before the 
last offset of a detected pattern (e.g., changing the Frame Type of a SAS Frame with Data 
Offset == 11223344), you are limited to a maximum of 9 dword offset (i.e., if you trigger 
on the 20th payload of a Data FIS, you can change/capture the 12th dword onwards. 11th 
payload dword and preceding dwords are not accessible for change/capture) 
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You can not change a state based on back‐to‐back events. At 6G speed, there should be at 
least one dword between the triggering event of two consecutive states. At other speeds, 
back‐to‐back dword state transitions might rarely be missed, so best practice is to never 
assume back‐to‐back dword events. 

As described later in this chapter, you can create any number of scenarios and store them 
in libraries on the host machine’s hard drive. Scenario library files names are in the 
following format: 

<filename>.infdb

Creating InFusion scenarios is easy, but it requires an understanding of the following 
terms defined in Table 1.

TABLE 4.1:  Key Scenario Terms

Term Definition
Action InFusion response to an event.

Event Condition that is detectable by InFusion.

Combined Event Logical OR association of events (for example, event A OR event 
B).

Global Rules Portion of a scenario that can define a single InFusion test state. 
You can think of the Global Rules and each sequence as a 
separate test routine or program operating within the scenario. 
Each operates independently and in parallel with the others. The 
purpose of each is to detect events and then respond with the 
appropriate action or set of actions. In essence, you can operate 
up to three test states simultaneously within InFusion.

Sequence Portion of a scenario that can define multiple InFusion test states. 
More flexible than the Global Rules, a sequence allows more 
powerful scenarios that include branching and looping between 
test states (Global Rules can define only a single test state, so 
there is no branching).

State “Behavior” of the Global Rules or a sequence at any point in time. 
In terms of InFusion testing, behavior is “waiting” for a set of 
events and responding with a set of actions.
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Global Rules

Global Rules are a portion of the scenario that can define only one test state. To create 
the Global Rules, you use the menu‐driven interface to enter an event or combined event 
and the corresponding action or set of actions (the response of InFusion hardware to the 
event).

In the case of a combined event, the action is taken upon occurrence of any of the events 
stated for the event combination. It is a logical OR association, meaning any of the events 
can trigger the action.

After you enter the event or combined event, the interface prompts you for actions. An 
action might be, for example, injecting a particular primitive or error into the traffic 
stream. You can enter multiple actions, which take place simultaneously. 

After defining the event and actions within the Global Rule area, you can save the 
scenario and download it to a InFusion device.

Sequences

The Global Rules are all you need for simple test scenarios. However, a scenario also can 
contain one or two sequences, which can define multiple states and allow branching 
between states. With a sequence, you also can do looping, which allows you to repeat a 
test state or to execute a test for a specified period of time.

As with Global Rules, the menu‐driven interface guides you in building a sequence. Some 
of the prompts are different, however, because you now are encapsulating groups of 
events and actions as distinct states. Recall that a state is a combination of events and 
actions at a specific point in time. If the event or combined event defined by a state 
occurs, the corresponding action or set of actions follows.

Figure 4.8: Global Rules and Sequence Areas of a Scenario

InFusion hardware provides the capacity to have up to two sequences co‐existing in a 
scenario in addition to the Global Rules. Recall that both the Global Rules and any 
sequences are active at all times. Each is a separate “state machine,” having the behavior 
of a particular test state at any point in time. Because the Global Rules has the capacity 
for only one state, you can view it as a “degenerative state machine.”
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4.5 Scenario Libraries

You can create any number of scenarios, which you then can archive on your host 
machine’s hard drive. You also can download up to ten scenarios to each InFusion device 
for test execution. You can think of the libraries as windows that hold scenarios. 

Recall that each library is a separate *.infdb file.

Main Library

When you launch the InFusion application, it opens a window called the Main Library. The 
main library is the default workspace for creating and storing new scenarios. The main 
library corresponds with the following file in the InFusion folder on the host machine’s 
hard drive:

default.infdb

File Libraries

You can save the main library with a name other than default (while still using the .infdb 
file extension). The new file becomes a file library that is functionally equivalent to the 
main library with the following exception: It does not open by default in the Main Library 
window. You can navigate to other file libraries using the File Manager of the InFusion 
application.

In this manual, the main library and other .infdb file libraries are collectively called 
general libraries.

If you select Open Library, you see a window similar to the following:

Figure 4.9: Open Library File List
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By selecting the TestCasesForSATA.infbd file, you get an additional library window with 
predefined SATA test cases, similar to the following:

Figure 4.10: Test Cases for SATA Library

Device Libraries

In addition to general libraries, the application defines device libraries. Each device 
library is associated with a specific InFusion device. Each device library opens in a 
separate Device Library window and holds up to ten InFusion scenarios for the device. 
When you connect to the device and click the entry for that device in the Device List, the 
device library for the device opens automatically. 

The scenarios that appear in the device library are those currently stored on the 
corresponding device. They were uploaded from the device to your host machine when 
you opened the device library. You can click any of the scenarios listed to open it for 
editing. When you are finished with your edits, you can use the buttons on the 
Device Library toolbar to download the revised scenario to the device.

The None scenario is an empty and undefined scenario to allow you to assign port(s) to 
None.

The Multiport feature allows you to run a scenario by more than one port in a 
Device Library and to assign different ports to different scenarios and run them together. 
Each scenario in a library can run by more than one port.
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4.6 Scenario Properties

To begin the scenario creation process, you click the New Scenario button in a library 
window, the InFusion application toolbar or from the SAS SATA Protocol Suite Main Menu 
(see Figure 4.11) select Jammer (to get the InFusion dialog to popup see Figure 4.12).

Figure 4.11: SAS SATA Protocol Suite Main Menu

From the InFusion Dialog select the Create New Scenario icon (see Figure 4.12).

Figure 4.12: InFusion Dialog 

The following New Scenario dialog pops up. See Figure 4.13 on page 298.
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Figure 4.13: Structure of New Scenario 0

4.6.1 Scenario Generation
Your New Scenario 0 already has several Scenario Properties defined for it:

 Scenario Name: New Scenario 0
 Direction for traffic changes: From Initiator
 Smart Hold: Yes
 OOB Setting: Normal (Spec Value).

You can change any of these parameters by selecting them.

Scenario Name

Selecting Scenario Name allows you to customize it. See Figure 4.14.

Figure 4.14: Scenario Properties: Name
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Direction of Traffic

Selecting Direction allows you to change the Direction of Traffic. You identify direction of 
traffic change, or modification, in terms of traffic origin. The application uses the 
following conventions:

 From Initiator: Change is made to traffic coming from test host (for example, CRC 
error is injected into traffic stream sent from initiator to target).

 From Target: Modification is made to traffic coming from the target (for exam‐
ple, CRC error is injected into traffic stream sent from target to initiator). 

The direction for traffic modification is defined on a global basis for the entire scenario. In 
other words, any scenario action that modifies line traffic only affects the traffic flowing 
in the direction established at the top of the scenario, in the Scenario Properties. Scenario 
events can be monitored in either direction, and therefore the parameters for events 
provide the ability to specify the intended direction for monitoring traffic for that event. 
See Figure 4.15.

Figure 4.15: Scenario Properties: Direction of Traffic

Smart Hold

SATA Scenario Properties have a Smart Hold option, which is on by default. Figure 4.16 on 
page 300.
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Figure 4.16: Scenario Properties: Smart Hold

Each port monitors incoming data, which originated with the other device’s receiver, as 
close as possible to where it enters the bus engine. If a port detects a HOLD primitive 
during a SATA frame, the port stops reading data from the FIFO and generates HOLDA. 
The HOLD propagates through the bus engine and eventually goes to the other device, 
where the HOLD causes the other device to send HOLDA. (The bus engine FIFOs must be 
deep enough to hold all the traffic that the other device sends while the HOLD 
propagates. The port drops all incoming HOLDA conditions, so HOLDAs are never put in 
the FIFOs or made visible to the sequencers.)

After this, the port that had been receiving the HOLD stops sending HOLDA and attempts 
to read data from the FIFO. The termination of HOLD propagates through the bus engine 
and then causes the other device to restart transmission, which puts data into the FIFO.

Note: If both sides send HOLD primitives that overlap, the receivers drop the HOLD conditions to avoid 
overflowing the FIFOs. If you turn off the Smart Hold option, the port does not send HOLDA 
when it detects a HOLD primitive during a SATA frame.

OOB Definition

Select OOB Definition to set the Out of Band conditions. You have three choices (see 
Figure 4.17 on page 301):

 Normal (Spec Value)
 Violated
 Custom (User Defined)

Normal uses Spec Values for OOB conditions. 
300 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual



Scenario Properties  Teledyne LeCroy
Normal (Spec Value)

Figure 4.17: Scenario Properties: OOB Definition

Violated

You can set the COMINT, COMSAS or COMWAKE parameters that would cause an OOB 
condition by selecting Violated and selecting Yes or No. See Figure 4.18.

Figure 4.18: Scenario Properties: OOB Violated Conditions
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Custom (User Defined)

Or you can generate your own set of Conditions for an Out of Bounds conditions: Custom 
(User Defined). See Figure 4.19.

Figure 4.19: Scenario Properties: OOB Custom Conditions

This allows you to set the values for each parameter type (COMINT, COMSAS, and 
COMWAKE).

The next step is to define the Scenario Events and Actions.

4.7 Scenario Events

A scenario is a script you create using simple mouse clicks and text entries. As you work, 
the script takes shape in the scenario area of the application display. You can think of the 
scenario area itself as consisting of two subareas: A Global Rules area at the top, where 
you create the Global Rules, and a Sequence area beneath the Global Rules, where you 
create any sequences. Whether you are creating Global Rules or a Sequence, the menu‐
driven interface prompts you to specify the event(s) for which you want to trigger actions 
(see Figure 4.20 on page 303).
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Figure 4.20: Event Properties Dialog
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To copy an event or action, right‐click on the event or action and select Copy. 
Right‐click Click here to add another event or Click here to add an action and then select 
Paste. 

To copy a sequence or state, right‐click on the sequence or state and select Copy. 
Right‐click Click here to add another sequence or Click here to add another state and 
then select Paste. 

You can also cut, delete, and edit a selected sequence, state, event, or action.

While many events are line conditions, an event also can be a condition that occurs 
within a InFusion device (for example, detection of a trigger signal from another device). 
The following table lists supported events. Note that some events are applicable only in 
the context of creating sequences (those events appear on the drop‐down list only if you 
are creating a sequence). Sequences can have multiple states, and they allow branching 
between states.
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TABLE 4.2:  Events

The following sections provide some additional details about three of the above events.

4.7.1 DWORD Matcher

DWORD Matcher is a DWORD pattern matcher that presents match and mask fields and a 
K‐Code Mask field. K‐Codes are control characters that are always used in the first byte of 
a four‐byte primitive. Of the K‐Code masks listed in the menu, D‐D‐D‐D is used for data 
bytes, and K‐D‐D‐D is used for all primitives.

Event Description
Address Frame Occurrence of a specified address frame.

Analyzer Trigger The Analyzer Trigger feature functions when an Analyzer trigger 
pattern is set to "Pattern/Infusion" and is running a scenario 
which activates the "Trigger Analyzer" action.

Any DWORD Occurrence of any DWORD.

ATA Command Occurrence of a particular ATA command.

ATA Command Frame Occurrence of a particular ATA command frame.

[+] ATAPI Occurrence of a particular ATAPI command from the list:
MMC4, RBC, SBC2, SMC2, SPC2, SPC3, or SSC2.

Both Links Up Occurrence of both line ports active (not idling).

CRC Error Occurrence of a CRC error.

DWORD Matcher Occurrence of a particular DWORD.

FIS Frame Occurrence of a particular FIS frame.

FIS Type Occurrence of a particular SATA FIS type.

Frame Type Occurrence of a particular frame type.

Internal Trigger Allows user to send a trigger (notification) to other ports. See 
“Generating an Internal Trigger” on page 314.

Invalid 10bit‐code Error Occurrence of an invalid 10b code.

Links Speed 3G Both lines operating at 3 Gbps.

Links Speed 6G Both lines operating at 6 Gbps.

OOB Signal Occurrence of OOB signal.

[+] Primitives Occurrence of Primitive Group, SAS Primitive, or SATA Primitive. 
Includes NOT property (see Figure 4.21 on page 307).

Running Disparity Error Occurrence of Running Disparity (RD) error.

SAS Data Pattern Occurrence of a particular data pattern in a SAS frame.

SATA Data Pattern Occurrence of a particular data pattern in a SATA frame.

{+} SCSI Occurrence of a particular SCSI command from the list:
MMC4, RBC, SBC2, SMC2, SPC2, SPC3, or SSC2.

SMP Frame Occurrence of a particular SMP frame.

SNW Occurrence of Final SNW, SNW1, SNW2, SNW3, Train SNW

SSP Frame Occurrence of a particular SSP frame.

Timer Occurrence of a particular elapsed time (time period).

Trigger Input Occurrence of input trigger.
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When you create a DWORD match, keep the following in mind:

 The pattern can be inside or outside of frames (it does not matter if the pattern 
is inside a frame or not).

 Because the pattern can be inside or outside of frames, there is no offset.
 You can make user‐defined primitives. (This is the reason this feature was cre‐

ated.)
 You can use any K/D pattern.

4.7.2 Address Frame

With Infusion, you must enter all values in reverse MSB, LSB order. 

For example: a SAS Address in the viewer "5000C50056B8C829" should be entered like 
this in Infusion: "29C8B85600C50050".

4.7.3 SAS Data Pattern

 When you create a SAS data pattern, keep the following in mind:
 The pattern must be defined inside a frame that starts with a SOF or SOAF.
 The pattern must be data only (no K‐codes/primitives).
 The pattern must be defined at a specific offset in the frame.
 The pattern and mask must be specified in the same format as specified in the 

SAS standard: 
0x12345678 (hex)
where “1” is the first digit on the cable and is the MSB as given in the SAS Stan‐
dard.

For example, for an SMP Request:

Pattern: 0x40000000
Mask: 0xFF000000
Offset: 0
SOF Type: SOF

4.7.4 SATA Data Pattern

When you create a SATA data pattern, keep the following in mind:

 The pattern must be defined inside a frame that starts with a SATA_SOF.
 The pattern must be data only (no K‐codes/primitives).
 The pattern must be defined at a specific offset in the frame.
 The pattern and mask must be specified in the same format as specified in the 

SATA Standard.

For example, for Register H ‐> D FIS:

Pattern: 0x00000027
Mask: 0x000000FF
Offset: 0
SOF Type: SATA_SOF
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4.7.5 Analyzer Trigger

Trigger the Analyzer when the Scenario event matches. You can see the trigger on the 
Analyzer Status Bar.

The Analyzer Trigger feature functions when an Analyzer trigger pattern is set to "Pattern/
Infusion" and is running a scenario which activates the "Trigger analyzer" action. A 
message "Triggered, Post‐Trig Capturing" displays on the Software Status bar.

Note:This is different from the external trigger mechanism. You do not need an external trigger cable.

Note:When the analyzer triggers, it triggers on a packet before the actual trigger event occurs. The 
trace triggers more than 1 µs before the event actually occurs. The trigger is on the Initiator side 
instead of the Target side as set in the scenario. 

4.7.6 Adding NOT Property to SAS and SATA Primitives

Figure 4.21: Event Properties: Not

Use the Not property to look for a de‐asserted Primitive.
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4.8 Scenario Actions

After you enter the set of events for a test state, the menu‐driven interface prompts you 
for the corresponding action or set of actions. If you define multiple actions, the actions 
occur simultaneously.

Figure 4.22: Action Properties Dialog.

The following table lists supported actions. Note that some of these actions only apply to 
creating sequences.
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TABLE 4.3:  Test State Actions

Action Description
Beep Emits audible sound of duration. Select via drop‐down list.

Branch to

 
Existing State1 Go to a state in this sequence that is already defined.1

New State1 Go to a state in this sequence that is not yet defined (you 

need to define it).1

Capture Data DWORD Captures a data DWORD into one of four registers.

Inject CRC Error Injects a CRC error into the line.

Invalid 10bit‐code 
Error

Injects invalid 10b code into the line.

Running Disparity 
Error

Injects a Running Disparity (RD) error into traffic.

Insert Address Frame

FIS Frame

SAS Primitive

SMP Frame

SSP Frame

Inserts a frame or primitive.

Insert DWORD Inserts DWORD.

Internal Trigger Allows user to send a trigger (notification) to other ports. 
See “Generating an Internal Trigger” on page 314.

Link Disconnect Puts both InFusion SAS ports at electrical idle immediately. 
This action is only in effect while the scenario is running, 
and the Jammer will reconnect the line when the scenario 
is stopped.

Reconnect Starts traffic pass‐through immediately. This action 
restarts traffic after a previous disconnect command. Once 
traffic is passing through, the initiator and target resume 
OOB signaling.

Marker The main purpose of this feature is enabling the user to 
mark specific parts of the captured traffic for better 
tracking. See “Generating a Jammer Marker” on page 316.

Monitor/Count Opens a window to count the number of events that occur 
during a session. A session is a time interval during which a 
scenario runs.

Remove Frame Partially

Primitive

Whole Frame

Removes the targeted event from the traffic.

Restart  All Sequences1 Restart all sequences in the scenario.1

Current Sequence1 Restart the sequence that contains this action definition. 1

SNW Speed Negotiation 
Retime

Set RCDT, SNTT, ALT/TLT, TX speed, TRAIN/TRAIN_DONE 
pattern, and/or PHY Capability.

Speed Negotiation 
Violation

Set Violation Type.
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1 Only shown in Action Properties dialog box when creating a sequence.

4.8.1 Available Resources

You can specify Events, Combined Events and Actions and additional Events. The 
application automatically checks for the maximum number of terms (Events/Actions). 
When you exceed the limit, an error is flagged, prompting you to jump to the place that 
caused the error.

The list of available resources is given below:

 External Trigger X 1
 Analyzer Trigger X 1
 Training Detector x 4 (only M12x)
 Primitive Detector (each has its own Embedded counter in M12x) X 8
 Pattern Detector (each has its own Embedded counter in M12x) X 8 (a total of 12 

DWORD detectors are shared between all pattern detectors)
 Frame Type Detector X 24
 Counter X 12
 Timer X 8
 OOB X 1
 ComWakeDetected X 1
 ComWakeCompleted X 1
 ComInitDetected X 1
 ComInitCompleted X 1
 ComSasDetected X 1
 ComSasCompleted X 1
 Snw1 X 1
 Snw2 X 1
 Snw3 X 1
 SnwFinal X 1
 SnwTrain X 1
 DisparityError X 1
 10B Error X 1
 CrcError X 1
 Both Links Up X 1
 Link Speed 3G X 1
 Link Speed 6G  X 1
 Link Speed 12G X 1

Stop Scenario Stops all scenario activity.

Substitute Data DWORD Substitutes a data DWORD in the traffic.

with SAS Primitive Substitutes a SAS primitive in the traffic.

with SATA Primitive Substitutes a SATA primitive in the traffic.

Trigger Output Sends a signal out the trigger port to the device 
downstream.

Action Description
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 Primitive Substitute X 12
 Insert Frame1 (Up To 1024 Dword) X 1
 Insert Dword8 (Up To 16 Dword) X 8
 SNW Manipulation X 16
 Global Action Register X 8
 State per sequencer X 256
 Action Register per state X 8

Usage of Action Register: 

 Each Counter in Global Rules = 2
 Each Counter in State = 3
 Each Timer in Global Rules = 2
 Each Timer in State  = 3
 Other Actions = 1

4.8.2 Using Counters in Events and Actions

Many of the events and actions supported by InFusion also support counters that can 
control functions.

Within events, counters determine how many times the event must occur before the 
associated actions are triggered. Event counters typically have two properties:

 Count Randomly: Can be set to “Yes” or “No” (default value is “No”). 
If set to “Yes”, the event repeats a random number of times (between 1 and the 
value set in the property Max Random Count, which replaces the property 
Counter Value when “Yes” is selected), before the action is triggered.

 Counter Value: Number of repeats required when Count Randomly is set to 
“No”. The default value is 1.

Within actions, counters determine how many times the system calls the action before it 
acts. Action counters typically have two properties:

 Random: Can be set to “Yes” or “No” (default value is “No”). 
If set to “Yes”, the action triggers a number of occurrences before the action 
takes place. That number ranges randomly between 1 and the value set in the 
property At least every Nth occurrence, which replaces the property 
Every Nth occurrence when “Yes” is selected.

 Every Nth occurrence: Number of times the system calls the action before it 
acts.

Note that there is some overlap in the way these counters can be used. For example, in 
the simple case of a single event leading to a single action, it makes no difference whether 
you specify the event to require five repeats before triggering the action, or the action to 
require five occurrences before it acts.

However, in the case of combined events and/or actions, the separate counters provide 
flexibility in designing test cases. For example, consider the case where Event_1 OR 
Event_2 leads to Action. If Event_1 has a counter of 5, then the Action triggers either 
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when Event_1 has repeated five times or when Event_2 happens the first time, 
whichever occurs first.

But if the event counters are set to 1 and the Action counter is set to 5, then the Action 
happens after five occurrences of EITHER Event_1 or Event_2.

4.8.3 Capturing a Data DWORD

InFusion provides the ability to capture individual data DWORDs and provides four 
different registers to store captured DWORDs (DWORD #0, #1, #2 and #3).

To capture a data DWORD, select Capture Data DWORD from the Action Properties 
screen. Select the register to be used to store the DWORD from the drop‐down menu 
under the Capture Register property.

Figure 4.23: Capture Data DWORD Action

4.8.4 Using Captured Data DWORDs

Captured data DWORDs can be used in creating events for data that match the captured 
DWORD(s), or in creating actions to substitute the captured DWORD(s) into the data 
stream.

To create an event using the captured DWORD, in the Event Properties menu, select SAS 
Data Pattern (or SATA Data Pattern), and then select any of the 12 DWORDs (DWORD 0 
Type through DWORD 11 Type). The drop‐down menu provides the choice of a custom 
DWORD or any of the four captured DWORDs. If you select a captured DWORD, the Value 
field beneath this selection is hidden (the Value field is only used for specifying custom 
DWORDs). Note that choice of a mask and an offset are still available when using 
captured DWORDs (see Figure 4.24 on page 313).
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Figure 4.24: Using a Captured DWORD in a SAS Data Pattern

Captured data DWORDs may also be used in the Substitute Data DWORD test state 
action. From the Action Properties screen, choose Substitute Data DWORD and then 
select the Substitute for property. A drop‐down menu is provided (see below) that allows 
the choice of a custom DWORD or any of the four captured DWORD registers.

Figure 4.25: Using a Captured Data DWORD in Substitute DWORD Test Action
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4.9 Summary of Scenario Creation

The suggested process of creating and executing a scenario is as follows:

1. Create a scenario in the main library.

2. Copy the scenario from main library to a device library by drag‐and‐drop with a 
mouse. (Each device library is associated with a specific InFusion device.)

3. Download all scenarios in the device library to a InFusion device.

4. Select the scenario in the device library that you want to run on the device.

5. To run the scenario, click the Start Scenario button from the Device Library toolbar. 
The device starts to monitor/modify traffic.

Note:Step 1 is described in detail for each example in following sections. Steps 2 to 5 are described in 
detail at the end of this chapter.

4.9.1 Generating an Internal Trigger

This feature has the following capabilities:

1. ‘Internal Trigger’ action to notify all other paths has been added, there are 4 internal 
trigger signals (0 to 3).

a.       Internal Trigger Action 0

b.      Internal Trigger Action 1

c.       Internal Trigger Action 2

d.      Internal Trigger Action 3

2. ‘Internal Trigger’ event to wait for others’ notifications has been added

a.       Internal Trigger Event 0, which corresponds to Internal Trigger Action 0

b.      Internal Trigger Event 1, which corresponds to Internal Trigger Action 1

c.       Internal Trigger Event 2, which corresponds to Internal Trigger Action 2

d.      Internal Trigger Event 3, which corresponds to Internal Trigger Action 3

The above feature can cover a few requirements like, Stop All ports, bi‐directional 
jamming and emulate wide port jammer. See Figure 4.26 on page 315.
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Figure 4.26: Internal Trigger Index

Example of Using Internal Triggers to Stop All Scenarios

The example scenario can be generated to use any of the internal triggers to stop all 
scenarios. When this scenario (New Scenario 1) is run on all ports, as soon as any port 
finds the 500th occurrence of SSP Command Frame, the scenario will stop on that Port 
and send an internal trigger signal to all other ports. This internal trigger will then cause 
the scenarios running on any other port to stop.

The commands used in the script are shown below:

< Global Rules ‐ waits for Internal Trigger Event then stop scenario >

< Sequence ‐ waits for SSP Command Frame then Internal Trigger Action and stop 
scenario > 

The commands to generate this scenario are shown below (see Figure 4.27).
 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual 315



Teledyne LeCroy Summary of Scenario Creation
Figure 4.27: Scenario to Turn Off Scenarios with Internal Triggers

4.9.2 Generating a Jammer Marker

The main purpose of this feature to enable the user to mark specific parts of the captured 
traffic for easier tracking of data.

In Sequence 0 shown below, the Event is Waiting for a CRC Error. After that event occurs 
an Action will be taken, (see Figure 4.28 on page 316).

Figure 4.28: Sequence 0: Event = CRC Error, then Add an Action

Add an Event 
Event = CRC Error

Sequence 0

Add an Action 
(Adding a 
Marker Index)
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In this case, Click on <Click here to add an action> and the Action Properties Menu will 
pop up. To add a Jammer Marker, click on Marker and the Properties section of the Menu 
will show Marker Index. There are seven Jammer Markers available to the user. See 
Figure 4.29 on page 317.

Figure 4.29: Jammer Marker Index 1 – 7

When the Jammer implements this action, the result is adding a marker to the captured 
trace in the analyzer data stream. See Figure 4.30 on page 318. The added marker 
(Bookmark = Jammer Marker 7) will be shown as a bookmark in the trace and you can see 
the list of markers in the bookmark dialog. 

Note:As a function of recorded speed and port configuration, the InFusion marker might be off by 
a tolerance of up to 200 nsec.

Note:The limitation for adding markers to a trace is 10,000. 
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Figure 4.30: Sequence 0: Event = Wait for CRC Error, Action = Add Jammer Marker 7

4.9.3 Summary of Scenario Creation

The suggested process of creating and executing a scenario is as follows:

1. Create a scenario in the main library.

2. Copy the scenario from main library to a device library by drag‐and‐drop with a 
mouse. (Each device library is associated with a specific InFusion device.)

3. Download all scenarios in the device library to a InFusion device.

4. Select the scenario in the device library that you want to run on the device.

5. To run the scenario, click the Start Scenario button from the Device Library toolbar. 
The device starts to monitor/modify traffic.

Note:Step 1 is described in detail for each example in following sections. Steps 2 to 5 are described in 
detail at the end of this chapter.

4.9.4 Creating Global Rules

This section gives examples for creating the Global Rules area of a scenario. Recall that 
the Global Rules area defines a single test state. The Global Rules do not have the 
capacity for multiple states, so that area of a scenario cannot change state.
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In terms of InFusion testing, a state defines test “behavior.” In this context, behavior is 
“waiting” for an event and responding with an action or set of actions that happen 
simultaneously. 

Keep in mind that a test state you implement with the Global Rules operates in parallel 
with the active test state of each sequence in the scenario. 

In effect, InFusion lets you do up to three line tests at the same time. You can do one test 
with the Global Rules and a separate test with each sequence you create. You can have up 
to two sequences in a scenario. 

The following table summarizes the Global Rules examples that follow.

TABLE 4.4:  Global Rules Examples

4.9.5 Examples

Example 1: Creating a Single Event and Action that Removes a Primitive

In this example, the Global Rules area of the scenario waits for each RRDY Normal 
primitive from the initiator and removes it.

1. Click the New Scenario button in the main library or one of the device libraries.

2. In the Scenario Properties dialog, enter the scenario name, description, and 
direction of traffic change (see Figure 4.7 on page 291).

3. In the Global Rules area, click the prompt to add an event.

Example Description
1 Creating a single event and action (removes a primitive).

2 Creating a single event and action (replaces a primitive).

3 Creating a combined event (a logical OR association of multiple events) and 
an action.

4 Creating multiple triggers and actions.

5 Creating multiple actions on a single event.

6 Using timers.
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Figure 4.31: Example 1: Adding an Event

The Event Properties dialog box appears (see Figure 4.20 on page 303). 

4. In the Type column of the Event Properties dialog, choose Primitive > SAS Primitive.

5. In the Type column in the middle of the dialog box, click Description if you want to 
add a description of the event. 

6. Click Direction to choose the direction of traffic to monitor for the selected event 
(the default is From Initiator, which is what you want for this example). 
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7. Still in the middle column of the Event Properties dialog box, click Primitive to 
display a drop‐down menu that lets you choose the type of primitive for which you 
want to wait in this scenario. In this example, it is RRDY (Normal).

Figure 4.32: Example 1: Event Drop-Down List

8. Click OK to close the Event Properties dialog box.
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9. In the Global Rules area, click the prompt to add an action.

Figure 4.33: Example 1: Entering an Action

The Action Properties dialog box appears (see Figure 4.22 on page 308).

10. In the Type column on the left, choose the action that you want to occur when an 
RRDY is detected. In this example, it is the Remove Primitive action. Select Random 
Yes or No, N for Every Nth occurrence, and Monitor/Count as Monitored or Not 
Monitored.

11. Click OK to close the Action Properties dialog box.

Figure 4.34: Example1: Complete Scenario

12. In the File menu, select Save Scenario to save the scenario.

Example 2: Wait for a Primitive and Replace It with an Error

In this example, the Global Rules portion of the scenario waits for each RRDY Normal 
primitive and replaces it with an ERROR primitive.
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1. Click the New Scenario button in the main library or one of the device libraries. In 
the Scenario Properties dialog, enter the scenario name, description, and direction 
of traffic change.

2. In the Global Rules area, click the prompt to add an event to display the 
Event Properties dialog box.

3. As you did in the previous example, choose RRDY (Normal) as the type of primitive 
to monitor.

4. In the Global Rules area, click the prompt to add an action to display the 
Action Properties dialog box.

5. In the Type column on the left, choose Substitute > with SAS Primitive as the action 
that you want when an RRDY (Normal) occurs.

6. In the middle column of the dialog box, click Description if you want to add a 
description of the action.

7. Still in the middle column of the Event Properties dialog box, click Primitive to 
display a drop‐down menu that lets you choose the type of primitive for which to 
substitute for RRDY (Normal) (see Figure 4.32 on page 321). Choose ERROR.

8. Click OK to close the Action Properties dialog box.

9. In the File menu, select Save Scenario to save the scenario.

In this example, you set the substitution action to happen at every occurrence of an RRDY 
(Normal) (as shown in the figure, the action is set for every occurrence). However, you 
can set an action to happen at other multiples of event occurrence (for example 5, 25, 
1000 and so on). You also can set the action to happen at random, within a specified 
number of event occurrences. 

Figure 4.35: Example 2: Complete Scenario

Example 3: Creating OR Conditions

In this example, the Global Rules area of the scenario waits for either of two types of 
RRDY primitive and replaces them with an ERROR primitive.
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This example includes a combined event (a logical OR association of two or more single 
events). Here, the combined event consists of any occurrence of RRDY (Normal) or RRDY 
(Reserved 0).

1. Click the New Scenario button in the main library or one of the device libraries. In 
the Scenario Properties dialog, enter the scenario name, description, and direction 
of traffic change.

2. In the Global Rules area, click the prompt to add an event to display the 
Event Properties dialog box.

3. As you did in example 1 of this chapter, choose RRDY (Normal) as the first primitive 
that you want to monitor.

4. Click the add combined event prompt to add a second event. 

Figure 4.36: Example 3: Entering the Second Event

The Event Properties dialog box appears.

5. Choose RRDY (Reserved 0) as the second primitive that you want to monitor. 

6. Click OK to close the Event Properties dialog box. 

7. In the Global Rules area, click the prompt to add an action to display the Action 
Properties dialog box.

8. In the Type list on the left, choose Substitute SAS Primitive as the action that you 
want when either RRDY Reserved 0 or RRDY Normal occurs.

9. Click OK to close the Action Properties dialog box.
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10. In the File menu, select Save Scenario to save the scenario.

Figure 4.37: Example 3: Complete Scenario

Example 4: Multiple Triggers and Actions

In this example, the Global Rules area of the scenario waits for two events, each of which 
triggers a different action.

1. Click the New Scenario button in the main library or one of the device libraries. In 
the Scenario Properties dialog, enter the scenario name, description, and direction 
of traffic change.

2. As you did in example 2, choose RRDY (Normal) as the first event to monitor, and 
substitute with the SAS primitive ERROR as action.

3. In the Global Rules area, click the prompt to add the next event (keep in mind this is 
not a combined event).

Figure 4.38: Example 4: Entering Second Event
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The Event Properties dialog box appears.

In this example, there is a parallel set of events, but each event is associated with its own 
action. In a combined event, there is a parallel set of events sharing the same action.

4. Using the drop‐down menu, choose RRDY (Reserved 0) as the second event to 
monitor.

5. Click OK to close the Event Properties dialog box.

6. In the Global Rules area, click the prompt to add an action to be triggered by the 
RRDY (Reserved 0).

Figure 4.39: Example 4: Entering Second Action

The Action Properties dialog box appears.

7. Use it to choose Inject RD Error as the action triggered by RRDY (Reserved 0).

8. Click OK to close the Action Properties dialog box.

Figure 4.40: Example 4: Complete Scenario

9. In the File menu, select Save Scenario to save the scenario.
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Example 5: Multiple Actions on a Single Event

In this example, an event triggers a set of actions. The actions occur at the same time. The 
device waits for an ACK from the initiator. When it occurs, the device beeps, injects an RD 
error, and increments a counter monitoring for that event (ACK from initiator).

1. Click the New Scenario button in the main library or one of the device libraries. In 
the Scenario Properties dialog, enter the scenario name, description, and direction 
of traffic change.

2. As in previous examples, configure the first event and its response in the Global 
Rules area. Choose ACK primitive as the event and Beep as the action. From the 
Action Properties drop‐down menu, enter 500 ms as the duration of the beep.

3. Click the add another action prompt to add a second action.

Figure 4.41: Example 5: Entering the Second Action

The Action Properties dialog box appears.

4. Choose Inject RD Error as the second action.

5. Click the add another action prompt to add a third action.

6. The Action Properties dialog box appears.

7. Choose Monitor/Count as the third action.
 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual 327



Teledyne LeCroy Summary of Scenario Creation
8. Click OK to close the Action Properties dialog box.

Figure 4.42: Example 5: Complete Scenario

9. In the File menu, select Save Scenario to save the scenario. 

This example sets the counter to increment at each occurrence of an ACK (every 1 ACK). 

Example 6: Using Timers

In this example, the Global Rules portion of the scenario waits for an ACK primitive from 
the initiator. Each time the device detects an ACK, it injects an RD Error into the traffic 
stream. This state continues for a random period of time, not to exceed 1.790 seconds. 
After the time period has elapsed (timer times out), the scenario stops.

Although this example sets the timer for a random period, you also can set the timer for 
known values (2 ms., 5 mins., 1 hr., and so on).

1. Click the New Scenario button in the main library or one of the device libraries. In 
the Scenario Properties dialog, enter the scenario name, description, and direction 
of traffic change.

2. As in previous examples, configure the first event and its response in the Global 
Rules area. Choose ACK primitive as the event and Inject RD Error as the action.

3. Click the prompt to add another event (keep in mind this is not a combined event) 
(see Figure 4.43 on page 329).
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Figure 4.43: Example 6: Entering the Second Event

The Event Properties dialog box appears.

4. In the Type column on the left, choose Timer. Set the timer for random timing with a 
maximum time limit of 1.790 seconds.

5. Click OK to close the Event Properties dialog box.

6. Click the prompt to add an action to correspond with the second event. 

Figure 4.44: Example 6: Entering Second Action

The Action Properties dialog box appears.

7. In the Type list on the left, choose Stop Scenario as the action that you want after 
the timer has expired.

8. Click OK to close the Action Properties dialog box.
 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual 329



Teledyne LeCroy Creating a Sequence
Figure 4.45: Example 6: Complete Scenario

9. In the File menu, select Save Scenario to save the scenario.

4.10 Creating a Sequence

This section gives several examples for creating sequences. Recall that a sequence can 
have multiple states, but only one state is active at any time. In other words, at any point 
in time, a sequence “waits” for one event (or combined event) and responds with the 
corresponding action or set of actions when the event occurs. 

A sequence is more powerful than Global Rules, because you can create branching or 
looping test logic with a sequence.You can include up to two sequences in a scenario, but 
each is completely independent of the other. There is no branching or other interaction 
between the two, except through the Restart All Sequences action.

You must follow some simple rules when creating sequences:

TABLE 4.5:  Sequence Rules
You can use only two branch actions per state.
When you specify actions for a state, you can only use two instances of Branch to an 
Existing State or Branch to a New State. If you try to use more than two, a red error 
message appears in the status area of the application that says “Too Many Actions.”

You can use only one restart sequence action per state.
When you specify actions for a state, you can only use one instance of Restart Current 
Sequence or Restart All Sequences. If you try to use more than one, a red error message 
appears in the status area of the application that says “Too Many Actions.”

You can use a maximum of 255 states per sequence.
If you try to use more than 255 states, a red error message appears in the status area of 
the application.
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The following table summarizes the examples that follow.

TABLE 4.6:  Sequence Examples

Example 7: Creating Two Sequences and Global Rules

In this example, Global Rules substitute an Align (0) primitive for each of the following 
received from the initiator: Align (1), Align (2), and Align (3). As a separate test operation, 
two sequences determine the order in which each Identify Address frame is received 
from initiator and target.

The following tables summarize the logic implemented by each of the sequences.

TABLE 4.7:  Example 7: Logic of Sequence 0

TABLE 4.8:  Example 7: Logic of Sequence 1

There is no interaction between the two sequences. Each of them operates 
independently (and is independent of the Global Rules). However, the two sequences 
complement each other with their logic. In this sense, they both combine to implement a 
test objective.

1. Click the New Scenario button in the main library or one of the device libraries. In 
the Scenario Properties dialog, enter the scenario name, description, and direction 
of traffic change.

2. As in previous examples, create the Global Rules area.

Example Description
7 Creating two sequences and Global Rules: This scenario has two objectives 

that you implement with Global Rules and two sequences. 1) You use Global 
Rules to replace any of three types of primitives. 2) You use two sequences to 
detect the order in which a type of frame is received from initiator and target.

8 Creating a sequence with many states #1: The objective of this scenario is to 
detect an incorrect order of primitives and to cause the device to beep when 
it happens. You implement this scenario with a single five‐state sequence.

9 Creating a sequence with many states #2: This scenario is an enhancement 
of example 8. In this scenario, the objective is to detect an incorrect order of 
primitives, fix it, and cause the device to beep when this happens. As with 
example 8, you implement this scenario with a single five‐state sequence. 

State Description
State 0 If Address Frame is detected from initiator, go to State 1;

otherwise, continue to check incoming frames (do not change state).

State 1 If next Address Frame detected is from target, beep 1 second.

State Description
State 0 If Address Frame is detected from target, go to State 1;

otherwise, continue to check incoming frames (do not change state).

State 1 If next Address Frame detected is from initiator, beep 2 seconds.
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3. Click the prompt to add a sequence. Prompts for the sequence appear beneath the 
Global Rules area. You create a sequence one state at a time. The application 
numbers states consecutively from 0 up (1, 2, 3, and so on).

Figure 4.46:  Example 7: Adding a Sequence

By default, the name of the first sequence in a scenario is Sequence 0. The name of the 
first state is State 0. To change the name of a sequence or state, or to associate a 
description with it, click the name of the sequence or state. A dialog box appears that 
allows you to enter that information.

Note:The description does not appear on screen, but you can bring it up by clicking the name of the 
sequence or state.

4. In the State 0 area, click the prompt to add an event.

Figure 4.47:  Example 7: Adding an Event for the First State

The Event Properties dialog box appears.

5. In the Event Properties dialog box, select Address Frame as the event.

6. Click OK to close the Event Properties dialog box.
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7. In the State 0 area, click the prompt to add an action.

Figure 4.48: Example 7: Adding an Action for the First State

The Action Properties dialog box appears

8. For the action, select Branch to > New State.

9. Click the OK button to close the Action Properties dialog box. 

10. This saves the action and automatically creates an area for State 1 in the scenario. 

11. In the State 1 area, click the prompt to add an event. The Event Properties dialog 
box appears.

12. Choose the Address Frame event. In the Direction column, select From Target (you 
want State 1 to trigger on an Identify Address frame received from the target). 

13. Click OK to close the Event Properties dialog box.
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14. Click the prompt to add an action for State 1. 

Figure 4.49: Example 7: Adding an Action to the Second State

The Action Properties dialog box appears. 

15. In this example, you enter the action Beep, and you set the duration of the beep for 
1 second.

16. Click OK to close the Action Properties dialog box.
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17. You are finished creating the first sequence. Click the add another sequence prompt 
to create an area in the scenario for the second sequence (Sequence 1).

Figure 4.50: Example 7: Adding a Second Sequence

18. Create two states in the second sequence with the characteristics shown in the 
following table.

TABLE 4.9:  Example 7: States for Second Sequence

State Event Action
0 Address Frame from Target Branch to State 1

1 Address Frame from Initiator Beep for 2 seconds.
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19. In the File menu, select Save Scenario to save the scenario.

Figure 4.51: Example 7: Sequence Area of Scenario

Example 8: Creating a Sequence With Many States #1

In this example, a five‐state sequence detects if a group of primitives is received 
out‐of‐order from the initiator. The expected order is: Align (0), Align (1), Align (2), Align 
(3). If this scenario detects any other order of these primitives, it causes the device to 
beep and the scenario to restart.

This example is designed to give you an idea of the powerful logic that you can 
implement with sequences.
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Note:The states in this sequence have been renamed (do not have their default names). The following 
table summarizes the sequence logic.

TABLE 4.10:  Example 8: Logic of Sequence 0

1. Click the New Scenario button in the main library or one of the device libraries. In 
the Scenario Properties dialog, enter the scenario name, description, and direction 
of traffic change.

2. As in previous examples, create the five states for this sequence.

3. In the File menu, select Save Scenario to save the scenario (see Figure 4.52 on 
page 338).

State Description
Wait for Align (0) When an Align (0) is received, go to Wait for Align (1).

Wait for Align (1) If an Align (1) is received next, go to Wait for Align (2);
otherwise, go to Indicate Error.

Wait for Align (2) If an Align (2) is received next, go to Wait for Align (3);
otherwise, go to Indicate Error.

Wait for Align (3) If an Align (3) is received next, restart test;
otherwise go to Indicate Error.

Indicate Error Indicate error and restart test.
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Figure 4.52: Example 8: Top Half of Scenario
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Figure 4.53: Example 8: Bottom Half of Scenario

Example 9: Creating a Sequence With Many States #2

In this example, a five‐state sequence not only detects if a group of primitives is received 
out‐of‐order, but it fixes any incorrect order. The logic is similar to that of example 8 with 
a few small changes. The following table summarizes each state.
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TABLE 4.11:  Example 9: Logic of Sequence 0

1. Click the New Scenario button in the main library or one of the device libraries. In 
the Scenario Properties dialog, enter the scenario name, description, and direction 
of traffic change.

2. As in previous examples, create the five states for this sequence.

State Description
Wait for Align (0) When an Align (0) is received, go to Wait for Align (1).

Wait for Align (1) If an Align (1) is received next, go to Wait for Align (2);
otherwise, replace primitive with Align (1) and go to Indicate 
Error.

Wait for Align (2) If an Align (2) is received next, go to Wait for Align (3);
otherwise, replace primitive with Align (2) and go to Indicate 
Error.

Wait for Align (3) If an Align (3) is received next, restart test;
otherwise, replace primitive with Align (3) and go to Indicate 
Error.

Indicate Error Indicate error and restart test.
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3. In the File menu, select Save Scenario to save the scenario.

Figure 4.54: Example 9: Top Half of Scenario
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Figure 4.55: Example 9: Bottom Half of Scenario

4.11 Downloading Scenarios

After you have created a scenario, you need to download it to the InFusion device for 
execution.

If you use a general library as a scenario archive, then the process of creating and 
downloading a scenario is as follows:

1. Open the general library (Main library or a File library). Scenarios in the library are 
listed in the Main Library window.

2. Open the Device Library window by clicking the Show Device Library button on 
application toolbar.

3. Open the Device Library for the device to which you want to download a scenario or 
scenarios. You can open the device library in two ways: by clicking the Device 
Library icon in the device list window or by double‐clicking the device name.

4. Copy the scenario from general library to device library by dragging it with the 
mouse. 
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5. Download all scenarios in the device library to the InFusion device. To do so, click 
the Download all Scenarios button on the Device Library toolbar (second button 
from left).

4.12 Running Scenarios

If you use a general library as a scenario archive, then the process of executing a scenario 
is as follows:

1. Select the scenario to run by clicking it. 

2. To run the scenario, click the Run Scenario button on the Device Library toolbar 
(second button from the right). The InFusion device then begins its session.
 Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual 343



Teledyne LeCroy Saving a Log File
4.13 Saving a Log File

To save a log file of a Jammer or Device Output, select the wrench from the toolbar below 
the Scenario window (see Figure 4.56) or below the Device window (see Figure 4.58 on 
page 345).

Option to Save Output Window Log File

Figure 4.56: Output Window Options
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Option to Save Device Output Window Log File

Figure 4.57: Device Output Window Options

Automatically Save Log File

Selecting either “Wrench”will pop up a window which automatically stores the log file for 
the Window selected. See Figure 4.58.

Figure 4.58: Auto Save Log File: Location and Size

You can change the maximum size of the log file by typing in the Max Size window. If you 
select the folder, you can change the path to the location of the log file. See Figure 4.59 
on page 346.
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Figure 4.59: User Defined Location of Jammer Output Window Log File

Figure 4.60: Sample Jammer Output Log File

Path to Log File Location
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Figure 4.61: User Defined Location of Device Output Window Log File

Figure 4.62: Sample Device Output Log File

Path to Log File Location
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Copy or Copy All

Another method to capture and save the log file is to simply perform a right click in the 
log Output Window or Device Window. Then select a portion of the log file to Copy or 
Copy All. See Figure 4.63.

Figure 4.63: Copy Data from Log File Window

4.14 Scenario Batch Files

You can write a script with commands to run a sequence of executable scenarios 
automatically. A Scenario Batch file is a text file with a list of commands to run in 
sequence when you execute the file. A batch script can manage scenarios and their 
assigned ports and hardware in sequence, using conditions. The system checks for 
accuracy of inputs and commands.

Note:Before you run a Scenario Batch file that requests scenarios, you must download the scenarios 
to the Scenarios box.

To start a batch script, click the New Batch Script   button or select 
File > New Batch Script.
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4.14.1 Script Workspace

In the Script Workspace shown below, add a command and make a batch file.

In this window, you can enter a script command by clicking Click here to add 
script command.

1. First, click Click here to add script command to open the Command Properties 
dialog.

The Command Parameters Dialog contains the list of available commands and their 
parameters from which to build scenarios and connected hardware and available ports.
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2. Select appropriate parameters for the command and click OK to display the script in 
the Script Workspace. 

Note:You can select ports from the port list, depending on number of ports licensed.

Note:The hardware Serial Number can already exist or not. If the Serial Number exists, the Serial 
Number (for example, S/N: 12871) is shown. In Offline and Simulation mode, you can enter a 
Serial Number. In Online mode, you can only enter an existing Serial Number.

3. To add another command, click Click here to add another script command.

To copy a script command, right‐click on the command and select Copy. 
Right‐click Click here to add another script command and then select Paste. 

You can also cut, delete, and edit a selected script command.

4. To edit batch commands, click the command, or right‐click the command and select 
Edit from popup menu.

5. To delete a command, right‐click and select Delete from popup menu, or select 
command and press Delete key on keyboard.

6. After finishing, if everything is correct, push the Run Batch button to execute 
scenario and save result in the log file. 
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Note:Before you run a Scenario Batch file that requests scenarios, you must download the scenarios 
to the Scenarios box.

4.14.2 Error Checking

The Script Workspace shows errors by red color. The program reports all errors in the log 
file. 

If you use a script from other InFusion hardware, it may cause an error, for example, 
mismatch in hardware Mac addresses, or scenarios that are not already in current 
hardware.

4.14.3 Log

Results of executable batch commands are saved automatically into a log file with user‐
specified name. The status of executable commands is shown in log area.

4.14.4 Statements

Statements can be conditional statements or non‐conditional statements.

IfIsStopped

Shows whether a scenario is already stopped or not.

Format
   IfIsStopped (Serial Number, Target Port)

Parameters
 Serial Number: Serial number of hardware
 Target Port: Port number in port map
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Example
IfIsStopped(ox01267, 1) Then 

{
Beep (750, 300)
Run (ox01267," Detect AddressFrame Open", 5)
}

The value of second parameter is 5 and shows check stopping mode of combination of 
port number 1 and port number 3. 

After filling parameters from the Command Parameters Dialog, the program makes the 
IF‐ELSE structure in the Script workspace. The ELSE statement is optional. To add an ELSE 
body, click Click here to add else body.

4.14.5 Goto Label

Goes to specified label. Labels can be assigned to each script line. 

Format
Goto Label3

Parameters

None

Example
Label3: WaitForStop(0x83456, 2, 100))
Run (ox01267," Inject CRC000", 4)
Goto Label7
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Note:You can use a Label and a Goto Label to make loops. First make the label, then make Goto Label. 
The Command Parameters window shows only enabled Labels. Labels are disabled by default 
and are in gray color. To enable them, click them to make purple color.

4.14.6 Run

Runs the scenario on hardware on specified ports. If you call this command for the first 
time and the scenario was not assigned to the hardware and ports before, the scenario is 
assigned to specified hardware and ports and then scenario runs on the hardware.

Format
Run(Serial Number, Scenario Name, Target Port)

Parameters
 Serial Number: Serial number of hardware
 Scenario Name: Name of scenario
 Target Port: Port number in port map
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Example
Run (ox841200," Substitute address frame", 4)
Beep(800, 400)
Run (ox841200," CRC Inject _ Play CD", 8)
WaitForStop(0x63463, 1, 150)
Run (ox841200," Remove Send Cue Sheet", 2)
Goto Label6
Run (S/N: 12871, Port 1, DISCOVER)

Note: If the selected ports are busy, scenario cannot run, and the command will be skipped. The result 
will be written in Log area.

4.14.7 Stop

Stops running scenario by hardware and port name.

Format
Stop (Serial Number, Target Port)

Parameters

• Serial Number: Serial number of hardware

• Target Port: Port number in port map

Example
Run (ox00820,"Inject CRC000", 2)
Beep(700, 500)
Stop (ox00820, 2) 
Goto Label3
...
Label3 : Run(ox005007,"Detect DATA", 8)
Sleep(40)

4.14.8 WaitForStop

Used to wait for occurrence of specified condition.

Format
WaitForStop(SerialNumber, Target Port, Duration)

Parameters
 Serial Number: Serial number of hardware
 Target Port: Port number in port map
 Duration: Integer or random duration in milliseconds. In the Command Parame‐

ters Window, WaitForStop duration has three options:
 Infinite: Wait until Stop command.
 Random: Stop after a random time.
 Finite time: Stop after specified time in milliseconds.
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Example
Run (ox001267,"Detect AddressFrame Open", 2)
WaitForStop (0x348790, 2, Forever) 
Run (ox005007,"Detect DATA", 4)
WaitForStop(ox005007, 4, 100)
Stop (ox001267, 2)

Sleep

Used to sleep for a few seconds.

Format
Sleep(Duration)

Parameters
 Duration: Integer or random duration in milliseconds

Example
Sleep(100)
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4.14.9 Beep

If specified condition is satisfied, the system beep for specified duration.

Format
Beep (Duration, Frequency)

Parameters
 Duration: Integer or random duration in milliseconds
 Frequency: Frequency in hertz

Example
IfIsStopped(0x83456, 4)) then

{
  Beep (2, 20)
  Run (0x83456,"Identify_Disparity error", 8)

}
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Creating a Pattern Generator File
You may use any text editor or word processor to create a pattern generator file (*.spg) 
using the following conventions:

5.1 Key words

ALIGN

CONT

DMAT

EOF

HOLD

HOLDA

PMACK

PMNAK

PMREQ_P

PMREQ_S

R_ERR

R_IP

R_OK

R_RDY

SOF

SYNC

WTRM

X_RDY

XXXX

LOOP

Enable

Disable

Host

Device

Scramble

Role

END_OF_FILE
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5.2 Comment format
/*Comment text*/

5.3 Primitive definition format

To add an ALIGN primitive, use ALIGN or 27.3 10.2 10.2 K28.5

To add a CONT primitive, use CONT or 25.4 25.4 10.5 K28.3

5.4 Loop definition format

You may write a defined pattern into memory repeatedly by enabling a loop.

Loop definition allows either “Enable” or Disable”. To enable looping use: Loop=Enable

5.5 Scramble definition format

Scramble definition allows either “Enable” or Disable”. To enable scramble use: 
Scramble=Enable

5.6 Role definition format

To specify SATA hardware role: Role=Host or Role=Device 

5.7 END_OF_FILE definition

A pattern generator file must include END_OF_FILE as the last statement in the file.

5.8 Example Pattern Generator File

Figure A‐1 illustrates a typical Pattern Generator file.
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Figure A.1: Sample Pattern Generator File *spg
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China Restriction of Hazardous Substances Table
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The following tables are supplied in compliance with China’s Restriction of Hazardous 
Substances (China RoHS) requirements: 

 



Teledyne LeCroy WAN Operation
6.1 WAN Operation

WAN connected operation is supported. Contact factory for details of operation. Refer 
“How to Contact Teledyne LeCroy” on page 363 for contact information.
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How to Contact Teledyne LeCroy
Type of Service Contact

Call for technical support US and Canada: 1 (800) 909‐7112

Worldwide: 1 (408) 653‐1260

Fax your questions Worldwide: 1 (408) 727‐6622

Write a letter Teledyne LeCroy

Protocol Solutions Group
Customer Support
3385 Scott Blvd.

Santa Clara, CA 95054‐3115

USA

Send e‐mail psgsupport@lecroy.com

Visit Teledyne LeCroy’s web site teledynelecroy.com/

Tell Teledyne LeCroy Report a problem to Teledyne LeCroy Support via e‐mail by 
selecting Help>Tell Teledyne LeCroy from the application 
toolbar. This requires that an e‐mail client be installed and 
configured on the host machine.
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Symbols
.cfg file 242

.infdb file 295

.sac files 39

Numerics
10 bit payload data display 226

8 bit payload data display 226

A
About 263

Action 293

action
counter 311
scenario 308

Action Properties dialog 310

Add Device... 25

Add Pattern button 107

Add to Trigger 121

address 363

address frame 64

Address Frame Type Pattern dialog 64, 87

Advanced Mode 28, 104

alias name 273

ALIGN Transmission Period 100

Analysis Project dialog 45

analyzer overview 15

Anchor the Selection bar 251

As previously saved 248

Ask user to close the previous captured sample 
before running the new project 247

ATA Command Pattern dialog 81, 92

ATA Command Report 160

ATAPI Pattern dialog 82

ATAPI Report 163

ATAPI spec assignment 247

Auto Run 19, 98

B
Based on Cell Type 251

Based on Port No. 251

Based on Read/Write Command Type 251, 253

Based on Specific Command Type 251, 253

batch command editing 350

batch script 348

Batch Script Setting 286

Beep statement 356

BIST (FIS) 70

bookmarks 202
finding 204

Break Link Recovery 284

Browse Default Path 247

buffer
% full 235

Bus Condition report 157

Bus Conditions dialog 78

Bus Utilization
buttons 187

Bus Utilization View 180

buttons
bus utilization 187

Buzzer check 270

Byte Order 232

Bytes in Column 241

C
Cancel button kills upload immediately 249

capture
parameter 58
pre and post trigger 59

Capture tab 41

Capture tab for Pattern 57

cascading 20

CATC Script Language 197

CATC Technical Support 363

cell address 115

Check for Updates 262

Choose Port Speed 101
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Click here to add another script command 350

Click here to add script command 349

Clock check 264

Close previous sample file when new sample file 
opens 249

Collapse All 233, 234

Collapse Log button 197

color 241

Color, customize operation code field 126

column
hiding 177
rearrange 144
resize 144

column content
filtering 175
sorting 177

Column View 33

column view 143

Columns in Row 241

Combined Event 293

Command Parameters dialog 349

Command Properties dialog 349

compensate
for line loss 245

components 17

conditional statements 351

configuration 238

Configuration menu (InFusion) 286

Configure Device 286

contact 363

Convert port configuration without prompt for 
confirm 247

Count Randomly 311

counter
as data 115

Counter button 115

Counter Value 311

counters 311

Create statistical report read/write page 52, 249

Current License Configuration field 255

cursor position status bar 236

cursors
locating 201
positioning 237
timing 148

D
data
pattern 61
show 233

Data (FIS) 71

data block
counter data 115
custom pattern 114

defining 112
editing 114
editing as text 117
naming 113
random pattern 116
walking bit 116

Data Block dialog box 112

Data Block Edit menu 113

Data Block Name list 117

data format 232

Data Pattern dialog 61, 83

Data Pattern edit box 114

Data Payload View 188

data report 187

Data Report button 187, 201

Data View 33

DataPatternCapture 121

Decode CDB of Commands 252

Decode Toolbar 228

Decode toolbar 36

Default Workspace 247, 248

default workspace 247

default.infdb file 295

Define different patterns for pre‐trigger and post‐
trigger data captures 42

Define Pattern dialog 114

defining patterns 94

device library 296

Device Library window 296, 342

Device Setup dialog 256

DHCP server 22

Disconnect 24

disparity indication 228

display
fonts 242

display Configuration 238

display configuration 238

Display License Information 261

display manipulation 121

DMA activate (FIS) 69

DMA setup (FIS) 70

Don’t care (Snapshot) 72

downloading a scenario 342

DVD ROM 19

DWORD Matcher 305

E
Easy Mode 28

Edit script 200

e‐mail 363

Email CATC Support 363

Enable Tooltip box 241
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Entire Memory 98

Error Injection 284

error message
startup 19

errors 351

Ethernet
connecting with 22

Event 293

event
counter 311
scenario 302

example files 55

exclude from capture
Align 41
Idles 42
Notify 42
OOB Signals 41
patterns 58
Payload of Data Frame 41
RRDY 42
SATA_CONT 41
SATA_SYNC 41
XXXX 41

Exclude Idle checkbox 59

Expand All 233

Expand Log button 197

Expanded Waveform View 149

Expansion Card Data Status or Clock Status 
check 269

Export Paired SAS Address Report 52

Export Read/Write Command Report 52

Export to Excel button 173

Export to Initiator Emulator 48

External Trig In Setting 101, 256

External Trig Out Setting 101, 256

External Trig Setting 286

External Trig Setting dialog 256

external trigger 101

External Trigger dialog 78

F
fax number 363

field
show/hide 230

Field Settings 240

Field View 146

file library 295

File Manager 295

File menu (InFusion) 286

file type
definition 54

filter 206
by tag number 214
check condition 213
options 211
save setup 208

type 208
filter enable 217

filter idle 200, 218

filtering 206
direction 208

filtering column content 175

Filtering menu 206

Find Device 271

Find Device button 272

FIS Command Report 160

FIS Pattern dialog 86

FIS Patterns dialog 63

FIS Type dialog 66, 91

FIS types 67

Fit to Graph Area 184

Floating License dialog 255

Force Add/Connect Attempt 25

Found Device List Mode 247

FPGA 1 or 2 Serdes Chip 266

Frame Inspector View 146

frames
hide 178

From Initiator 299

From Target 299

G
general report 154

Gigabit Ethernet interface 22

Global Rules 294
examples 318

Go to ATA/SCSI Cmd. 184

Go To button 200

Go To Timestamp dialog 202

Goto Command 231

Goto Label statement 352

Goto Response 231

Goto Within Packet command 231

grouping
by port 99

H
hardware
run 43

hardware setup 19

Help Topics 261

Hide All Primitives 201

Hide RRDY Primitives 200

Hide Unassociated Traffic 201

Histogram View 33

histogram view 178

I
IfIsStopped statement 351
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InFusion 283

Infusion 37

InFusion scenarios 290

Install component selection 19

Installation DVD‐ROM 17

Inter‐FPGA Connection 268

IP Settings... 25

J
Jammer 289

Jump to Next button 175

Jump to Previous button 175

Jump to Specific button 175

K
K‐Codes 305

key sequences 111

L
Lanes Report 171

launching 28

Launching the CrossSync Control Panel 45

LED check 270

library 295
device 296
main 295

License Configuration 255

License Manager 255

line condition 304

link layer
command interpretation 44

Link With Sample View 175

Load dialog 117

log file 351

M
Main FPGA tab 268

Main Library window 295

Manual Trig button 73

manual trigger 73

Maximum Number of Uploader Threads 247

Memory Assignment 253

memory check 265

Memory Size 98

Micro‐D Sync cable 20

Micro‐D to DB‐9 cable 21

Move drop‐down list 175

MUX Setting 103

N
NCQ Commands Time out Threshold 247

network 22

Networks... 25

New Batch Script command 285

New Protocol Analyzer Project in Advanced 
Mode 246

New Scenario button 297

New script 200

normal zoom
reset 201

Notes tab 103

Number of Run text box 98

Number of Runs Each Test 265

O
Open as Data Vie 188

Open Library command 285

Open Sample file In 248

operating system 19

order reorder
in results display 226

Others Report view 172

output trigger 108

P
Pack Repeated Primitives 249

Packet Drop 284

Packet View 33, 119, 126

packing list 17

Partial Memory 98

Paths settings 246

pattern
definition 94

Pattern command 57

pattern definition
in sequential trigger mode 94

Pattern field 107

Pattern triggers 72

Pending ATA IO 181

Pending IO report 171

Pending SCSI IO 181

Performance report 170

PIO Setup (FIS) 71

port
renaming 229
status 234

port alias 242

Port Configuration 285, 286

Port Configuration button 101

port ID 229

Port Speed 101

Port Status 37

Post‐Trigger Capture tab 59
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pre‐trigger 96
data 97

Pre‐Trigger Capture tab 59

Primitive dialog 60, 79

Primitive Manipulation 284

primitive report 156

primitive response timeout 99

Print Preview button 173

project
examples 55
file type definition 54
notes 103
settings 97, 112

project note 103

Project Tree 41

projects 54

protocol
error mask 100

Protocol Analyzer 28

Protocol Analyzer setting 246

protocol error report 169

protocol errors 61

Protocol Errors dialog 61, 85

Q
Quick Start manual 17

Quick View 120, 248

R
random data pattern 116

Read/Write report 167

Rec Analyzer command 285

Refresh (append to) the list of found devices 247

Refresh Device List 26

register device to host (FIS) 67, 68

relative time display 44

Remove Device 25

Rename Title of Port dialog 229

renaming port 229

Repeat decoded command in frame column 252

Reset (clear) the list of found devices 247

Response frame 231

Reverse Link Data 249

Run All Tests Sequentially 265

Run Batch button 350

Run Batch Script command 285

run hardware 43

Run Scenario button 343

Run scripts button 198

Run statement 353

Run Verification Scripts dialog 197

running disparity 228

Running verification scripts button 197

Rx/Tx Settings dialog 245

S
Sample File Name 98

Sample View link 175

Sampling memory usage optimization 248

Sampling Memory Usage Optimization option 253

SAS Address Alias 243

SAS Address report 168

SAS data pattern 306

SAS Parameters window 74

SAS/SATA Protocol Suite 28

SATA data pattern 306

SATA Parameters window 75

save
partial trace capture 47, 48, 49, 53
trace capture 46

Save As Display Formats 49

Save as Text button 173

Save As Text dialog 141

Save Filtered Sample 47

Save Output button 197

scenario 290
action 308
creation 314, 318
downloading 342
event 302
running 343

Scenario Batch file 348

scramble/unscramble payload data 227

scrambling
disable 99

Script Workspace 349

SCSI Command Pattern dialog 90

SCSI Command Report 164

SCSI commands
address display 44

SCSI spec assignment 247

SDRAM or Exerciser RAM memory check 265

search 218
by tag 223, 224
domain 221
for data pattern 219, 220
logic 220
SAS address 221
save setup 219
status 237
STP port 221
sub items 221

search direction 219

search from 219

select
item for capture 60

Select Device 22
Sierra M6‐1 SAS/SATA Protocol Analyzer User Manual 369



Teledyne LeCroy Index
Select Port Configuration dialog 102

selecting components for installation 19

self test 263

Self Test dialog 263

separate systems 19

sequence 294
examples 330

Sequential Trigger mode 93

sequential triggering 93

Serial ATA (SATA) data transfers 15

Serial Attached SCSI (SAS) data transfers 15

session 309

Set Alias Name 24

Set as Second Data Payload 190

set device bits (FIS) 69

Set Port Configuration dialog 101

Set the Anchor row as sync. point 251

Set Time Stamp Origin 205

Set Timers dialog 108

Setting button 174

Setting dialog 174

settings
advanced mode 112

Settings command 198

Settings dialog 198

Settings tab 97, 112

Setup command 19

show
all data in data field 233

Show Analyzer command 285

Show Description window 200

Show Device Library button 342

Show Device Library command 285

Show Grid 200

Show Library command 285

Show Output 200

Show Output command 285

Show Sector Count instead of Xfer Length 252

Show Trainer command 285

Show Warning in Search Primitive In Column 
View 252

Show XXXX value 100

Show/Hide CMD packet
in results display 226

Show/Hide Compare 2 Data Payloads button 190

Show/Hide DLLP packet
in results display 226

Show/Hide Field 230

Show/Hide Link Packet button 226

Show/Hide Physical Packet
in results display 226

Show/Hide TLP packet

in results display 226
Show/Hide Transport Packet button 226

Simulation Mode 28

Sleep statement 355

SMP Command Report 165

SMP frame 65

SMP Frame Pattern dialog 65, 88

Snapshot mode 73

Soft Reset dialog 93

Software default 247

software installation 19

sorting column content 177

Spec View 146, 228

Spread Sheet Color Setting 251

Spreadsheet View 33

spreadsheet view 136

SSP Frame 66

SSP Frame Pattern dialog 66

SSP Frame Type dialog 89

SSP Transport Report 158, 159, 162

State 293

statements 351

statistical report
column setting 174
content (SATA) 153
options 154
save as text 173

Statistical Report toolbar 172

Statistical Report View 175

statistical reports 33

Statistics button 188

Status bar 237

Stop Batch Script 285

Stop Hardware button 73

Stop statement 354

subnet 27

support 363

Switch to CATC Navigation 249

Symbol dialog 79

Sync port 20

Synchronize with Trace View 184

T
Task Command Report 166

Technical Support 363

telephone number 363

Template Files 246

Test Result 264

Text View 33

text view 144

Tile Views 201

time
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relative display 44
Time Stamp Origin 205

Timeout Pattern dialog 76

timer
setup advanced mode 108

Timer dialog 76, 94

timers 328

timing
cursors 148
measurement 148

tool bar 236

Toolbar command 236

Tools menu (InFusion) 286

Trace Capture 46

Trace Memory Status section 97

Traffic Monitoring 284

trigger
condition 106
external 78
manually 73
on address frame 87
on ATA command 81
on ATA command pattern 92
on ATAPI 82
on bus condition 78
on data pattern 83
on FIS 91
on pattern 73
on primitive 79
on protocol errors 85
on SCSI Command 90
on SMP Frame 88
on soft reset 93
on SSP Frame 89
on STP frame 86
on symbol 79
on timer 76
position in memory 97
setting advanced 106
setup 72
snapshot 73

trigger on
any ATA command 81

Trigger tab 72

triggering
on timer sequential 94
order 95

Tx Vout 244

Tx Vout & Preemphasis command 245

U
unpacking 17

Update License 261

Update Sierra Device 286

Update Sierra Device command 256

Upload Manager dialog 98

user defined decoding 259

User Defined Decoding dialog 259

User Path 246

using the cursors 237

V
Value Replacement 284

VENDOR (FIS) 72

Verification script command 197

Verification Script Engine Reference Manual 197

View Field option 228

View menu (InFusion) 286

View Type toolbar 144

Viewer 119

Viewer Setting toolbar 225

Viewer Settings 241

Viewing Check Condition Sense Data 129

views 33

Virtual Private Network (VPN) 27

Visible box 240

W
WaitForStop statement 354

walking bit pattern 116

Waveform Display 33

waveform display 148

web site 363

Website, CATC 363

Windows default 247

Wrap Packet box 241

wrap packets
in results display 225

Z
Zoom In
results display 201

Zoom Out
results display 201
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